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Preface

The Veterans Health Information Systems and Architecture (VistA) Mental Health Assistant Version
3 (MHAZ3) User Manual for Patch YS*5.01*96 provides the Department of Veterans Affairs Medical

Center (DVAMC) Information Resource Management (IRM) staff and other DVAMC users with a

straightforward means for implementing and utilizing the MHAS3 software application. Detailed

instructions, functional requirements, and examples for using the MHA GUI software application are

illustrated in this user manual.

NOTE: The Veterans Health Administration (VHA) fully supports Section 508 of The Rehabilitation

Act and is committed to equal access for all users. While every effort has been made to ensure
Section 508 compliance, we realize that there may be other issues. If you have questions or would
like to see a copy of the Compliance Action Plan for future releases, please contact:

Richard Fischer, Project Manager
VA OI&T

1st Avenue and Cermak Rd

Bldg 37

Hines, IL 60141

Phone# 708-786-7529

email: richard.fischer@va.gov

Intended Audience

The intended audience for the MHA3 User Manual includes mental health clinicians, clerks, and
patients.

Mental Health Assistant VVersion 3 User Manual Sections

The Mental Health Assistant Version 3 (MHA3) User Manual for Patch YS*5.01*96 contains the
following sections:

NOTE: The screen captures examples text is written in support of Section 508 compliance.
Commands to utilize options are bolded.

October 2010 MHA3 User Manual
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Preface: This section provides an overview of the manual.
Orientation: This section addresses package or audience specific notations or directions.

Table of Contents (TOC): The TOC provides references to major chapters and/or sections of the
user manual.

Introduction: This section conveys the major functions, purposes, and how the software
accomplishes the objectives.

Use of the Software: This section describes what the user needs to know in order to competently
operate the MHAS software application, including screen captures examples.

Glossary: This section contains the glossary of terms that are related to the MHAS3 software
application.

Appendix A: This section contains a list of shortcut keys use in the Mental Health Assistant Version
3, Graphical User Interface software application:

Appendix B: This section contains descriptions of the many window commands and features used in
MHAS.

Appendix C: Instructions on co-signing a progress note generated by MHA3.
Appendix D: Procedures are described to remove data that was entered in error.

Appendix E: SecureDesktop (a MHAS security application for patient data-entry) and Screen Pass (a
screensaver security application) may require Windows Registry adjustments to work together.

Appendix F: Instructions on adding an instrument’s name to the CPRS Tool menu.
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Documentation Retrieval Locations and Formats

MHAZ3 Patch YS*5.01*96 exports the following folders and files:

Retrieval Formats Information

FILE NAMES CONTENTS RETRIEVAL FORMATS
YS50196_MHA3_UM.pdf Mental Health Assistant BINARY
Version 3 (MHAS3) User
Manual Patch YS*5.01*96
YS50196_MHA3_UM.doc Mental Health Assistant BINARY

Version 3 (MHA3) User
Manual Patch YS*5.01*96
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Retrieval Locations:

User Manuals (i.e., YS50196_MHA3_UM.pdf and YS50196_MHA3_UM.doc) are available in MS
Word Format (doc) and Portable Document Format (pdf) are available on the Office of Information
Field Offices (OIFOs) ANONYMOUS SOFTWARE directory FTP addresses listed below:

NOTE: All sites are encouraged to use the File Transfer Protocol (FTP) capability. Use the FTP
address “download.vista.med.va.gov” (without the quotes) to connect to the first available FTP server
where the files are located.

Ol FIELD OFFICE FTP ADDRESS DIRECTORY
ALBANY ftp.fo-albany.med.va.gov [ANONYMOUS.SOFTWARE]
HINES ftp.fo-hines.med.va.gov [ANONYMOUS.SOFTWARE]
SALT LAKE CITY ftp.fo-slc.med.va.gov [ANONYMOUS.SOFTWARE]

VistA Website Locations:

VistA MHA3 User Manual (i.e., YS50196 MHA3_UM.pdf and YS50196 MHA3_UM.doc) are
available in MS Word Format (doc) and Portable Document Format (pdf) at the following Website
locations:

VistA Mental Health VVersion 5.01 Home Page:
http://vista.med.va.gov/ClinicalSpecialties/menthlth/Index.html

VistA Documentation Library (VDL):
http://www.va.qgov/vdl/

Related Manual

VistA Mental Health (MH) Addiction Severity Index Multimedia Version (ASI-MV) Installation and
User Guide (Patch YS*5.01*78)
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Introduction

Overview

The VistA Mental Health Assistant (MHA) is the graphical user interface (GUI) for the VistA
Mental Health Package (MHP). MHA was developed to create an effective and efficient tool for
mental health clinicians and their patients to use for the administration and scoring of assessment
instruments and interviews. Additionally, results are displayed in report and graphical formats.
MHA and MHP support mental health assessments (e.g., psychological testing, structured
interviews, and staff rating scales) that are not available elsewhere in the Computerized Patient
Record System (CPRS)/Veterans Information System and Technology Architecture (VistA).
MHA has enjoyed widespread usage among mental health clinicians over the past several years,
and the current revisions of MHA and MHP initiate steps toward re-engineering VistA Mental
Health functionality.

The original revision of MHA created a closer integration with CPRS, by placing the MHA GUI
on the CPRS Tools Menu. Additionally, functionality was created to allow a site to place an
individual instrument on the Tools menu, allowing widespread access to that specific instrument
without having to issue the menu for the MHP to all clinicians.

Additional functionality that strengthens the tie to the patient’s medical record is the creation of a
progress note in CPRS when an instrument is completed through MHA.

Furthermore, MHA maintains and strengthens its ties to the Clinical Reminders program, which
allows for the presentation of specific instruments through reminder dialogs to all clinicians who
resolve reminders.

To better meet the needs of clinicians and patients in different programs, particularly non-
traditional settings, MHA can now run in a stand-alone mode to administer instruments offline
for later uploading to VistA.

This version of MHA has corrected several defects in the YS*5.01*85 version (released in
January 2008). These defects are corrected:

1) The printing of Minnesota Multiphasic Personality Inventory version 2 (MMPI2) graphs
would appear across pages rather than one graph on one page.

2) Administrations of Symptom Check List, revised (SCL9R) would produce errors when saved
to Vista.

October 2010 MHA3 User Manual 14
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3) Administrations of various instruments would sometimes try to save information to a Vista
file that no longer exists (601.2) and would produce Vista errors.

4) The Morse Fall Scale incorrectly scored one item.

5) The data-entry format used in MHA3 and the data-entry format used in the Clinical
Reminders within CPRS were not similar.

6) To reduce the number of instances when data were entered on the wrong patient, a “Cancel”
button was added to the two data-entry forms.

7) ASI-MV administrations could be edited in the ASI manager which would treat them as
administrations of an ASI Follow-up.

8) The Battery Wizard would sometimes produce errors when deleting and adding instruments to
a battery list.

9) Some dialogs that used radio groups were problematic for some screen readers (e.g., JAWS)
so the radio groups were replaced with buttons.

10) Users were not given the option of saving and editing progress notes once an instrument was
completed in MHA3.

11) When two administrations of the same instrument were performed at about the same time,
MHA3 would not display both administrations, only the first administration.

12) CAC’s, and others who possess the MH Manager key, were unable to view the results of the
instrument they wished to remove from VistA.

13) The ability to have students obtain co-signer’s signatures on completed instruments was not
explained.

14) In accordance with VA Directive 6507, the patient’s Social Security Number (SSN) will not
be displayed in its entirety in this application; only the last four digits will be shown. When the
patient is selected, their entire SSN is available so the user can ensure the proper patient is
selected.

October 2010 MHAS3 User Manual 15
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Test Sites

VistA MHA3 Patch YS*5.01*96 has been tested by the following Veteran Affairs Medical

Centers (VAMCs) and Healthcare Network Systems (HCS):

Test Sites/Integrated Operating System Platform Test Site Size

Upstate New York HCS -

Integrated Cache/VMS Large
Atlanta VAMC Cache/VMS Large
Northern California, CA HCS - Cache/VMS Large
Integrated

North Texas, TX HCS - Cache/VMS Large
Integrated

Oklahoma City, OK Cache/VMS Large

October 2010
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Use of the Software

This section describes what is needed to successfully use the new Mental Health Assistant Version
3 (MHAS3) software application for the following enhanced activities:

e Instrument Administrator

e Instrument Results Review

e Addition Severity Index (ASI) Manager

e Global Assessment of Manager (GAF)
NOTES:

Please see Appendix A, (i.e., located in the back of this manual) for a revised list of MHA3 shortcut
keys. The list can be removed from this manual for easy access and viewing.

Please see Appendix B, (i.e., located in the back of this manual) for a list of the MHA3 windows
conventions. The list can be removed from this manual for easy access and viewing.

Contingency Planning

Each facility using the MHA3 software application must develop a local contingency plan to be
used in the event of application problems in a live environment. The facility contingency plan
must identify procedures used for maintaining the functionality provided by the software in the
event of a system outage.

Security Keys

MHAS3 software application did not release any new security keys, however, the YSP security
key is required to control access to the results of “non-exempt” tests. Holders of the YSP security
key are controlled (i.e., given out by the Chief of Psychology or a senior psychologist) at a
facility that does not have a Chief of Psychology. The Chief of Psychology or senior
psychologist also determines which tests are “exempt” (i.e., the results can be seen by anyone),
and which are “non-exempt” (i.e., require the YSP key to see the results).

October 2010 MHA3 User Manual 17
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Windows Conventions

The startup, setup, and assignment functions for MHAS use a Graphical User Interface (GUI).
You may refer to the Appendix B, Windows Conventions for an explanation of the windows
elements and form buttons used by MHA3.

Mental Health Assistant Temporary Crash Files

To prevent data loss resulting from MHA3 being improperly closed (e.g., power outage), MHA3
creates a temporary crash file on the local PC hard drive when instruments are administered.
This temporary crash-file is updated each time a new entry is made; therefore, the temporary
crash-file is always current. Upon normal program closure, this temporary crash-file is erased.
Each time MHAZ begins, it looks for the temporary crash-file on the PC hard drive. If it exists,
the data in the temporary crash-file are uploaded to the VistA Mental Health Package (MHP)
database so the user can restart the incomplete administration. No data that identifies the patient
are contained in the crash file (e.g., name, SSN).

Mental Health Assistant results and CPRS Progress Notes

Under normal circumstances and proper setup, the results of the instruments administered in
MHAS3 will become progress notes in CPRS.

If the progress notes are not generated, the Clinical Applications Coordinator should be notified. If
it does not already exist, create the progress note title of "Mental Health Diagnostic Study Note™
in the progress note hierarchy. This is needed for MHAS3 to automatically pass a note to CPRS
from instrument administrations completed within MHAS.

Some instruments do not generate progress notes because their results are to be viewed by

designated staff; for example, the results of the Minnesota Multiphasic Personality Inventory,
version 2, can only be viewed by psychologists who have the YSP key.

Starting Mental Health Assistant
There are two ways to start Mental Health Assistant:

e VistA CPRS Tools Menu
e Off-line Mode

Starting Mental Health Assistant from VistA CPRS Tools Menu

The VistA CPRS Tools menu is the standard way of connecting to the VistA MHAS3 software
application. Since all VistA Mental Health Assistant functionality is started and available to the user
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via the VistA CPRS Tool menu, the VistA CPRS software application must be installed on the PC
workstation where Mental Health Assistant functionality is to be administered. The Mental Health
Assistant software application is normally used by clinicians at VAMCs and VA satellite clinics
where a “live” network connection to VistA is available. Most of the functionality described in this
user manual assumes that the user is operating via the VistA CPRS Tools menu.

NOTE: When the users VistA account is properly configured, there will be a Mental Health
Assistant menu located on the VistA CPRS Tools menu (as seen in the example below). If the
Mental Health Assistant menu is missing from the VistA CPRS Tools menu, users should contact
their clinical coordinator to have it added.

To start VistA CPRS software application click on the CPRS icon located on the Windows Desktop.

Example: CPRS icon located on the Windows Desktop.

CPRSChart.ink

Once the VistA CPRS software application is started click on the VistA CPRS drop-down list Tools
menu to start Mental Health Assistant.

NOTE: If Mental Health Assistant asks users to logon to VistA again, users should contact their
clinical coordinator to inquire about the availability of a Single Sign-on.

Example: VistA CPRS drop-down list Tools menu displays Mental Health Assistant.

& VistA CPRS in use by: Mhprovider,One (COR-FO-ALBANY)
File Edit Wiew MEEEES Help

MHPATIENT O  Mental Health Assistanty  Jected Primary Ca
000-00-2412 F Lab Test InFDrmatiDn...\N@em

Active Problems Gptions. . =z / Adverse R
Mo Problems Found. i Mo Allergy Aszeszment

Active Medications Clnizal Beminde
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Use of the Software

Click on the “Mental Health Assistant” menu item to start MHAS3. The splash screen is displayed
briefly followed by MHA3 main form.

Example: The Mental Health Assistant splash screen provides the version number of Mental Health
Assistant.

Version Number
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Example: Mental Health Assistant main form.

@ Mental Health Assistant in use by MHPROVIDER,ONE
File Tools Help

One Mhpatient

Mental Health Assistant riaryeh
Instrument Administrator

Instrument Results Review
Addiction Severity Index Manager

Global Assessment of Functioning Manager

GAF rating iz due
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Starting Mental Health Assistant from Off-line Mode

Alternatively, Off-line mode should be used only when the user and equipment are located at a
remote site which has no means of connecting to the VistA network. The Off-line mode starts only
the smaller subset of the Mental Health Assistant functionality. This functionality handles
administering psychological instruments while not connected to VistA. To benefit from the work
performed in the Off-line mode, the user must eventually reconnect to the VistA network, at which
time the Off-line mode data is uploaded to the VistA database.

NOTE: Specific details about the Off-line mode are discussed later in this manual.

To start the Mental Health Assistant from the Off-line mode click on the Mental Health Assistant

3 icon located on the Windows Desktop.

Example: Mental Health Assistant 3 icon.

7B,

Mental Health
Assistant 3

Click on the Yes command button located on the Mental Health Assistant dialog box to start the
Off-line mode function.

Example: Mental Health Assistant dialog box.

Mental Health Assistant @

c)/ MHA is not able to connect to VistA. Do you want to work offine?
L]
.

The only thing you can do offine is administer a test. You can upload the results the next time you're

connected to VistA.
If you can start CPRS from this machine, you should do so and then start MHA from the CPRS tools
menu.
No
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Mental Health Assistant Main Form Functions

The Mental Health Assistant main form is the starting point for launching the four major activity
areas in MHAS3:

Instrument Administrator

Instrument Results Review

Addiction Severity Index Manager

Global Assessment of Functioning Manager

The Mental Health Assistant main form also provides user’s access to GAF rating is due, select
another patient, File, Tools, and Help menus functions.

NOTE: Details about these activity areas are described later in this manual.

Selected Patient Identification Label

The Selected Patient Identification label displays information about the currently-selected patient
within MHAZ3. All functions performed in MHA3 apply to this patient. This patient is the same as the
one selected in CPRS and should remain synchronized with CPRS even when another patient is
selected.

Title Bar

The Title Bar is used throughout MHA3 to display information about the context that applies to the
current activity.

Launch Links

The launch links (i.e., Instrument Administrator, Instrument Results Review, Addiction Severity
Index Manager, and Global Assessment of Functioning Manager) located on the Mental Health
Assistant main menu form function very similar to links on a web page—however, MHAS3 links do
not invoke any web pages. Clicking on a launch link will start a new form that offers the user access
to all the functions associated with that particular activity. Navigation is possible by pressing arrow
keys. A highlighted, underlined link can be selected by pressing the return key.

Instrument Administrator
The Instrument Administrator launch link starts the Instrument Administrator activity, where
instruments are selected for administration, which is explained in detail later in this document.

Instrument Results Review
The Instrument Results Review launch link starts the Instrument Review activity, where results of
previous administrations are visible.
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Addiction Severity Index Manager
The Addiction Severity Index Manage launch link starts the ASI Manager activity where previous
administrations and new administrations are handled.

Global Assessment of Functioning Manager

The Global Assessment of Functioning Manager link starts the GAF Manager where a GAF score
can be entered, previous GAF’s are visible and GAF criteria are quoted.

GAF Rating is Due Label

The “GAF rating is due” label is not a link. It is a notification that is displayed only when a current
patient is overdue for a GAF rating. If the patient is not overdue the “GAF rating is due”
notification is not displayed.

Starting the Instrument Administrator

Example: To start the Instrument Administrator, click on the launch link “Instrument
Administrator” located on the Mental Health Assistant main menu form. It is also possible to
press the “I” key, or the return key (when “Instrument Administrator” is highlighted and underlined)
to display the Instrument Administrator form. After a brief pause, the Instrument Administrator form
is displayed.

@ Mental Health Assistant in use by MHPROVIDER,ONE
File Tools Help

One hMhpatient

Mental Health Assistant s et

Instrument Administrator
i [

Instrument Results Review
Addiction Severity Index Manager

Global Assessment of Functioning Manager

GAF rating iz due

October 2010 MHAS3 User Manual 24
Patch YS*5.01*96



Use of the Software

Example: The Instrument Administrator form is used to start the Instrument Administrator

functions.

w- Mental Health Assistant in use by MHPROYIDER ,ONE
File Tools Help

Instrument Administrator

Instruments Ordered By

IMHPROVIDER,ONE -
Inteniewer:
IMHPROVIDER ONE -

Diate of Administration:
| 5/ /2009

Lo

“izit Location:
|1 Test (north)

Le |

Instructions:

The presentation of instruments can
he filtered: show all (na filter), only
batteries, or only incomplete
instruments.

Awailable Instruments and Batteries:

Show: |A|I j

Instrurments Chosen:

One Mhpatient
SN w2412

BOMC (05/04/2008 10:64:28 Abf) ©
AUDIT (05/04/2009 10:54:08 Akd)
MH Battery B
Screen Battery

AlMS

ATO

AUJDC

ALDIT

AR

BAl

BOIZ

BHS

Display:
" One Question ata Time

+ All Questions at Cnce

£ [= =

|
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Starting the Instrument Results Review Functions

Example: To start the Instrument Results Review function, click on the launch link underline
character Instrument Results Review label. You can also press the “R” key or the return key to
move to the results sections. After a brief pause the Instrument Results Review form is displayed.

». Mental Health Assistant in use by MHPROYIDER ONE s
File Tools Help

One Mhpatient

Mental Health Assistant S

Instrument Administrator

Instrument Results Review
—

Addiction Severity Index Manager

Glaobal Assessment of Functioning Manager

GAF rating iz due
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Example: The Instrument Results Review form is used to start the Instrument Results Review

functions.

m. Mental Health Assistant in use by MHPROYIDER ,ONE

File Edit Wiew Tools Help
. . One Mhpatient
Instrument Results Review: MORSE FALL SCALE SEN x00ec 241 2
Instruments: A
Diate Mamea Morse Fall 3cale
ElFSE [FALL Date Given: 09/23/2009
0&/20/2009 ALDIT Clinician: Mhprovider, Cne
0542042009 BOI2 Lozation: 1 Test (north)
0541242009 BOMC Veteran: Mhpat:i.ent, One
0541242009 AlMS H8N: wwx-ux-Z41Z2
0471 6/2009 CAGE DOE: Feb 1,1592F (B7)
/16 Gender: Female
04/06/2009 CAGE
012042009 PHO-2 Morse Fall Scale dcore: 15
0172042009 PHOY No risk: 0-z4
01/20/2008  SF36 dEy siclss  2g=dd
0171542009 ALUDIT High risk: 45 and higher
01,/08/2009 BRADEM SCALE Questions and Answers
History of falling in past 3 months?
121122008 BOMC e
12/02/2008  CAGE Secondary diagnosis:
12/01/2008 CAGE pe )
Ambulatory aid:
12/01/2008  AUDIT Crutches/cane(s) /fwalker
11/24/2008  AUDIT Intravenous therapy/Heparin lock:
Mo
11724/2008  AUDC Gait/Transferring:
0&/20/2008 Bl Normal/bed rest/immobile
05/20/2008 PCLM MentalIStatus: o o .
Oriented to own ability/knows own limitations
12/08/2006 [EQ
“
Beponts | Graph & Table
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Starting the Addiction Severity Index Manager Function

Example: To start the Addiction Severity Index Manager, click on the launch link underline
character Addiction Severity Index Manager. After a brief pause, the Addiction Severity Index
Manager form is displayed.

& Mental Health Assistant in use by MHPROVIDER ,ONE s
File Tools Help

One Mhpatient

Mental Health Assistant S

Instrument Administrator

Instrument Results Review

oo N

Addiction Severity Index Manager

Glaobal Assessment of Functioning Manager

GAF rating iz due
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Example: Addiction Severity Index Manager Form.

o Mental Health Assistant in use by MHPROVIDER ,ONE
File Edit Wwiew Tools Help

- . One Mhpatient
Addiction Severity Index Manager SN w0041 2

12/08/2006 MHFROVIDER MNEW Completed ue y
061 3/2006 LITE MHFROVIDER.NEW Feady to sign False
0z/08/2006 LITE MHFREOVIDER MNEW Completed True

1028 days since .
last AS] 02/08/2006 LITE MHPROWIDER, MNEW Ready to sign False 7

Previous AS|
Mew ;
Date Twpe Ordered By Status Signed A

MHPATIENT,ONE O000-00-241ZF AST LITE on 1Z/708/Z00& by: MHPROVIDER,NEW
F** PETCHOSOCIAL HISTORY *** =

GCEMNEDMAL INFORMATION

M=. Mhpatient i=s a 27 year old White i(not Hisp), married female NEC wveteran.
She lists her religious preference as Protestant. She was admitted to the
Conzultation/liaison program on Dec 08, Z20056. In the past 30 days, she has not
heen in a controlled environment. Z5he has liwed at her current address for 32
wears, 2 months.

Thisz report is based om an ASI Lite interwview conducted in person on Dec 08,
2006 by New Mhprowvider. Ms. Mhpatient completed the interwview.

Composite Score
MEDICAL 0.0z2zz
EMPLOYMENT 0. 5356

MNarrative Repart ltem Report | tem Trends | Domain Scores

£
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Starting the Global Assessment of Functioning Manager

Example: To start the Global Assessment of Functioning Manager activity, click on the launch
link Global Assessment of Functioning Manager label located on the Mental Health Assistant main
form. As with the previous selections, you can press the “G” key or the return key (when the menu
item is highlighted and underlined) to move to that form. After a brief pause the Global Assessment
of Functioning Manager form will display.

% Mental Health Assistant in use by MHPROYIDER, ONE MisIET
File Tools Help

One Mhpatient

Mental Health Assistant S

Instrument Administrator
Instrument Results Review

Addiction Severity Index Manager

Click o
lobal Assessment of Functioning Manager

GAF rating iz due
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Example: Global Assessment of Functioning Manager form.

& Mental Health Assistant in use by MHPROYIDER ,ONE

File Edit Wiew Action Tools Help
Global Assessment of Funclioning Manager One Mhpatient
d g SSN: 0002417
100+
Date GAF | Clinician e £ 80
05/11/2009 o O
E{L 40
& 20y
0+ f ; ;
bark Bating "Entered in Error" 01421,/2003 01/03/2005 07/19/2006 12/12/2008

GAF Criternia

Fange Criteria. =

tent inahility to maintain minimal

11-20 Some danger of hurting self or cthers (e.g.. suicide attempts without clear expectation of death; frequently violent; OR
occasionally fails to maintain minimal personal hygiene (e.g. smears feces) OR gross impairment in communication (e.g..
largely incoherent ar mute).

21-30 Behavioris considerably influenced by delusions or hallucinations OR serious impairment in communication or judgment
(2.9.. sometime incoherent, acts grossly inappropriately, suicidal precccupation) OR inahility to function in almaost all areas
(2.9.. stays in bed all day: no joh. home ar friends).

31-40 Some impairment in reality testing ar communication (e.g. speech is attimes illogical. obscure, or irrelevant) OR major
impairment in several areas, such as wark or school, family relations. judgment, thinking, or mood (e.g. depressed man
avoids friends, neglects family, and is unable to work; child frequently beats up younger children, is defiant at home and is
failing at schoal).

41-50 Serious symptoms (e.g.. suicidal ideation, severe ohsessional rituals, frequent shopliting) OR any serious impairment in
social, occupational, or schoal functioning (e.0. no friends, unable to keep ajob).

51-60 Maoderate symptoms (e.g.. flat affect and circumstantial speech, occasional panic attacks) OR moderate difficulty in social,
occupational, or school functioning (e.g., few friends, conflicts with peers or cowarkers).

B1-70 Some mild symptoms (e.g.. depressed mood and mild insamnia) OR some difficulty in social, occupational or schoal
functioning (e.g.. occasional truancy, or theft within the household), but generally functioning prettywell, has some meaningful
interpersonal relationships.

71-80 If svmptams are present, they are transient and expectable reactions to psychosaocial stressors (e.g. difficulty concentrating
after family argurnent); no mare than slight impairment in social, occupational, or schoaol functioning (e.q.. termporarily falling
behind in schoohwork).

81-90 Absent or minimal symptoms (e.9. mild anxiety before an exam), good functioning in all areas, interested and involved in a
wide range of activities, socially effective, generally satisfied with life, no mare than everyday problems or concerns (e.g. an
occasional argument with family members).

91-100 Superiorfunctioning in awide range of activities, life's problerms nesver seem to get out of hand, is sought out by others
because of his or her many positrve qualitites. Mo symptoms. w

Iew GAF rating: |1 S Ewalugtion Date: |10/ 1/2009 -
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GAF rating is due

Example: The “GAF rating is due” alert is displayed at the bottom-right of the main form if a GAF
rating is due for the currently-selected patient. If a GAF is not required at this time, the alert is not
displayed.

% Mental Health Assistant in use by MHPROVIDER ,ONE MiSE
File Tools Help

One hMhpatient

Mental Health Assistant s

Instrument Administrator
Instrument Results Review
Addiction Severity Index Manager

Global Assessment of Functioning Manager

GAF rating iz due
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File Menu

The Mental Health Assistant drop-down list File menu contains the following three menu items:
e Seclect Patient...
e Upload Results...
e Exit

NOTE: Refer to the CPRS documentation for instructions on patient selection procedures.

Select Patient

Example: From the Mental Health Assistant form click on the drop-down File menu and click on
the Select Patient... menu item. After a brief pause, the familiar CPRS patient-selection form is
displayed. After selecting a different patient, both CPRS and MHAZ3 are synchronized and updated to
identify the same new patient.

@ Mental Health Assistant in use by MHPROVIDER ,ONE
FIEN Tools Help

Select Patient...A/_ . Ona Mhpatient
| Health Assistant SN oo 2412

Exit:

Instrument Administrator

Instrument Results Review

Addiction Severity Index Manager

Glaobal Assessment of Functioning Manager

GAF rating iz due
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Upload Results

Example: If any off-line administered records remain on this PC, the Upload Results menu item
becomes enabled. If no records need to be uploaded to Vista, this menu item is visible, but disabled.

Clicking on the Upload Results menu item initiates the process for uploading off-line records to
VistA.

& Mental Health Assistant in use by MHPROVIDER ,OME
FEW Tools Help

Select Patient... One Mhpatient

wosiress.. Al Health Assistant SN 00602412

Instrument Administrator

Instrument Results Review

Addiction Severity Index Manager

Global Assessment of Functioning Manager

GAF rating iz due
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Exit

Example: To exit the Mental Health Assistant form and return to the Windows Desktop, click on

File then Exit, or click on the Close (X) icon located at the top-right of the Mental Health Assistant

form, or press and hold the Alt key then press the F4 key.

@ Mental Health Assistant in use by MHPROVIDER ,ONE
ZEN Tools Help

Select Patient. ..

One Mhpatient

| Health Assistant SSN: 00002412

Ipload Resulks, ..

Exit

Instrument Administrator
Instrument Results Review
Addiction Severity Index Manager

Glaobal Assessment of Functioning Manager

GAF rating iz due

October 2010 MHAS3 User Manual
Patch YS*5.01*96

35



Use of the Software

Tools Menu

METRIC Instrument Reviews...

The METRIC Instrument Reviews menu item is located on the Mental Health Assistant drop-
down Tools menu. The METRIC Instrument Reviews offers comprehensive information about all
sorts of instruments, including Mental Health instruments. This menu item is offered as a courtesy
and a quick way to link the METRIC website from Mental Health Assistant. This website is not
associated in any way with Mental Health Assistant.

Click on the drop-down list Tools and click on the METRIC Instrument Reviews... menu item
display the METRIC website homepage.

Example: The METRIC Instrument Reviews menu item is located on the Mental Health Assistant
dialog box Tools drop-down menu.

& Mental Health Assistant in use by MHPROVIDER ,ONE ==

Fil= BEEEN Help
METRIC Instrurment Reviews, /_ 0 .
. ne hhpatient |
E Options. .. kh ASSIStant SEMN oo-o-2412

Instrument Administrator

Instrument Results Review

Addiction Severity Index Manager

Global Assessment of Functioning Manager

GAF rating iz due
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Example: METRIC website displayed in Internet Explorer.

._.f’_" Metric - Mental Health - Windows Internet Explorer
e

E\ v l_/']v |g http://vaww.mentalhealth.va.gov/mha/metric.asp V‘ 4 | XK ‘ | Pl-

Fle Edit View Favorites Tools Help

S_’,E #}G /& Metric - Mental Health l_l 1"}’7 @ [_] o= - ;'_::)(Eagev f} Tools + »
Unirenswrss WV KANET Jsearch)

DEPARTMENT OF VETERANS AFFAIRS s

VA Intranet Home About VA Organizations Locations Employee Resources

Mental Health Home
MENTAL HEALTH

Resources for
Clinicians

Resources for Metric

Administrators

IRicainipsant & VA Health Services Research and Development: METRIC.

S The METRIC Instrument Reviews were designed to give researchers the

Site Search information necessary to make informed decisions about choosing a
measure for their needs.

Disclaimer
This measurement section is an archive of original topic pieces and extermnal
resources that were selected and evaluated by METRIC, an HSR&D Resource

Center.

Please note that METRIC is no longer a Resource Center and that these
sections are not currently being updated. (last updated in June 2006).

Section 508 Accessibility | Intranet Privacy Folicy | No Fear Act
WHA Intranet Home | VBA Intranet Home | NCA Intranet Home

Reviewed/Updated Date: August 6, 2008

&) Local intranet #100% -~
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Options

Clicking on the Tools Options menu item invokes the User Preferences form, where users can choose
from different MHA3 system properties and behaviors.

Changing User Preferences

Example: Some system parameters are user-configurable and can be changed by clicking on the
drop-down Tools menu and Options... menu item. The User Preferences form appears, allowing the
user to make system changes, such as the default display font. The user may optionally abort changes
before they are saved.

% Mental Health Assistant in use by MHPROYIDER  ONE ==
Fil= BEEEN Help
METRIC Instrument Reviews. .. :
. One Mhpatient
E Optinnsi h ASSISta nt SEMN: wooco-2412

Instrument Administrator

Instrument Results Review

Addiction Severity Index Manager

Global Assessment of Functioning Manager

GAF rating iz due
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Example: Mental Health Assistant User Preferences form.

&~ User Preferences

Eont | Miscellaneous

Instructions:

CPRS Font

Fonton display: MS Sans Serf Size: 0

Thig menu will demonstrate fonts selected below.
Click the "Done" button to incorporate a font in kMHA,

’ Winidows Font ]

Cancel

Done

October 2010
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Help Menu

The Mental Health Assistant Help menu contains the following two menu items:
e Online Support
e About

Online Support...

Example: The Mental Health Assistant Online Support is available via the Mental Health
Informatics Section’s website. Clicking on the Help menu and Online Support... menu item will
start the default Web browser and loads the following web address into the browser:
http://vaww.mentalhealth.va.gov.

@ Mental Health Assistant in use by MHPROVIDER ,ONE

File Tools BgEls Click
Online Suppurt./_

Cne Mhpatient

l\ About, .. &alth ASSiStant SEMN: w2412

Instrument Administrator

Instrument Results Review

Addiction Severity Index Manager

Global Assessment of Functioning Manager

GAF rating iz due
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About...

The About... menu item contains useful release information about MHA Version 3.

Accessing Program Information

Example: Clicking on the drop-down list Help menu > About... menu item displays the About
Mental Health Assistant form.

». Mental Health Assistant in use by MHPROVIDER ONE Eo&X
File Tools BgEls

nline Suppart. .. One Mhpatient

l\ P.I:u:uut..v\ &alth ASSiStant SaMN: -2 412

Instrument Administrator

Instrument Results Review

Addiction Severity Index Manager

Global Assessment of Functioning Manager

GAF rating i1z due
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Example: The About Mental Health Assistant form.

o About Mental Health Assistant

Mental Health Assistant

Client%ersion: 1.0.3.45

bental Health Fackage Fatch Required:
%R 01*96

Campile Date: 110172010 07:00:06 Akd
CRC: 2386450107

RPC Broker Yersion: =M/E*1 1*40
RPCYerzion: 0

Located: RPCBroken

in accordance with %A policy on security and privacy.

there may be otherissues,

Developed by the Department of Yeterans Affairs. Linauthorized access or
misuse of this system and/or it's data is a federal crime. Lse of all data shall be

MOTE: The Weterans Health Administration (vHA) fully supports Section 508
of The Rehabhilitation Act and is committed to equal access for all users. While
every effort has been made to ensure Section 08 compliance, wea realize that
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Instrument Administrator Functions
Orientation

The Instrument Administrator functions allow the user to order new tests to administer to selected
patient and specify the data entry mode for the ordered tests. First, the user must specify the user’s
name that is requesting the test to be ordered. By default, the user requesting the test to be ordered is
identified as the session user. However, another user may be specified as the user requesting the test
to be ordered, in which case, the original user’s name that requested the test is notified by VistA E-
mail that tests were administered in his/her name. The available set of tests that can be ordered
depends on the user access privileges (for example, whether the user ordering the test has the YSP
key assigned).

Example: Mental Health Assistant Instrument Administrator form.

@ Mental Health Assistant in use by MHPROYIDER ,ONE

File Tools Help
i .
+— Title bar — > One Mhpatient

Instrument Administrator SN o042

Instruments Ordered By Available Instruments and Batteries: Instrurments Chosen:
IMHPROVIDER ONE T shom: m -
Interviewer: K
|MHPROVIDERONE j BOMCNUEIDMZDDB1D:54:28AM] A J
D of Aebiisieien AUDIT (N5/04/2009 10:54:06 Abdl J
| 5/ /2009 ~| MH Batle\xt 3 J
Wisit Location: Screen Ba List Filter
|1 Test(narth) - AIMS
Instructions: ATQ List of chosen
AL instruments in order of
The presentation yf instruments can administration
be filtered: show all o filter). only AUDIT <
hatteries, ar only incoiplete = aur Instrument
instruments. o Display:
Visit Info ;
] Bal List ~ One Question ata Time
£ BoR
BHES /G All Questions at Once
Data-entry —
Mode
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Main Menu

The Main Menu offers user functions in the context of the Instrument Administrator Form, such
as selecting another patient and help.

Selected Patient Identification label

The Selected Patient Identification label displays information about who is the currently-selected
patient within MHAS3. All functions performed in the Instrument Administrator will apply to this
patient. This patient is the same as the one selected in CPRS and should remain synchronized with
CPRS even when another patient is selected.

Title bar
The Title Bar is a visual artifact that is used throughout MHAS3 to display information about the
context that applies to the current activity.

Visit information
The Visit information group of data-entry controls is used to describe the clinical particulars of a
patient’s visit, such as the clinician’s name and the location of the visit.

List filters
The list filters are used to change the number and types of instruments displayed in the Instruments
and Batteries list.

Available Instruments and Batteries list

The Available Instrument and Batteries list is used to select which instruments will be administered.
In some cases there will only be one instrument selected. But, this list also allows for selecting
multiple instruments or batteries, or a combination of both.

Instruments Chosen list

The Instruments Chosen list is the collection of instruments selected in the Instruments and Batteries
list. The instruments are listed here in the order in which they will be administered—from top to
bottom.

Re-sequencing buttons
The re-sequencing buttons are used to alter the order in which the instruments in the Instruments
Chosen list will be administered. Instruments can be removed from the list too.

Data-entry mode selection
There are several combinations of data-entry display modes which are selected using the data-entry
mode selection buttons.

Context-sensitive help
Context-sensitive help tips are displayed in this area and are dependent on where the mouse pointer is
resting.
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Ordering Tests

Tests can be ordered in three ways:

1. An existing test battery may be selected.

2. Anincomplete test may be restarted if it has not been too long since it was first started. The
MMPI2, for example, must be completed within 24 hours; some instruments do not have time
limits. Most instruments have a two day time for completion. If the time period has lapsed,
the incomplete instrument will not be listed.

3. New tests may be selected individually and their order of administration specified.

The Instrument Administrator Permits the User to select one of two Data Entry Modes:

1. Staff entry, which is optimized for staff data entry when the staff person wishes to see test
questions and answers while entering data.

2. Patient entry, which is optimized for on-line administration of tests to the patient.

NOTE: Patient entry invokes special security measures to prevent patients from using the PC for any
other purpose than answering questions. Because security measures are not invoked for the staff
entry modes it must not be used for the on-line administration of tests to patients. (See Appendix E
for more information on SecureDesktop.)
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Selecting a Person (other than yourself) for Instruments Ordered By

By default, the current user’s name is selected. So, it is necessary to select a different name only if
the user is not the same person ordering the tests. To select a new person:

1. Click on the drop-down list box labeled Instruments Ordered By.
2. From the Ordered By list, select the name of the person ordering the tests.

Example: The Instrument Ordered By person will receive an email notification in VistA regarding
the administration and also appears as the Instrument Ordered By person in all reports related to
this administration.

& Mental Health Assistant in use by MHPROVIDER ,ONE

Eile Tools Help
- Click One Mhpatient
Instrument Administrator - SEM 0002412
Instruments Ordered By Available Instruments and Batteries: Instruments Chosen:
MHPROWIDER,OMNE - )
| J Shiow: |A|I j
Interviewer:
|MHPROVIDERONE j BOMC [05/04/2009 10:54:28 Abf) & J
Date of Administration: AUDIT (05/04/2009 10:54:06 A J
| 5/ /2009 | MH Battery J
Yisit Location: Screen Battery
|1 Test {north) - AIMS
Instructions: ATQ
AUDC
The presentation of instruments can
be filtered: show all (no filter). onky AUDIT < »
hatteries, ar only incomplete ALIR
instrurnents. Display:
BAI " One Question ata Time
BDIZ
BHS 2 f+ All Questions at Once
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Selecting a Person for “Interviewer”

By default, the current user’s name is selected. So, it is necessary to select a different name only if
the user is not the same person as the interviewer. To select a new person:

1. Click on the Drop-Down List Box labeled Interviewer

2. Select a name from the list

Example: The selected name also appears as the “Interviewer”, or “Printer” person in all reports

related to the administration.

@ Mental Health Assistant in use by MHPROYIDER ,ONE

File Tools Help

Instrument Administrator

Instruments Ordered By

i) ents and Batteries:
A -

Instrurments Chosen:

One Mhpatient
SEM: o2 412

IMHPROVIDER ONE p
Interviewer:
|MHPROVIDERONE j BOMC (05/04/2009 10.54.28 Ahfy & J
Date of Administration: AUDIT (05/04/2009 10:54:06 Ak J
| 5/ /2009 ~| MH Battery J
“igit Location: Screen Battery
|1 Test(narth) - AIMS
Instructions: AT
AUDC
The presentation of instruments can
be filtered: show all (no filter). onky AUDIT < »
hatteries, ar only incomplete ALIR
instruments. Display:
BAI " One Question ata Time
EDI2
BHS f+ All Questions at Once
October 2010 MHAS3 User Manual 47

Patch YS*5.01*96



Use of the Software

Selecting a Date of Administration

By default, today’s day is selected. So, it is necessary to select a different date only if the date of
administration is not the same as the current date. Future dates are not allowed. To select a new date:

1. Click on the Date-Picker labeled Date of Administration
2. Select the administration date from the calendar.

Example: The selected date also appears as the date in all reports related to this administration.

w. Mental Health Assistant in use by MHPROYIDER ,ONE
File Tools Help

'y One Mhpatient
Instrument Administrator SSIN: 000002412
Instruments Ordered By: Available Instruments and Batteries: Ingtruments Chosen:
MHPROYWIDER, OMNE M
| J Shiow: |AII j
Interviewer:
|MHPROVIDERONE j BOMC (05/04/2009 10:54:26 Abd J
D o Ao AUDIT (05/04/2009 10:54:06 Akd) J
| 5/ /2009 e MH Battery 3 J

[« ] May, 2009 [+ |

Sun kon Tue Wed Thu Fri Sat
12
i 4@ 7 5 8§
011 12 14 15 16 2
o7 18 19 20 ) z
24 25 26 27 28 29 : Display;
3l £ Ba e ,
" One Cuestion ata T
T Today: 5/5/2009 - One Question ata Time
BHS = f+ Al Questions at Once
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Selecting a Visit Location

By default, the previously-selected Visit Location is selected. So, it is necessary to select a different
location only if the location is different from the one displayed. To select a new location:

1. Click on the Drop-Down List Box labeled Visit Location
2. Select a different location from the list.

Example: The selected location also appears as the location in all reports related to this
administration.

® Mental Health Assistant in use by MHPROYIDER ,ONE =13
File Tools Help
. One Mhpatient
Instrument Administrator SEIN: 00002412
Instrurnents Ordered By Awvailable Instruments and Batteries: Instruments Chosen:
MHFROWIDER, OMNE )
| J Show: |A|| j
Intersdewear:
IMHPROVIDER,ONE - BOMC (05/04/2009 105420 Akd) J
Diate of Administration: & 1. Click to open list J
| 5/ /2009 - _ J
Wisit Location: / Screen Battery
1 Test (north] | AlMS
3East 4] ATQ
3 Maorth ] —
4 East . .
aNoth «—— | | IR Click to make a selection 3 | 2
4 South = =
5 East Bl AR Display:
E Morth BAl - RO
7 At j One Question ata Time
BDI2
BH= | | ® AllQuestions at Once
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Filtering the display of Available Instruments and Batteries List

Which tests appear in the Available Instruments and Batteries list box depends on the user’s access
privileges to order tests (i.e., user must hold the YSP security key.) By default, the list of Available
Instruments and Batteries displays all instruments and batteries that the user identified as the Ordered
By user has permission to administer. However, the list of Available Instruments and Batteries can be
filtered in four different ways:

1. All instruments and batteries, in alphabetical order.

2. Batteries only.

3. Restartable instruments only (incomplete instruments which may be resumed.)
To change the lists filter:

1. Click on the Drop-Down List Box labeled Show
2. Select a filter for the list of available instruments.

Example: The displayed Instrument List changes to include only the instruments that meet the new
filter’s specification.

w. Mental Health Assistant in use by MHPROVIDER,ONE

File Tools Help
.. One Mhpatient
Instrument Administrator 1. Click to SN oot D1?
Instrurnents Orderad By Avsailable nstruments and Batteries: Ingtruments Chosen:
[MHPROVIDER,ONE El| R i
Interviewer: A —
MHPPROYIDER, ONE - ElBatteries only 4
R rable onl
Date of Administration: m‘ J
| 5/ /2009 - MH Battery ]
- P i=] Screen Batte - -
st Lecailomn = i 2. Click to make a selection
|1 Test (north) - AlMS
Instructions: ATQ
ADC
The presentation of instruments can
be filtered: show all ino filter), onlky AUDIT < b4
bafteries, or only incomplete ALIR
instruments. Display:
BAI " One Question ata Time
BOI2
BH= || | AllQuestions at Once
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Choosing One or More Instruments

By default, nothing is selected on the list of Available Instruments and Batteries. The user must
choose one or more instruments to administer during this session. In the case where there are
multiple instruments that are administered frequently, the user has an option to create and select
instrument batteries, which simplify selecting groups of instruments. The user may select any
combination of single instruments and batteries.

To select instruments or batteries, click on the check box next to the Available Instruments and
Batteries list box names found on the Instrument List.

Example: The Available Instruments and Batteries list box located on the Mental Health Assistant
form.

w.- Mental Health Assistant in use by MHPROYIDER,ONE
File Tools Help

Instrument Administr 2. Selected tests appear in the One Mhpstient

Instruments Chosen list SEN ooc0c24T2
Instrurnents Orderad By ' - e . Instruments Chosen:
FMHPROWIDER, ONE - :
| J Show: |A|| j AIMS
= AUDC
Interviemer:
MHPROVIDER ONE - BOMC (05/04/2003 10:54:28 Abf) # 4
Dats of Administration: AUDIT (05/04/2009 10:54:06 Akl ﬂ
| 5/ 5/2009 - MH Battery J
Wigit Location: Screen Battery
|1 Test (north) - AlMS
Instructions: A
Select the instrument by checking its AUDC 1. Click on check box next
biox with the mouse. or use the arrow AUDIT "
keys and space-harto select. to Instrument names b4
Underlined instruments are ALIR -
incormplete. . BAI cheplay
Bold indicates a battery which " One Question ata Time
containg many instrurments. BOI2
Fight click an an instrument for more BHS # All Questions at Once Stat Entry
information. hs -

The selected instruments appear in the list of Instruments Chosen. These are the instruments
selected for administration.

NOTE: Instruments are added to the Instruments Chosen list in the order in which they were selected
in the Instrument List. This is the same sequence in which the tests will be administered. The date
and time of administration is appended at the end of an incomplete test name.
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Restarting Incomplete Tests

Whether an incomplete test can be restarted depends on how long ago it was first entered in the
VistA Mental Health Package (MHP) database. The permissible lapse is a local site parameter that is
set using MHS Manager\Psych Test Utilities\Edit Instrument Restart Limit [YSINST RESTART
LIMIT] option (usually two days). Restarting an incomplete test from the Instruments Chosen list
box is no different from starting a new test, so that process is not described here.

Manipulate the list of Instruments Chosen

After two or more instruments are added to the Instruments Chosen list, it is possible to rearrange the
order in which they will be administered. The re-sequencing buttons may be used to change the order
of the instruments in the list, or to remove instruments from the list. The order of administration is
always from top to bottom.

To change the order, select the instrument item in the Instruments Chosen list. Using the re-
sequencing buttons:

e Click on the up-arrow button to move the instrument up the list.
e Click on the down-arrow button to move the instrument down the list.
e Click on the left-arrow button to remove the instrument from the list.

Example: The Instruments Chosen list box is located on the Mental Health Assistant Instrument
Administer Form.

& Mental Health Assistant in use by MHPROYIDER ,ONE

File Tools Help
Instrument Administrator 1. Click on an item ss?qﬁﬂﬁaztﬁnzt
in the list to select it '
Instruments Ordered By: A Instrurments Chosen:
MHPRCOWIDER, ONE -
| J Showe: |A|I j AT
Intervieswer: gy
= PCFTSD
MHPROVIDER OMNE B MMPI2 = 4/
Date of Administration: MORSE FALL SCALE ﬂ
| 5 52009 = PCPTED ﬂ
“isit Location: PCLC
|1 Test (north) - PCLM
Instructions: PHO-2 2. Use the re-sequencing
PHAS buttons to move the selected
Thig is the order in which the i i
instruments will be presented. RLOC item up -OI’ down the_ IISt’ or k4
SAl remove it from the list
Use the arrows to change the order 3 _
or rernayve an instrurnent. SCLIR entlrely. ime
’ Staff Entry
"
|=f| SF3R " All Questions at Once _
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Selecting Display Mode for Data Entry

There are two display modes in MHAS3: Display One Question at a Time, or display All Questions at
Once.

The One Question at a Time display mode is ideal for patient-entry, since it only displays one
question in the data entry form. This allows for a more focused and relaxed approach to responding
to questions.

The All Questions at Once display mode is ideal for staff-entry, since it displays all the questions in
a scrollable window. This allows for rapid navigation between questions, and a faster approach to
entering data.

In MHAZ3, either One Question at a Time or All Questions at Once may be used for patient-entry
or staff-entry modes. It is a user preference choice.

e To select One Question at a Time display mode, click on the One Question at a Time
option button.

e To select All Questions at Once display mode, click on the All Questions at Once
option button.

e At least one test must be available in Instruments Chosen.

Example: Instruments Chosen list box is located on the Mental Health Assistant Instrument
Administer Form.

& Mental Health Assistant in use by MHPROYIDER ,ONE

File Tools Help
. One tMhpatient
Instrument Administrator Ny
Instruments Ordered By: Asailable Instruments and Batteries: Instrurments Chosen:
MHPROYWIDER,ONE - .
| J Show: |A|I j AlAS
Irterviewer:
= FPCFTSD
[MHPROVIDER, ONE - Y=r - ﬂ
Date of Administration: MORSE FALL SCALE ﬂ
| 5/ 5/2009 =l PCPTSD -
*isit Location: PCLC
|1 Test (north) - PCLM
Instructions: FHO-2
This is the order in which the Select Display mode
instruments will be presented. < ?
Lzeth to ch the ard A Display:
se the arrows to change the order :
ar remaowve an instrument. SCLIR ™ One Question ata Time = 4
-
] Staff Entry
' =
= sF36 " All Questions at Once
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Selecting Patient Entry Data Entry Mode

Patient-entry mode supports the on-line testing of patients, which is by far the most common method
of computerized testing in VHA. Patient Entry has added security features to prevent unattended
patients from using the PC for unauthorized purposes. Clicking on the Patient Entry command
button triggers the activation of the SecureDesktop security functionality. To start patient entry
mode:

1. Click on the Patient Entry button

2. Click on Yes in response to the first warning prompt. Click on No, to abort invoking

SecureDesktop and cancel patient entry.
3. Click on OK to respond to the second warning prompt

Additional notes about Patient-Entry mode:

e At least one test must be available in the Instruments Chosen list.

e |f the Patient Entry button is disabled, this means that the SecureDesktop software is not
properly installed on this PC — contact your local IRM for support, if needed.

e Any time Patient Entry mode is invoked, two warning messages are displayed. These
messages are an indication that SecureDesktop is about to be activated.

e The Single-Question form or the All-Questions form is displayed, depending on which
option button was selected.

e Appendix E has further details about the operation of SecureDesktop.

Example: The Instruments Chosen list box is located on the Mental Health Assistant Instrument
Administer Form displaying the Patient Entry button.

& Mental Health Assistant in use by MHPROYIDER ,ONE
File Tools Help

One Mhpatient

Instrument Administrator SN w0412
Instruments Ordered By: Asailable Instruments and Batteries: Instrurments Chosen:
MHPROYWIDER,ONE - .
| J Show: |A|I j

Interdiewear: Upc
r — [PCPTSD
MHPROVIDER ONE g

Date of Administration:

2. Click on Patient Entry

4 [+ |

| 5/ 5/2009 - -
“isit Location: PCLC
|1 Test (north) - PCLM

Instructions: .
1. Select Display mode
Thisg is the order inwhich the

instruments will be presented. RLOC s 2
Lzeth to ch the ard A Display:
se the arrows to change the order :

ar remaowve an instrument. SCLIR ™ One Question ata Time = 4

s
] Staff Entry
' =
|=f| SF3R " All Questions at Once
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Example: SecureDesktop WARNING prompt #1.

SecureDesktop Warning

WARNING

Fram thiz point on, the weteran will be answering questions on the
ingtruments selected. To maintain security, all other functions on this
camputer will be unavailable.

All unzaved work, in other programsz zhould be zaved and the
programs clozed before continuing.

YWhen pou have finizhed, this computer will automatically return to
thie log-on window.

AFTER COMPLETING THE TEST([S). USER IS AUTOMATICALLY
LOGGED OFF FROM THE SYSTEM

Do you wizh to continue?

SecureDesktop Warning

WARNING

LSE OMLY ALPHA-MUMERIC KEYS ON THE KEYEOARD.

[Jzing any other kevs will cause the test to abort.
All kepstrokez are monitored for securnty violations.
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Selecting Staff Entry Data Entry Mode

1. Click on the Staff Entry button.

Additional notes about Staff-Entry mode:
e At least one test must be available in the Instruments Chosen list.

e Staff-entry mode does not make use of the SecureDesktop functionality, since it is intended

for staff use only, not for patients.

e The Single-Question form or the All-Questions form is displayed, depending on which

option button was selected

Example: The Instruments Chosen list box is located on the Mental Health Assistant Instrument
Administer Form displaying the Staff Entry button.

@ Mental Health Assistant in use by MHPROYIDER ,ONE

Fle Tools Help

Instrument Administrator

Instruments Ordered By:

IMHPROVIDER ONE -
Intersiewer:

IMHPROVIDER,ONE -
Date of Administration:

| 5/ /2009 -
Yisit Location:

|1 Test (north) -
Instructions:

This is the order inwhich the
instruments will be presented.

Llse the arrows to change the
or remowve an instrument,

Assailable Instruments and Batteries:

Show: |A|| j

-

MMPI2

MORSE FALL SCALE
FPCFTSD

PCLC

PHCR
PHQY
RLOC

One Mhpatient
SN w2412

Instrurments Chosen:

s 2. Click on Staff Entry mode

[« |>

Display:
" One Question ata Time

Staff Entry

[

* Al Questions at Once
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On-form Instructions

Example: The On-form Instructions are displayed in the bottom-left corner of the Instrument
Administrator form. These are context-sensitive help tips that instructions change depending upon
which part of the form the mouse pointer is resting on. Not all elements of the form trigger

instructions.

@ Mental Health Assistant in use by MHPROYIDER ,ONE

Fle Tools Help

Instrument Administrator

Instruments Ordered By:

Assailable Instruments and Batteries:

Instrurments Chosen:

One Mhpatient
SN w2412

AlbAS

FCFTED

Display:
" One Question ata Time

IMHPROVIDER ONE A1 show m 7
Intersiewer:
IMHPROVIDER,ONE - = =
Date of Administration: MORSE FALL SCALE
| &/ 572009 =l PCPTED
Yisit Location: FCLC : .
1 Test (narth) B =YY |nstructions are displayed here
Instructions: / PHG-2
. N PHOY
This is the order in which the
instruments will be presented. RLOC
SAl
Llse the arrows to change the order
or remawve an instrurment. SCLIR
SDES 1
| SF36

* Al Questions at Once

[« |>

2

Staff Entry
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Selecting a Different Patient

To select a different patient, click on the File > Select Patient... menu item. After a brief pause, the
familiar CPRS patient-selection form is displayed. After selecting a different patient, both CPRS and
MHAZ are synchronized and updated to identify the same different patient.

NOTE: Refer to the CPRS documentation for instructions on patient selection procedures.

Example: The Tools drop-down list is located on the Mental Health Assistant Instrument
Administer Form displaying the Select Patient...menu item button.

w. Mental Health Assistant in use by MHPROVIDER,ONE

3-8 Tools Help .
e One Mhpas
- ne Mhpatient
et ministrator SEN: 0002417
Instrurnents Orderad By: Avsailable nstruments and Batteries: Ingtruments Chosen:
MHPROWIDER, OMNE - )
| J Shiow |AI| j
Interviewer:
z PCFTSD
IMHPROVIDER ONE - MMEI2 2 ﬂ
Date of Administration: WMORSE FALL SCALE ﬂ
| & 572009 = PCPTSD -
Visit Location: PCLC
|1 Test {north) - BOLM
Instructions: PHO-2
. N PHQY
This is the order in which the
instrurnents will be presented. RLOC S %
Use th to ch the ord = Display:
ze the arrows to change the order :
or remaowve an instrument. SCLIR " QOne Question ata Time = L
S
; Staff Entry
i+ =
= sF36 3 All Questions at Once
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Exiting the Instrument Administrator Form

Example: To exit from the Instrument Administrator form, click on the File > Exit menu item.
Alternatively, you can click on the “X” in the upper right-hand corner of the window, or, press the
“ESC” key. The Instrument Administrator form will close and the user is returned to the Mental

Health Assistant main form.

& Mental Health Assistant in use by MHPROYIDER ,ONE

N Tools Help

Select Patient. .. L
ministrator
Instrumente Ordered By:

IMHPROYIDER ONE -
Date of Administration:

| 5/ 5/2009 =
Yigit Location:

|1 Test (north) -
Instructions:

These instructions change
depending upon the location of the
MOouse ar cursar.

Cne Mhpatient
SEM: w2412

Ayailable nstrurments and Batteries: Instrurments Chosen:

IMHPROVIDERSWNE Show: Al -
Interviewer:

MMPI2
MORSE FALL SCALE
PCPTSD

PCLC

PCLM

PHQ-2

PHQI

RLOC < | >
54|

SoLSR Patient Entry

" One Question ata Time

SDES
- f All Questions at Once Staff Entry

SF3E

4 = >
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Use of the Software

Invoking the METRIC Instrument Reviews Website

The METRIC Instrument Reviews website offers comprehensive information about all sorts of
instruments, including Mental Health instruments. This menu item is offered as a courtesy and quick
way to link to this website from within MHA3. The METRIC website is not associated in any way

with MHAS.

Example: Clicking on Tools > METRIC Instrument Reviews... menu item causes the user’s
default Web browser to display the homepage of the METRIC website.

& Mental Health Assistant in use by MHPROYIDER ,ONE

Battery Wizard,..
| Opkions, ..

IMHPROVIDER ONE -

Intersiewer:
IMHPROVIDER,ONE -

Date of Administration:
| 5/ /2009 -

Yisit Location:
|1 Test (north) -

Instructions:

These instructions change
depending upon the location of the
Mouse ar cursor.

-

Assailable Instruments and Batteries:

Show: |A||

[

Instrurments Chosen:

One Mhpatient
SN w2412

MMPI2
MORSE FALL SCALE
FCPFTSD
FCLC
FCLM
FHO-2
FHQY
RLOC
SA
SCLAR
SDES
SF36

AlbAS

PCFTSD

Display:
" One Question ata Time

* Al Questions at Once

4 [« |

>

Staff Entry
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Use of the Software

Example: METRIC website displayed in Internet Explorer.

._.f’_" Metric - Mental Health - Windows Internet Explorer
e

E\ v l_/']v |g http://vaww.mentalhealth.va.gov/mha/metric.asp V‘ 4 | XK ‘ | Pl-

Fle Edit View Favorites Tools Help

S_’,E #}G /& Metric - Mental Health l_l 1"}’7 @ [_] o= - ;'_::)(Eagev f} Tools + »
Unirenswrss WV KANET Jsearch)

DEPARTMENT OF VETERANS AFFAIRS s

VA Intranet Home About VA Organizations Locations Employee Resources

Mental Health Home
MENTAL HEALTH

Resources for
Clinicians

Resources for Metric

Administrators

IRicainipsant & VA Health Services Research and Development: METRIC.

S The METRIC Instrument Reviews were designed to give researchers the

Site Search information necessary to make informed decisions about choosing a
measure for their needs.

Disclaimer
This measurement section is an archive of original topic pieces and extermnal
resources that were selected and evaluated by METRIC, an HSR&D Resource

Center.

Please note that METRIC is no longer a Resource Center and that these
sections are not currently being updated. (last updated in June 2006).

Section 508 Accessibility | Intranet Privacy Folicy | No Fear Act
WHA Intranet Home | VBA Intranet Home | NCA Intranet Home

Reviewed/Updated Date: August 6, 2008

&) Local intranet #100% -~
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Reviewing a Description of the Selected Instrument

Example: The clinical and technical features of any particular instrument supported by MHA3 can
be reviewed by clicking on the instrument name followed by clicking on Help > Instrument
Description... You can right-click on the instrument to perform the same operation.

#. Mental Health Assistant in use by MHPROVIDER ONE (=1[E3
File  Tools Hgkls
Inst Instrument Description. . 2. C||Ck, to view a description One Mhpatient
nsirun Online Suppart... SN 002412
Instrum e Ayailable nstrurments and Batteries: Instrurments Chosen:
MHFRCOvoerrome =T S how: |,.¢-\|| j LlkAS
Interviewer: AUDE
= : FCPTSD
IMHPROYIDER ONE - =r A ﬂ
Diate of Administration: FMORSE FALL SCALE ﬂ
| &/ 52009 -~ B 5] PcPTSD «|
“igit Location: FCLC
|1 Test (north) - POLM
Instrucions: PHG-2 1. Click on an instrument
PHQI name to select it
These instructions change
depending upon the location of the RLOC 8 | X
MOUgEe Or Cursor. SAl
SCLIR " One Question ata Time = L
o L
: Staff Entry
— 0 =
= cF36 v All Questions at Once
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Use of the Software

Example: Description of an instrument.

& Mental Health Assistant
File Edit Help

Description of PCPTSD

Clinical Features

Print Title: Primary Care PT3D 3creen

Version:

Author: A Prins, et al.

Publisher: LibraFPharm

Copyright:

Publication Date: 2004

Feference: Primary Care Psychiatry 2(1):9-14, January 2004

Purpose: screen for PTRD related symwptoms in a primary care
Setting

Norm Sammple:

Target Population:

Technical Features

Aidtninistration Priwvilege:
Fesults Privilege:

Entered EBv: Vol TR LY LT
Entry Date: NOV 22, 2005

Last Edited Evy: T LA T
Last Edit Date: 02/12/2009
MNational Test: TRUE

Fequires License: FAL3IE

I=s Legacy Instrument: FALLSE
Submit To MNational DE: TRUE
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Accessing Online Support

Example: Online support for MHAS is available via the Mental Health Informatics Section’s
website. Clicking on the Help > Online Support... menu item will start the default Web browser
and loads the following web address into the browser: http://vaww.mentalhealth.va.gov.

@ Mental Health Assistant in use by MHPROYIDER ,ONE

File Tools NgElE
Click One Mhpatient
SN w0oex-2412

Instrun

Online Support, ..

Available Instruments and Batteries: Instruments Chosen:
Showy: |A|I j
Intersiener:
|MHPROVIDERONE j EOMC (05/04/2009 10:54:25 Ah] J
Date of Administration: AUDIT (05/04/2009 10:54:06 Akd) J
| & 5/2009 -l MH Battery 2 =
“isit Location: Screen Battery
|1 Test (narth) - AlMS
Instructions: ATO
AUDC
These instructions change
depending upon the location of the AUDIT < &
MOUSe oF cursar. AUIR .
BA| Dizplay:
" One Question ata Time
BODIZ
EBHE z f+ All Questions at Once
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Accessing Program Information

Example: Clicking on the Help > About... menu item displays the About Mental Health Assistant
message dialog, which contains useful release information about MHA version 3.

w- dental Health Assistant in use by MHPROVIDER ,ONE

File Tools Mgl
Click Cne Mhpatient
Instrum - SSMN: w2412
Awailable Instruments and Batterigs: Instruments Chosen:
Shiow: |AII j
Interviewer:
|MHPROVIDERONE j BOMC (05/04/2009 10:54:25 Abd) = J
Date of Administratian: AUDIT (05/04/2009 10:54:06 Abf) J
| 5/ /2008 - MH Battery 3 J
“isit Location: Screen Battery
|1 Test {north) - AIMS
Instructions: £ ATQ
ALDC
These instructions change =
depending upon the location of the o AUDIT < *
MOUse ar cursar. AR
BAl Display:
i= " One Question at a Time
EDIZ
= BHS 2 * All Questions at Once
October 2010 MHAS3 User Manual 65

Patch YS*5.01*96



Use of the Software

Example: Message dialog containing information about the Mental Health Assistant program.

@ About Mental Health Assistant ﬁ|

Mental Health Assistant

Client“ersion: 1.0.3. 46

Mental Health Fackage Fatch Required:
SE*E 07*36

Compile Date: 11/01/2010 07:00:06 A
CRC: 2386490101

RPC Broker Wersion: *MWE*1.1*40
RPC%ersion: 0

Located: RPCBroker]

Deweloped by the Department of Veterans Affairs. Unauthorized access or
misuse of this system and/or it's data is a federal crime. Use of all data shall be
in accordance with WA policy on security and privacy.

MOTE: The Weterans Health Administration (YHA) fully supports Section 508
of The Rehahilitation Act and is committed to equal access for all users. While
every effort has been made to ensure Section 508 compliance, we realize that
there may he other issues.
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Instrument Administrator’s Battery Wizard

Orientation

The Instrument Administrator’s Battery Wizard is a tool for creating and maintaining persistent, re-
usable instrument batteries. User-defined batteries that are created using the Battery Wizard are
listed in the Available Instruments and Batteries list box and can be added to the list of
Instruments Chosen. When a battery is added to the Instruments Chosen list, the names of the
instruments contained in the battery are listed in Instruments Chosen, not the name of the battery.

Creating re-usable batteries from frequently administered sets of instruments can reduce the time
required to set up a testing session for patients with similar testing needs.

Example: The Available Instruments and Batteries list box is located on the Mental Health
Assistant Battery Wizard form.

@ Mental Health Assistant

Fie Help
; <— BT s
Ba'ttery Wizard Battery selector
MNarme of Battery Avvailable Instruments: Instruments in Baftteny:
AlMS ATO
v AlDC
SR List of ol
AlLDC available +
Instructions: ALDIT Instruments
A battery is a handy collection ALIR +
of instruments that are used BAl
frequently or grouped for
special purposes. BOIZ
_ BHS
Check an instrument to mowe ; ; ;
it to the list of instrurnents for ol tIel | st of instruments in —
this battery. BERS selected battery
“'ou can hawe many batteries BRADEN SCALE
and the same instrument can BS
be in several batteries.
BSia
BUSS
CAGE
CESD
CESDS
DOKS0
DOMG
ERS 3 | >
=l o= - S
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Main Menu

The Main Menu offers user functions in the context of the Battery Wizard, such as additional tools
and help.

Title bar

The Title Bar is a visual artifact that is used throughout MHAS3 to display information about the
context that applies to the current activity.

Available Instruments and Batteries list

The Available Instruments and Batteries list is used to select which instruments will be administered.
In some cases there will only be one instrument selected. But, this list also allows for selecting
multiple instruments or batteries, or a combination of both.

Instruments in Battery list

The Instruments in Battery list is the collection of instruments selected to become part of the current
battery. The instruments are listed here in the order in which they will be administered—from top to
bottom.

Re-sequencing buttons

The re-sequencing buttons are used to alter the order in which the instruments in the Battery will be
listed in the Instruments Chosen list. Instruments can be removed from the battery too.

Context-sensitive Help

Context-sensitive help tips are displayed in this area and are dependent on where the mouse pointer is
resting.

Battery Selector

The Battery Selector Drop-Down Combo Box is used to type in the name of a new battery, or to
select from a list of existing batteries. The battery name indicated here is the currently-selected
battery to which all editing actions apply.
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Save Button

The Save button is used to save to VistA all changes made to the current battery. After a battery is
saved, its name will be listed in the list of Available Instruments and Batteries on the Instrument
Administrator form.

Invoking the Battery Wizard

The Battery Wizard must be invoked from the Instrument Administrator form. Similarly, all
consequences of editing batteries are reflected in the Instrument Administrator, upon closing the
Battery Wizard form.

Example: To start the Battery Wizard, click on Tools > Battery Wizard... located on the
Instrument Administrator’s Tools drop down list menu.

w- Mental Health Assistant in use by MHPROVIDER ,ONE
File MEEER Help

METRIC Instrument Reviews. .. Cl |Ck Cne Mhpatient

SEN: oce-2412
|| Options... Awailable Instruments and Batteries: Instruments Chosen:
MHFPROWIDER, OME )
| Show: |AI| j
Interviewer:
|MHPROV|DERONE BOMC (05/04/2009 10:54:28 Abd

Date of Administration: AUDIT (05/04/2009 10:54:06 A)

K
K

| 5/ 5/2009 - MH Battery
|

E ==

Wizit Location: Screen Battery
|1 Test (north) AIMS
Instructions: ATU
AJDC
These instructions change
depending upon the location of the AUDIT < »
mouse of cursar. ALIR _
BAl Display:
" QOne Question ata Time
BDI2
BHS || | ® AllQuestions at Once
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Example: Mental Health Assistant Battery Wizard form.

& Mental Health Assistant
File Help

Battery Wizard

Mame of Battery

Instructions:

Enter a unique name far
battery

ar zelect ane from cambo
box.

Avsailable Instruments:

Instrurments in Battery:

B

|

AlNS
AT
ALDC
ALDIT
ALIR
BAl
EDIZ
BHS
BOMC
BFRS
BRADEM SCALE
Bl

1 [Tl [Tl ] o) 6T o [ f T )

|

BOIZ
BSI18
CLT

|

| = =
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Creating a New User-defined Battery using the Battery Wizard

New batteries of instruments are created by first assigning a name to the new battery. Next,
instruments (and other batteries) are added to the Instruments in Battery list by clicking on the
desired instrument names shown in the Available Instruments and Batteries list box.

The Instruments in Battery list box can be manipulated to change the order of the tests and to add
or remove tests. To modify the Instruments in Battery list of an existing battery, simply load the
battery by selecting the battery name using the Name of Battery Drop-Down Combo Box.

Here is an example of creating a new battery:

1.
2.

w

No ok

Click on File > New menu item.

Enter the name “Screen Battery” in the Name of Battery box.

Select AUDC and PC-PTSD instruments by clicking on the selection box next to their
names.

Click on the Save button.

The new battery is saved after the Save button is pressed.

The Battery Wizard form is closed.

The Instrument Administrator form is shown and the newly-created battery appears in the
list of Available Instruments and Batteries.

When Screen Battery is selected, the two instruments included in the battery are added to
the Instruments Chosen list on the Instrument Administrator form.

Example: This is a display of creating a new battery from the Name of Battery box.
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&- Mental Health Assistant : E'E'
FE8 Help
Fename .-"izar!
Delete 2. Type new battery name
Euit jatten, Avqallable nstrurments: Instruments in Battery:
= A |lauDC
Screen Battery & j WBRD o0 TS0
MACHIZ 4
Instructions: MOMI3 —
Enter a unique name far bAHLA, i
battery MHLE
or select ane from combo J
hiox. MHLC
MISS 3. Click
=| MORSE FALL SC
| PCPTED m
PCLC v -
< | =
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Example: Created battery is displayed and is available from the Instrument Administrator form
under the Available Instruments and Batteries list. The two instruments included in the battery are

displayed in the Instruments Chosen list box.

@ Mental Health Assistant in use by MHPROVIDER, ONE

File Tools Help
HE Mhpatient One
Instrument Administrator SEN o241
Instruments Ordered By Awailable Instruments and Batteries: Instrurments Chosen
|MHPROVIDERONE j AUDC
Show: [A =1 | |pcPTeD
Intenrdewer:
[MHPROVIDER.ONE - Screen Battery ~ 4
Diate of Administration: AlJDC
[1os18/2010 ~| - +
Visit Location: Two Battery
K AIMS
Instructions: ATO
The presentation of instruments can AUDE -
he filtered: show all (nofilter), only AUDIT
hatteries, or only incomplete
instrurnents. AUR
BAl
EDIZ
EHS
BOMC
BPRS
BRADEN SCALE < | >
BSI
B8 (" One Question ata Time  — 2
BUSS
CAGE @ All Questions at Ohce sitafiEnty
October 2010 MHAS3 User Manual 73

Patch YS*5.01*96



Use of the Software

Renaming an Existing Battery

Go to Battery Wizard

Click on File > Rename menu item.

Select the battery that you wish to rename from the Available Instruments and Batteries list.
Type the new name for the battery

Click Ok.

1.
2.
3.
4.
5.

Example: Selecting the battery that you wish to rename from the Available Instruments and
Batteries list box.

& Mental Health Assistant

(=N Help
Rename
Delete
Available Instruments: Instruments in Battery:
: AlS ~| ||BDIZ
""" Bzg
ATQ CLT ﬂ
Instructions: ALDC
Enter a unique name far AUDIT ﬂ
hattery. AUIR J
BAl
BOIZ |
BHS
| BOMC
BFRS
BRADEN SCALE
BS 3 | A
- bt
< >

Example: Typing in a New Name for an existing battery.
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& Mental Health Assistant

Screen Eiatte

1. Click, to select
the battery name

2. Type the new name for battery

e MNarme:

|rv1H|EIattery

Once the “OK” button is pressed, the Battery Wizard can be closed (use the “exit” selection in the
“File” menu, or click on the “X” in the upper right hand corner of the window). The battery’s new
name will appear in the “Instrument Administer” window.
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Example: Displaying the New Name from the Available Instruments and Batteries list box.

& Mental Health Assistant in use by MHPROVIDER ONE =13
File Tools Help

One Mhpatient

Instrument Administrator 2SN 000-00-2412

Instruments Ordered By Available Instruments and Batteries: Instruments Chosen:
MHPROVIDER.OMNE -
| J Show: |A|| j
Interviewer:
IMHPROVIDER,ONE - MH Battery A J
Date of Administration: Screen Battery J
1241512008 -] AIMS B
Visit Locafion: ATO Battery is now listed
2 East || AUDC with the new name
Instructions: AUDIT
AUIR
These instructions change
depending upon the location of the BAI
mOouse ar cursar. BDI2
BHS
BOMC
BPRS
BRADEN SCALE < >
Bsl _
Display:
Bsig * Qne Question ata Time
BUSS
CAGE v Al Questions at Once
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Deleting an Existing Battery

Go the Battery Wizard

Click on Yes.

gk~

Batteries.

Click on File > Delete menu item.
Select the battery to be deleted from the Available Instruments and Batteries list box.

The selected battery is deleted from Vista and from the list of Available Instruments and

Example: Deleting an existing battery from the Available Instruments and Batteries list box.

& Mental Health Assistant

=8 Help

Mew

Instructions:

Enter a unique name far
batteny.

Available Instruments:

Instruments in Battery:

| #

AlMS
ATO
ALIDC
ALDIT
ALIR
Bl
BDIz
BH=
BOMC
BFRS
BRADEMN SCALE
Bl

0 i i i i i i i i i i

BOIZ
BSI18
CLT

|

[ = =

Example: Click on File > Delete menu item. Click on the Yes button.
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& Mental Health Assistant

Select a battery to remove

e ——

Screen Battery

— I
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Exiting the Battery Wizard

Example: To exit the Battery Wizard form and return to the Instrument Administrator form click
on the drop-down File > Exit menu item. You can also press the “ESC” key, or click on the “X” in
the upper right-hand corner of the form. The Battery Wizard form will close and the user is returned
to the Instrument Administrator form.

& Mental Health Assistant

#8 Help
e
Rename
Delete m
2vailable Instruments: Instruments in Battery:
MH Batior AIMS & ||BODE
: ATO E=NE
CLT ﬂ
Instructions: ALDC
3
Enter & unigue name for AUDIT ﬂ
hattery. AUIR J
BA|
BOI2 |
BHS
BOMC
BPRS
BRADEN SCALE
BS < ! 4
W
< e N
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Accessing Online Support

Example: Online support for MHAS is available via the Mental Health Informatics Section’s
website. Clicking on the drop-down Help menu> Online Support... menu item will start the
default Web browser and loads the following web address into the browser:
http://vaww.mentalhealth.va.gov.

&- Mental Health Assistant |;||E|[z|
File MgEle
' about... Available Instruments: Instruments in Battery:
' AlAS ~| ||BDI2
B3na
ATO CLT ﬂ
Instructions: ALDC
Enter a unique name far AUDIT ﬂ
hattery AUIR J
or select one from combo
box. BAl I
BOIZ
BHS
BOMC
BPRS
BRADEN SCALE
BSl < ' >
Wt
s S
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Instrument Administrator’s “One Question at a Time” Input Form
Orientation

The “One Question at a Time” data-entry form enables the user to answer questions by viewing and
responding to one question at a time. This display mode is ideal for patient-entry, since it only
displays one question in the data entry form. This allows for a more focused and relaxed approach to
responding to questions. This mode is also suitable for staff entry as well. It boils down to a matter of
personal preference.

This section lists, in detail, all the various types of visual artifacts that users are likely to interface
with while responding to questions during an administration.

Refer to the GUI glossary for a description of the visual elements on these forms, and how they are
normally used.

Example: Single-question data-entry form.

& AUDC: MHPATIENT ,ONE
File Wiew Tools Help

Flease read each item carefully and select the correct answer foryou
DY | o text

How often did vou hawe a drink containing alcohol in the pastyear?

1. Never .
\ Ouestion text

I 2. Monthly or less

- 1 .
3. Twio to four times a manth s e AR

I 4 Two to three times perweel

—

I B. Four or more times aweek

AUDC

/ /— Navigation buttons

[ MNext Question l [ Erior Question l ’BeviewAnswers] ’

Progress indicator
Cancel ]
[ Usespeedtab  Hint: Press cariage returm to move to next question,

[ ]

The Main Menu

The Main Menu offers user functions in the context of the Single-Question form, such as tools and
help.

The Selected Patient Identification label
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The Selected Patient Identification label displays information about who is the currently-selected
patient within MHAS3. All functions performed in the Single-Question form will apply to this
patient.

The Instrument’s Name

The Title Bar is a visual artifact that is used throughout MHAS3 to display information about the
context that applies to the current activity. In this case, the Title Bar displays the current instrument’s
name.

The Section Title Bar
Sometimes, instrument designers may group questions into sections. In this case, existing section
titles are displayed in the Section Title Bar.

The Introduction Text
Introduction Text is used as narrative introduction to one or more questions. Generally, introductions
present instructions on how to respond to questions.

The Question Text
The Question Text is the actual question presented to the user.

The Response Artifact

A Response Artifact is a visual control that the user will use to respond to the presented question.
There are a number of different types of Response Artifacts in MHAZ3, such as Drop-Down Combo
Boxes, Text Boxes, Spin Edits and such. On the Single-question form, all response artifacts are
displayed on the same area of the form.

The Navigation Buttons
The Navigation Buttons are used to display Previous and Next Questions. They are used to navigate
through the sequence of all questions contained in the instrument.

The Progress Indicator
The Progress Indicator displays the current percentage of questions answered so far, represented by
the number of questions answered, compared to the total number of questions in the instrument.

The Review Answers Form

The Review Answers form is a navigational aid to use with instruments that contain a large number
of questions. It presents a simple way to select a question for editing that is not contiguous to the
present question.
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Responding to a multi-choice question using a Multiple-Selection List Box

Multiple-Selection List Boxes allow the user to select one or more of the choices listed. To respond
to a question:

1. Select one or more choices from the Multiple-Selection List Box on the form by clicking on
the item, or, use the arrow keys to move to the desired item and press the space bar.
2. To go to the next question, click on Next Question button, or, press the “Enter” key.
The choices made are recorded and the next question is automatically displayed.

Example: Selecting two choices.

- 1Bl 2ND LEVEL EVAL V2: MHPATIENT ,ONE

File “iew Tools Help

29-B. Consult requested with: (Check all that apphd

v udioloogy

1.ENT i
2. Meurology 1. Click
3. Meuropsychology f Meuropsychological as%e =

4, Dccupational Therapy .
5. Ophthalm i 2. Click

7 PMand R
8. Prosthetics

3. Psychiatry

10. Psychology
11. Speech-Language Pathology
12. Substance Use / Addigh i

tion and/or Treatment

TEIZMND LEVEL EVAL Y,

Mext Question Erior Question ] [ Bewview Answers ] [ Cancel ] [ Finish

Use speedtab Hint: Use the number key of the item to speed data entry.

Cluestions Skinoeci B.
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Responding to a Single-choice question using a Drop-Down List Box

NOTE: Drop-Down List Boxes allow selection of a single choice from a list. This type of question is
also called a “combo box.”

To respond to a question:

1. Click on the down-arrow located on the Pick one number drop-down list box to display the
list, or, use the arrow keys to step through the sequence of items.

2. Select a number from the Pick one number question by clicking on the item, or, when the
desired item is presented in the box, press the “Tab or “Enter” key to select the item. It is also
possible to type the number of the item’s designator (“1,” “2,” etc) if they are used.

3. To proceed, click on the Next Question button, or press the “Enter” key. Alternately, you can
also press the “Tab” key until the Next Question button is active, then press the “Enter” key.

Example: Data Input Test form displaying the Pick one number label.

Addiction Severity Index - Lite for MHPATIENT ,ONE S5H: 00000241 2
File Toaols Help

General Information

53. Program Type: Consultation/Liaisan \#j
Early InterventionfEducation/Referral i‘

B, DEVE QAL IS0, Detoxification Services

Ambulatory except Opioid 5 titution

r | Dpinid Substitution
Inpatient Acute Care
=511 Interviewer - Suhstance Abuse Residential Rehabilitatinmgram
Compensated Wark TherapyTransitional Residence
G11a. Ordered By : Therapeutic Cormmunity hd
G12 Special:
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Responding to a question that asks for a currency amount using a Text Box

Some Text Box artifacts are configured to only accept valid currency values.
To respond to a question:

1. Type acurrency value in the Text Box
2. Click on Next Question button, or press the “Enter” key.

The entered currency value is recorded and the next question is automatically displayed.

Example: Entering a currency amount.

w- Form 5R: MHPATIENT ,ONE g@

File Wiew Tools Help

10. Cost of treatrment under this provider

—

™~ 1. Type in a valid currency amount

~
¥

Farm SR
I Mext Question ] I Brior Question ] [Beview!—\nswers J
Use speedtab Hint: Use the number key of the itern to speed data entry.
[ ]
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Responding to a question that asks for a date using a Date-Picker

Date-Pickers are used to respond to questions requiring a date for an answer. A Date-Picker displays
a calendar from which a date is selected. Alternatively, the user may simply type the date in the Text
Box portion of the Date-Picker artifact. In MHA, Date-Pickers usually don’t allow for selecting a
date in the future. To select a date:

1. Click on the button with the arrowhead to open the Date-Picker calendar component;
alternately, you can type the date directly into the date box and skip the next step.

2. Navigate to the desired date and click on its number symbol

3. Click on Next Question button, or, press the “Enter” key.

The selected date value is recorded and the next question is automatically displayed.

Example: Selecting a date.

5. Weteran's Date of Birth

_4/26/2004 ~

B April, 2004 [ > |

1. Click to open calendar Sun hdon Tue Wwed Thu Fri Sat
: 1 2 3
4 5 B ¢ 8 9 10 .
1M 12 13 14 15 5 2. Click on a date

18 19 20 2 23 2
25 27 28 29 30

TToday: 12H15/2008

ya 3. Click
Farrm SR /

[ Mext Question l [ Prior Question ] [BeuiewAnswers]

Use speedtah Hint; Use the number key ofthe item to speed data entry,
[ ]
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Responding to a question that asks for a line of text using a Text Box

A Text Box allows entry of a single line of text as a response to a question.
To answer a question:

1. Type aline of text in the Text Box.
2. Click on Next Question button, or, press the “Enter” key.

The entered text is recorded and the next question is automatically displayed. A Text Box accepts
any type of text.

Example: Entering text into a Text Box.

& Form 5R: MHPATIENT,ONE

File Wiew Tools Help

*Uge anly for continuations of treatment that began under HCMI contract

7. Mare of Residential Provider

\ 1. Type in text

- X

Form BR /
[ Mext Question ] l Erior Question ] l Bewview Answers ] l Cancel ] l Finish ]
Use speed tab Hint: Use the nurber key of the item to speed data entry.
Cluestions skioned: 6. 7. [TTTTTTTTT] |
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Responding to a question from a list of answers using a Single-Selection List Box

A Single-Selection List Box is very similar to a Combo Box, except that all available responses are
readily visible. There is no drop-down list to trigger. To answer a question:

1. Select one item from the Single-Selection List Box by clicking on it, or, use the arrow keys to

move to desired item then press the “Tab” or “Enter” key.
2. Click on Next Question button, or, press the “Enter” key.

Alternately, if the “Speed Tab” is checked, you can press the number key that corresponds to the
item’s designator. That key press will do two functions; it will select that item and display the next
question.

The single choice made is recorded and the next question is automatically displayed.

Example: Selecting a single response.

@ 1Bl 2NDVLEVEL EVAL V2: MHPATIENT ,ONE
File View Tools Help

29-C. Refarral to Folytrauma Metwork. Site (FMNE):

W'est Roxbury (W1
Syracuse (W)
Brorx (v3)

Indianapaolis (11)

1. Clle Hines (v12)
StLouis (v18)

Houston (W16)
Washington, DG (WE) Diallas (W17
Richmond () Tucson (18]
Augusta 7 Derrver (v19)
San Juan ) Seattle (W20
Tampa ) Falo Alto (W21)
Lexington (+3) YWastLos Angeles (WEEZ)
Clesveland (v10) Minneapaolis (w23

TBI 2MD LEWEL EVAL W2

[ Mext Question Prior Question ] [Beview Answers J [ Cancel ] l Finish ]
Usze speedtab Hint: Use the nurmber key of the itern to speed data entry.
usstions skionec: B, PTTTTTTT T R
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Responding to a question using a Masked Text Box that pre-formats input data

Masked Text Boxes automatically format the data entered into them. For instance, a Masked Text
Box configured to accept a phone number, or Social Security Number, will automatically position
and display the parenthesis and dashes normally found in fully-formed phone numbers or SSN. All
that the user must type are the numbers.. The rest of the formatting is done automatically.

Enter a Social Security Number:

1. Type only the numbers in a SSN in the Masked Text Box.
2. Click on Next Question button, or, press the “Enter” key.

Example: The Masked Text Box adds formatting to the entered numbers to reflect a standard SSN
notation. Only numbers are accepted for input.

@ Form 5R: MHPATIENT ,ONE
File Wwiew Tools Help

4. Social Security Murmber

™~ 1. Type in a SSN

-~

Farm bR
[ Mext Question ] [ Erior Cuestion l [BeviewAnswers ] [ Cancel ] [ Finish ]
Use speedtab Hint: Use the number key of the iterm to speed data entry.
Questions skioned. B 7. [|"l"l"l 1
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Responding to a question that asks for a long textual answer using a Multiple-Line
Text Box

Multiple-Line Text Boxes accept more than one line of text.
To answer a question:

1. Type several lines of text in the Multiple-Line Text Box
2. Click on Next Question button, or, press the “Enter” key.

Example: The entered text is recorded and the next question is automatically displayed .The
Multiple-Line Text Box accepts any type of text.

@ TBI ZND LEVEL EVAL V2: MHPATIENT ,ONE |Z||E|fg|

File Wiew Tools Help

20. Additional history of present iliness, social history, functional history, patient goals, and other relevant infarmation.

This text is typed by user)

T

TBI 2MD LEVEL EVAL W2

l Mext Question I ’ Erior Question ] [Beview ANSWers J ’ Cancel ] ’ Finish ]
Use speed tab Hint: Use the number key ofthe item to speed data entry.
Questions skipoed B, AR RRAARAAANL
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Respond to a question using a Spin Box that asks for an integer value

Spin Boxes are used to select from a list of consecutive integer values. Additionally, an integer value
may be typed into the Text Box area of a Spin Box artifact. To answer a question:

1. Type an integer, or use the spin buttons with the arrowheads to enter a value in the Spin Box.
2. Click on Next Question button, or, press the “Enter” key.

The entered integer value is recorded and the next question is automatically displayed. The Spin Box
only accepts integer values.

Example: Entering an integer value.

- 1Bl 2ND LEVEL EVAL V2: MHPATIENT ,ONE

File “iew Tools Help

441, Manth of most serious injury:

1. Type in avalid integer value,
or click on the arrows

TEI Z2MND LEVEL EVAL W2

[ Mext Question ‘[ [ Erior Question ] [BeviewAnswers] [ Cancel ] [ Finish

Use speedtab Hint: Use the number key of the item to speed data entry.

Cluestions Skinoeci B.

October 2010 MHAS3 User Manual 91
Patch YS*5.01*96



Use of the Software

Responding to a question that asks for a single choice from a list using Option Buttons

Option Buttons are used to answer questions from a list of mutually-exclusive answers. To answer a
question:

1. Click on one of the Option Buttons in the group, or, use the arrow keys to move to the
desired option and press the “Tab” or “Enter” key to select the option.
2. Click on Next Question button, or, press the “Enter” key.
Alternately, if the “Speed Tab” is checked, you can press the number key that corresponds to the
item’s designator. That key press will do two functions; it will select that item and display the next
question.
The single choice made is recorded and the next question is automatically displayed.

Example: Selecting an Option Button response.

- 1Bl 2ND LEVEL EVAL V2: MHPATIENT,ONE

File Wiew Tools Help

2. Pre-military level of educational achi : 1. Click
1. Less fefrschool

* 2 High school graduate or equivalent
" 3. Some college. associate degree or technical degree
" 4 College graduate (haccalaureate)

" & Posthaccalaureate

TEIZMND LEVEL EVAL Y2

[ Mext Cuestion T [ Erior Question ] [BeviewAnswers] [ Cancel l [ Finish

Use speedtab Hint: Use the nurber key of the item to speed data entry.

Cuestions skinned: B..
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Responding to a question that asks for a staff name from VistA using a Drop-Down
List Box

Staff list Drop-Down List Boxes are special list boxes that display a list of staff members from
VistA.

To answer a question:
1. Begin typing the first three letters of the last name in the Text Box part of the component.
2. If the complete name is not automatically filled in, select the name from the list of names that
“dropped down” in the Vista Drop-Down List Box
3. Click on Next Question button, or, press the “Enter” key.

The name choice made is recorded and the next question is automatically displayed.

Example: Selecting a staff name from a list.

w- Form 5R: MHPATIENT ,ONE

File Wiew Tools Help

Use this form anly for veterans whao are placed in contracted residential treatment, under the HCMI program. Complete a new form any time that a
weteran is formally discharged ar has left the residential pragram and itis unlikely that the weteran will return to that program.

1. %A staff member completing this report
ol --- Click to open list
p—— [ 1ot E i

Begin typing, or...

Student Eight
StudentEighteen
Student Elewen
Student Fifteen
Student Five
Student Four
Student Fourteen
Student Mineteen

N

_ Farm 5R
l Mext Question ] I Erior Question ] I Beview Answers ]
Use speed tab Hint: Use the number key ofthe item to speed data entry.
[ ]
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Responding to a question that asks for a value from a Slider

Sliders simplify visually selecting a value from a range of values.
To answer a question:
1. Select a value on the Slider by moving the choice indicator on the scale to the number of

your choice.
2. Click on Next Question button, or, press the “Enter” key.

Example: Selecting a point on a scale. The selected Slider value is recorded and the next question is
automatically displayed

6. Estimate of success:

1 2 3 4 5 B 7

Mediurm High
Slide pointer to
make selection on
the scale
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Identifying the End Point of an Instrument and Finishing the Instrument

The last question in an instrument will trigger a change in the displayed navigational buttons. The
Prior Question buttons remain enabled and a dialog box will be. Clicking on the Finish button will
finish the test.

To finish a test:

1. Answer every question in the instrument (the progress bar will be green).
2. On the last question, click on the Finish button.

Example: Finishing an instrument. Since this is the last question, the Information dialog is presented.
Click on OK and then the Finish button.

10. Has a relative or friend. ar a doctar ar other health worker been concerned about your drinking or suggested that you cut down?
1. No

@ 2 Yesg, butnotin the lastyear
" 3.%es, during the lastyear
Information [g|

i There are no more questions,
‘ou can review your answers by clicking on the "Review Answers" butkon,
Ta save your answers, click on the "Finish" buttan,

o |+ 1. Click

AUDIT 2. Click \

Erior Question ] [ Beview Answers ] [ Cancel ] [ Finish ]

Use speedtab Hint: Use the number key of the item to speed data entry.

World Health Oraanization [ |

Once the data are saved to VistA, the user is given the choice of 1) saving a standard progress not to
VistA that summarizes the data and its score(s), 2) Editing the standard note before saving it and 3)
not saving a progress note. See Appendix C for cases where a co-signer is required for signing a
progress note.
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& AUDIT: MHPATIENT ,ONE
File Wiew Tools Help

Save Progress Note to VistA

The data for this administration has been sawved in Wista.
Do you wish to:

J &

I Editthen sawe progress note ]

‘ Sawe standard progress note

I Do not seve progress note ]

Select one

Mext Question
Use speed tab

SWh'orld Hee_llth CIraanization

Brior Question l [ Bewview Answers ]

Hint: Use the number key of the iterm to speed data entry.

I

Cancel

[ Finish |

PP I IIIITI T E

October 2010
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Use of the Software

Incomplete Data-Entry Session

=

Click on the Finish button.

2. Click on the YES button of the “Confirm” dialog. The Confirm dialog will list the questions
that have not been answered and will inform the user of the permitted delay to finish the
administration. The Confirm dialog will also allow the user to return to the instrument.

Example: When the Finish button is clicked, the confirm dialog is displayed. Click Yes to save the
administration as “incomplete.”

& AUDIT: MHPATIENT ,ONE
File Wiew Tools Help

5. How aften during the last wear hawve you failed to do whatwas normally expected from wou because of drinking?
1. Newver

2 Less than monthly

3. Manthly

4 Weekly

B Daily or almost daily € | Some questions have not been answered in the AUDIT and the instrument is incomplete.
\t/ Questions: 5, 6, 7, 8, 9, 10,

¥aou have 2 days to finish, otherwise vou will have to start over.

Are you sure you are done For now?
Cedre ) e

AUDIT | {
[ Mext Question l [ Erior Question ] [BeviewAnswers] Cancel Finish

Use speed tab Hint: Use the number key of the itern to speed data entry.

YWiorld Health Oroanization ['llll-llll-l-llll-lllll-ll =
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Viewing the Next Instrument

Within the context of a series of instruments, it is possible to jump to different instruments.

Example: Jumping to the next instrument; click on the tab of the desired instrument. The responses
are not lost on the current administration when you return.

& AUDIT: MHPATIENT ,OME
File View Tools Help

4. How often during the lastyear hawe wou found thatyou were not able to stop drinking once wou had stared?
1. Newer

" 2. Less than manthly
3 Monthly

4 \Weekly
~

&, Daily ar almost daily

AJDIT [BOMC

l Mext Cluestion ] [ Erior Question ] [BeuiewAnswers] [ Cancel ] [ Finish ]

Use speed tab Hint: Use the number key of the item to speed data entry.
‘'orld Health Oroanization [ |
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Viewing the Prior Question

To view the question that is prior in order to the currently-selected question, click on the Prior

Question button.

Example: The displayed question becomes the prior question within the current instrument.

w.- | AUDIT: MHPATIENT ,ONE

S(=1[Ed

File View Tools Help

1. MNewer

2 Less than monthly
3. Monthly

4 Waekly

r
-
-
" & Daily or almost daily

4 How often during the lastyear hawve vou found that vou were not able to stop drinking once yvou had started?

e

AUDIT [BOMC

’ Mext Question ]

’ Erior Question Beview Angwers ’ Cancel ] ’ Finish ]

Use speedtab

YWaorld Health Organization

Hint: Use the number key of the item to speed data entry.
[ ]
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View Next Question

To view the question that is next in order to the currently-selected question, click on the Next
Question button.

Example: The displayed question becomes the next question within the current instrument.

& AUDIT: MHPATIENT ,OME
File View Tools Help

4. How often during the lastyear hawe wou found thatyou were not able to stop drinking once wou had stared?
1. Newer

2. Less than monthly
3. Monthly

~
~

4 \Weekly
" & Daily or almost daily

AUDIT |BOMC /

l Mext Cluestion ] [ Erior Question ] [BeuiewAnswers] [ Cancel ] [ Finish ]

Use speed tab Hint: Use the number key of the item to speed data entry.
‘'orld Health Oroanization [ |
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Review Answers

In the case where navigating through the questions in an instrument using the Next Question and
Prior Question buttons is too cumbersome due to a large number of questions, the Review Answers
offers a quicker way to move around. To start the Review Answers form, click on the Review
Answers button.

Example: Starting the Review Answers form.

& AUDIT: MHPATIENT ,ONE E”E”g'
File View Tools Help

4 How often during the lastyear hawve vou found that vou were not able to stop drinking once yvou had started?
1. MNewer

2 Less than monthly
3. Monthly
4 Waekly

r
-
-
" & Daily or almost daily

AUDIT | BOMC
’ Mext Question ] ’ Erior Question ] ’ Beview Angwers ’ Cancel ] ’ Finish ]
Use speed tab Hint: Use the number key of the item to speed data entry.

W'arld Health Oroanization [ |
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Changing Answers

To change a given answer, it is first necessary to return to that answer. There are two ways to
navigate back to a previously-answered question: the question navigation buttons or the Review
Answers form. Once the answer is again displayed in the form, simply choose or type in a different
answer.

To change an answer using the Review Answers form:

1. Click on any of the previously-answered questions listed in the table, to select the question.
2. Click on the Change Answer button.

To return to the Single-Question input form, without making any changes, click on the Exit button,
or click on the Exit button.

After clicking on the Change Answer button:

1. The Single-Question input form is displayed and the selected question is shown with the
previously-entered response.
2. User can change the response to this question.

Example: Selecting which question to change.

& Review Answerns Q@@

File Help

Alcohol Use Disorders Identification Test aans npatient
Answers

MNo. | Question Answer +
1 How often do ywou hawe a drink containing alcohal ? bonthly or less i
P Howe many drinks coftaining alcohol do you hawe on a typical day when wou |1 or

3 How often dowou have sioor SNl [le] /- e oocasion? Less than monthly

4 How often during the lastyear hawve you found that you were not able to stop | Less than monthly

5 How often during the last year have you failed to do what was narmally Less than manthly

b How often during the lastyear hawve you needed afirst drink in the maorning to | SKIFFED

7 How aften during the last year hawve wou had a feeling of guilt or remorse

8 How often during the last year hawve wou been unahble to remember what

9 Hawve wou or someone else beeninjured as a reault?

10 Has arelative or friend, or a doctor or other health warker been cunc;rxed bt

To change an answer, highlight it 3
and press "Change Answer" or ’ Change Answer ] ’ Exit
double-click on it.
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Exiting Data-Entry Session without Saving the Answers

Example: To abort saving any of the given answers to an administration, click on the Cancel button.
The editing session ends and no answers are saved.

Careful: The use of the Cancel button will close out the entire session, which means all the
instruments, if more than one has been selected, will be closed without saving, not just the instrument
that is active at the time.

- AUDIT: MHPATIENT,ONE

File “iew Tools Help

3. Howr often dao wou hawve six or more drinks on one occasion?
1 Newer

" 2. Less than manthly
& 3 honthly

4 Weekly

" B Daily or almost daiky

AUDIT [ BOMC
l Mext Question ] I Erior Question ] [Beview ANSwWers J Cancel l [ Finish ]
Use speedtab Hint: Use the number key of the iterm to speed data entry.

World Health Organization [ |
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Use of the Software

Mental Health Assistant File Exit Menu ltem

It is possible to interrupt the administration of an instrument and save all the responses given so far.
The administration will be saved as an “incomplete” administration, which may be completed later,
by using the “Finish” button.

1. The Single-question data-entry form closes and the user is returned to the Instrument
Administrator form.

2. The instrument administration is automatically saved as an incomplete administration in VistA.
No data is lost.

3. The instrument appears in the list of available instruments as an incomplete administration, which
can be selected for resumption.

Example: To interrupt and save an administration, click on the “Finish” button.

- AUDIT: MHPATIENT,,ONE

File Wiew Tools Help

3. How often do wou hawe six or mare drinks on one occasion?
1. Mewver

" 2. Less than monthly

* 3 honthly

4 Weekly

" & Daily or almost daily

Click here

AUDIT | BOMC \
l Mext Question ] I Erior Question ] [Beview ANSWErs ] I Cancel ] I Finish ]
Use speedtab Hint: Llse the number key of the item to speed data entry.

‘World Health Organization [ |
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Use of the Software

Example: This is a display of the Mental Health Assistant message dialog box. Click on the Yes
command button to save the administration.

Confirm [5__<|

Some questions have nok been answered in the AUDIT and the instrument is incomplete,

?)
\_':’/ Questions: &, 9, 10,

You have 2 daws to Finish, otherwise vou will hawve to start over.,

Are wou sure you are done For now? Click

[ ies‘(” Mo ]
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Use of the Software

Resume Responding to Questions in an Administration Previously Saved as
Incomplete

Saved incomplete administrations may be reloaded into MHAS3 to continue answering questions and
complete the administration. Incomplete administrations are identified by the date and time text that
is appended to the instrument’s name. Incomplete administrations that cannot be restarted are simply
not listed in the list of available instruments.

Whether an incomplete test can be restarted depends on how long ago it was first entered in the
VistA Mental Health Package (MHP) database. The permissible lapse is a local site parameter that is
set using MHS Manager\Psych Test Utilities\Edit Instrument Restart Limit [YSINST RESTART
LIMIT] option.

To restart an incomplete administration:

1. Identify and select the incomplete administration in the list of available instruments, in the
Instrument Administrator form.

Choose the display and entry modes.

The reminder message shown below is displayed.

4. The data-entry form is displayed and the 1% unanswered question is presented and is ready for
a response.

All previously-saved responses are restored correctly.

6. Resume the administration in a similar fashion as new administrations after they are started.

w N

o
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Use of the Software

Example: Incomplete administration listed in the Available Instruments and Batteries list.

@ dMental Health Assistant in use by MHPROYIDER ,ONE
File Tools Help

Instruments Crdered By:

Instrument Administrator

Asailable Instruments and Batteries: Instruments Chosen:

COne hhpatient
SEM: o412

MHPROVIDER.ONE ElrE m <] [BoMC Grareuns Tosazs v
: - AUDIT (5/4/2009 10:54:06 A)
Interviemer:
MHPROVIDER.ONE B £l A ﬂ
Date of Administration: SRINELARNG: ] Select Incomplete ¥
| 5/ /2009 - MH Battery administration(s) =
Wigit Location: Screen Battery
|1 Test (narth) - AlMS
Instructions: ATO 2. Click
Select the instrument by checking its AUDC
hox with the mouse, or use the arrow
keys and space-bar to select. AUDIT >
Underlined instruments are = AUIR )
incomplete. Display:
Bold indicates a batten, which BAl * One Question at a Time — 4
contains many instruments. | BOIZ
Right click on an instrument for more BHS | Al Questions et Once Staft Entry
information. > -
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Use of the Software

Example: Mental Health Assistant message dialog box displaying the Reminder information given
upon resuming an incomplete administration.

Information E'

- Reminder
- | )

Before proceding, ensure the infarmation is carrect Far;

Instrument Ordered By
Interviewer

Drate of Adminiskration .
Wisit Locakion Click

These usually have default values

4and may need adjusting.
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Use of the Software

Instrument Administrator’s “All Questions At Once” Input Form
Orientation

The “All Questions at Once” data-entry form allows the user to answer questions by viewing and
responding to any of all the instrument questions at any time. All questions are displayed at once on a
scrollable form, much like a pencil-and-paper version of the instrument. The “All Questions at
Once” data-entry form does not make use of a Review Answers form, or navigation buttons, since
they would be redundant with the functions already offered by this form.

NOTE: Refer to the glossary for a description of the visual elements on these forms, and how they
are normally used.

Example: All-questions input form.

- AUDIT: MHPATIENT ,ONE

File Wew Tools Help

AUDIT One Mhpatient

ban] U R

— Introduction text 4

Flease read each item carefully and selectthe carrect answer faryou.

1. How often do wou have a drink containing gloohal ?
1. Mewver

O 2. Monthly or less

" 3. Two to four imes & month

4 Two to three times perweek \ ;
Response artifact

" B Four or more times aweek

1. 0 drinks

2. How many drinks containing alcohol do wou have on atypical dasy when yw e /
Navigation
scroll bar

2.1 ard

~
" 3 3ard Tabs listing all instruments

~

~

4 5orh
. 7t08

" B.10 ar more w

|Aupr |BoMC |
Use speed tah

Hint: Llse the number key of the item to speed data entry.

YWarld Health Organization [ ]
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Use of the Software
Main Menu

The Mental Health Assistant Main Menu offers user functions in the context of the All Questions at
Once form, such as tools and help.

Selected Patient Identification Label

The Selected Patient Identification label displays information about who is the currently-selected
patient within MHAS3.

Instrument’s Name

The Title Bar is a visual artifact that is used throughout MHAS to display information about the
context that applies to the current activity. In this case, the Title Bar displays the current instrument’s
name.

Section Text

Sometimes, instrument designers may group questions into sections. In this case, existing section
titles are displayed in the form, just above any introduction or question text.

Introduction Text:
The Introduction Text is used as narrative introduction to one or more questions. Generally,
introductions present instructions on how to respond to questions.

Question Text:
The Question Text is the actual question presented to the user.

Response Artifact:

A Response Artifact is a visual control that the user will use to respond to the presented question.
There are a number of different types of Response Artifacts in MHAS3, such as Drop-Down Combo
Boxes, Text Boxes, Spin Edits and such.

Navigation Scroll Bar:
The Navigation Scroll Bar is used to display any questions on the form which may be hidden below
or above the current view.
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Instrument Tabs

When the user is responding to a series of instruments, each individual instrument is indicated as a
tab at the bottom of the form. These tabs are used to navigate among the different instruments in the
series.

Respond to all questions using the technigues learned while using Single-Question
Data Entry
The data-entry visual artifacts on this form respond in the same way that they do on the Single-

Question form. The difference being that all questions are presented at once and that navigation to
the different questions is done differently.

To navigate using the mouse, simply use the scroll bar until the desired question is within view. To
navigate using the keyboard, use the Tab key to jump to the next question in the sequence. Shift-Tab
causes a reverse jump to the previous question in the sequence. Additionally, to automate the tabbing
effect, there is the Speed Tab option that automatically tabs to the next question once a question is
answered. However, the Speed Tab option has no effect on Multiple-Line Text Boxes, Single-Line
Text Boxes, and Spin Boxes.

While answering questions:

All questions pertaining to the current instrument are available on the current form.

The scroll bar permits navigation to all the instrument’s questions on the form.

Using the Tab key for navigation performs as described above.

All data-entry visual artifacts respond in the same way as they do on the Single-Question
form.

5. After saving the administration, the answers given match the ones listed in the Instrument
Results Review report.

PR

October 2010 MHAS3 User Manual 111
Patch YS*5.01*96



Use of the Software

Identify the event of reaching the end of an instrument (or battery,) and finish the
instrument

An instrument administration is finished once all questions have been answered. In the case of the
“All Questions at Once” input form, questions may be answered on a single form which displays all
questions.

To end an Instrument Administration:

1.
2.
3.

4.
5

Answer every question in the instrument (the progress bar will be green).

Click on the Finish button.

If a required answer has not been answered (progress bar is red), a warning message is
displayed and user is returned to the data-entry form.

All instrument responses are saved to VistA.

The instrument saved message is displayed and user is returned to the Instrument
Administrator form.

Example: AUDIT instrument is saved by clicking on the Finish button.
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Use of the Software

a AUDIT: MEHPATIENT ,ONE

File wiew Tools Help

COne khpatient
AUDIT SSM: moen-2412

Y

4 Weakly
" & Dally or almost daily

9. Hawe wou or someone else been injured as a result of wour drinking?
1. Mo

2 %es, butnotinthe lastyear
£ 3. %es, during the lastyear

10. Has a relative or friend, ar & doctor or other health warker been concerned about your drinking or suggests
1. Mo

¢ 2 %as butnotinthe lastyear

£ 3. %es, during the lastyear

ALUDIT | BOME
Use speed tab

Hint: Llse the number key of the item to speed data entry.
YWorld Health Organization LT |

Once the answers are saved, the user is given the three options below concerning the progress
note. See Appendix C for cases where a co-signer is required for signing a progress note.
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Use of the Software

Save Progress Note to VistA

The data for this administration has been saved in Yista.
Doyou wish to:

[ Sawve standard progress note ]

’ Edit then sawe progress note ]

’ Do not sawve progress note
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Use of the Software

Selecting an Instrument within a Series

The instruments are listed in the tabs at the bottom of the form. These tabs are used to navigate to any
of these instruments.

To change the current instrument:
1. If the desired instrument tab is not the selected tab (in the foreground) click on the tab to
bring the instrument to the foreground. Or...

2. Use the View menu option, click on the instrument’s name in the View list.

Example: The Mental Health Assistant form displays the View menu instrument names.

w- AUDIT: MHPATIENT ,ONE

File N Tools  Help

Al sl One bhpatient
oy

4 ekl

& Daily or almost daily

4. Hawe you or someaone else been injured as a result of wour drinking?
& 1. Mo

' 2 as butnotinthe lastyear

£ 3. %es, during the lastyear

10. Has a relative or friend, or & doctor or other health worker been concerned about ywour drinking or suggeste
£ 1. Mo

* 2 es, butnotinthe lastyear

£ 3. %es, during the lastyear

P

AUDIT |BOMC |
T

Hint: Use the number key of the item to speed data entry.
‘orld Health Organization LT |
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To review answers given:

Example: Use the scroll bar to review every answer given. Moving the scroll bar permits all
questions and answers to be viewed.

- AUDIT: MHPATIENT ,ONE

File Wew Tools Help

One Mhpatient
AUDIT SEM: o212

-
7. How aften during the last year hawe you had a feeling of quilt ar remarse after drinking?
1 MNewer
@ 2 Lessthan manthly
3. Maonthly
4 Weakly

B Daily or almost daily Click and drag

8. How often during the last year hawe vou been unahble to rememberwhat happened the night beforeMecause
1, Mever

@ 2 Lessthan manthly
3 kanthly

4 Weekly 4
B Daily or almost daily

L e S PR U Y ¥ U e Prou Iy |

AUDIT |BOMC |
Use speed tah

Hint: Ulse the number key of the item to speed data entry.
Yorld Health Organization LT |
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Change a Previously-given Answer

To change a previously-given answer, navigate to the question and change the answer.

Example: Question #7 with answer changed to the second item.

ax. AUDIT: MHPATIENT ,ONE

File Wiew Tools Help

Cne khpatient
AUDIT Sa M w2412

Fa

7. How often during the last vear hawve vou had a feeling of guilt or remorse after drinking?
1. Mewver

* 2 Lessthan manthly
3 kanthly

4 Weekly

O B Daily or almost daily

8. How often during the last year hawe wou been unahble to rememberwhat happened the night before because
1. Mewver

* 2 Lessthan manthly
3 kanthly
4 Weekly

O B Daily or almost daily

L e S PR U Y ¥ U e Prou Iy |

AUDIT |BOMC |
o

Hint: Llse the number key of the item to speed data entry.
Yorld Health Organization LT |
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Suspend responding to questions and save the administration in an incomplete state.

To suspend responding to questions, click on the Finish button.

1. The “All questions at once” data-entry form closes and the user is returned to the Instrument
Administrator form

2. The instrument administration is automatically saved as an incomplete administration in
Vista. No data is lost.

3. The instrument appears in the list of available instruments as an incomplete administration,
which can be selected for resumption.

Example: BOMC saved as an incomplete administration.

- BOMC: MHPATIENT ,ONE

File wiew Tools Help

COne khpatient
BOMC SSM: moen-2412

Y

1a. Patient's response:

2. What month is it now?
" 0. Correct month ™+ 1. Incorrect month

Za. Patient's response:

Fepeat this phrase after me: John Brown, 42 Market Street, Chicago.

3. About what time is it? {within one hour)
0. Correcttime 1. Incorrect time

: Click
Ja. Patient's response: N\
L N 3
AUDIT BoOmC

Use speed tah
ot Vo .
Hint: Llse the number key of the item to speed data entry.

Cluestions skipped: 3. (TTITITITTITT ]
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Use of the Software

Example: Warning given upon exiting an incomplete administration.

Confirm PE|

“p \  Some guestions have nok been answered in the BOMC and the instrument is incomplete,
\_ﬁ/ Cuestions: 4a., 5., 5a., 6., 6a,,
¥ou have 2 days ko finish, otherwise wou will have to skart over,

Are vou sure you are done For now?

Exiting Data-Entry Session without Saving the Answers

Example: To abort saving any of the given answers to an administration, click on the Cancel button.
The editing session ends and no answers are saved.

Careful: The use of the Cancel button will close out the entire session, which means all the
instruments, if more than one has been selected, will be closed without saving, not just the instrument
that is active at the time.
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Use of the Software

Instrument Results Review Functions

Orientation

All previous tests completed by the selected patient are listed on the Instrument Results Review
form, and one of those tests is always highlighted (by default, the first test in the list is highlighted
when the user first access this form). A text-based report for the highlighted test is shown. If the
highlighted test has a numeric score, only one scale, and if the test has been completed more than
once, a graphical display of those scores is presented on the Graph & Table tab.

Example: The Instrument Results Review form offers functions to print, save and copy-paste
reports, tables and graphs, as well as enable the user to append comments to the results of the

highlighted test.

% Mental Health Assistant in use by MHPROVIDER ,ONE

Cine hdhpatient
SSM: w2412

~
&leohol Use Discorders Identification Test

Date &iven: 1/15/Z009
Clinician: Mhprovider, Cne
Lozation: 1 Test (north)

Veteran: Mhpatient, One
FEN: Hxx-xx-2412

DOE: Feb 1,1%ZZ (87)
Gender: Female

AUDIT &core: 0O
& score of B8 or more indicates a strong likelihood of hazardou=z or
harmful alcchol consumption.

Cuestions and Answers
1. How often do you have a drink containing aleohol?
Never
Z. How many drinks containing alcohol do you have on a typical day
when you are drinking?
Not asked {(due to responses to other gquestions)
3. How often do you hawve six or more drinks on one occasion?
Hot asked ({due to responses to other guestions)
4. How often during the last year have you found that you were not
able to stop drinking once you had started?
Not asked {due to responses to other guestions)
5. How often during the last year hawve you failed to do what was
normally expected from you because of drinking?
Hot asked (due to reswonses to other ouestions)

File Edit ‘ew Tools Help
Instrument Results Review: AUDIT
Instrurnents:
Date Marme
0141 g
01,/09/2009 BRADEM SCALE
121272008 BOMC
1240272008 CAGE
12/01/2008 CAGE
12/01/2008 ALDIT
1242008 ALDIT
12472008 ALDC
12/08/2006 IEQ
11/20/2006 CAGE
11/16/2006 CaGE
11/16/2006 CAGE
1116/2006 CAGE
11162006 CAGE
1043172006 CaGE
10/31/2006 ALDIT
10/31/2006 AlDC
1043072006 ALDIT
10/30/2006 CaGE
Beports | Graph & Table
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Use of the Software

Example: Graph and table views.

% Mental Health Assistant in use by MHPROVIDER ,ONE
File Edit ‘ew Tools Help

Instrument Results Review: AUDIT One Mhpatient

SEN: woo=-2412

Scores

1/20/2005  |1/20/2005  |1/21/2005  |1/1/2005  |1/e1/2005  |1421/2005  |1/24/2005  |1/31/20

AUDIT total
Total 21 22 21 12 22 19 Al 24

]

[

Beports  Graph & Takle
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Use of the Software

Example: Multi-scale instrument graph. Click on the « group of scales » name (in this case the

bold « SCLOR Total »).

%- Mental Health Assistant in use by MHPROVIDER ,ONE
File Edit Yiew Tools Help

Instrument Results Review: SCLI9R

SCLIR total

One Mhpatient
SN woomo-2d12

el * . g
?SCIJM OlC I—IS DEP AT\IJX HCIJS PHIOEI PSIY GISI PSIDI
|a-12,r20,r2005 = 020012006 -+ 0200172006 * 0201/2006 + 02/01/2006 & 020012006 = 020172006 4 02/01,2006 ¥ 02/01/2006 + 0201 /2006 I
Scores
1242042005 |02/01/2006 (0240172006 (0270142006 |02/0172006 |02/0172006 |02701/2006 |I]2,"I]1,"2I]I]B |I]2 15

SCLIR total

SOMSOMATIZATION 62 53 53 56 55 47 53 55 55
O-C;:0BSESSIVE-COMPULSIWE 56 49 49 46 49 47 55 47 51
FEINTERFPERSOMNAL-SENSITINT |58 52 53 46 48 48 51 51 48
DEF.DEFRESSION 49 45 1 1 39 42 46 40 39
ANANSIETY 57 50 47 L1 39 47 47 L1 49
HOS;HOSTILITY 65 45 50 49 49 49 50 49 55
FHOB;PHOBIC ANXETY 58 58 58 57 57 53 57 53 56
FARPARANOID IDEATION 62 49 52 48 49 47 49 49 48
FSY:PSYCHOTICISM 65 54 50 48 51 50 56 54 52
ADDADDITIOMNAL ITEMS 2.00 1.249 1.00 0.43 1.14 1.14 1.14 1.43 1.2
< >

Eeports  Graph & Table ‘

If you click on one of the scales, then this graph is presented.
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Use of the Software

w- Mental Health Assistant in use by MHPROVIDER ,ONE
File Edit Yiew Tools Help

One Mhpatient

Instrument Results Review: SCLIR SSN: oacoe2d12

DEP:DEFPERESSION

350
300
250

200
150
1004

50

0t t
1242042005 02/01/2006

Scores

12/20/2005  |02/01/2006 |02/01/2006 |02/01/2006  |02/01/2006  |02/01/2006  |02/01/2006  |02/01/2006 |02,

SCLIR total
SOM;SOMATIZATION 62 b3 53 b6 55 47 53 bh 55
0-C;:OBSESSME-COMPULSIWE 5E 49 49 46 49 47 55 47 51
FS:INTERPERSONAL-SEMSITINVIT| 58

52 53 4k 43 48 5 51 43
P N N A R [N
50 47 46 349 47 47 46 49

AN ANRIETY 57

HOS:HOSTILITY 65 45 50 49 49 49 50 49 55
PHOB.:PHOBIC ANAIETY 58 b 58 57 57 b3 57 b3 13
PARPARANOID IDEATION 62 49 52 48 49 47 49 49 45
PEY:PSYCHOTICISM 65 54 50 48 51 50 13 54 52
ADDIADDITIONAL ITEMS 2.00 1.24 1.00 0.43 1.14 114 1.14 143 124
&[] 4

Beports Graph & Tahle
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Use of the Software

Main Menu

The Main Menu offers user functions, such as tools and help.

Selected Patient Identification label

The Selected Patient Identification label displays information about who is the currently-selected
patient within MHA3.

Instrument’s Name

The Title Bar is a visual artifact that is used throughout MHAS to display information about the
context that applies to the current activity. In this case, the Title Bar displays the current instrument’s
name.

List of Previously-Administered Tests

This is the list of all tests that have been administered to the selected patient. The list is also used for
selecting which administration to process. The list may be sorted by date or instrument type.

The Report View:

The Report View displays an administration report in textual form, based on the patient’s data stored
in Vista for the selected administration.

The Navigation Tabs

These tabs are used to switch between report and graph/table view.

The Graph View:
The Graph View displays a graphical representation of test data values over time.

The Table View:

The Table View represents the same data as the Graph View, except that it is in table format. The
Table View also functions as a means for selecting which administrations and characteristics to
represent on the graph.
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Use of the Software

Selecting Another Patient

To select a different patient, click on the File > Select Patient menu item. After a brief pause, the
familiar CPRS patient-selection form is displayed. After selecting a new patient, both CPRS and
MHAZ are synchronized and updated to identify the same new patient.

Note: Refer to the CPRS documentation for instructions on patient selection procedures.

Example: Selecting another patient.

& Mental Health Assistant in use by MHPREMWINFD ONE

N Edit Wiew Tools Help
. ) One hhpatient
cave e, , isults Review: AUDIT SEN oomoc 2417
Print... 4
i ”~
Bt e ~ &Aleohol Use Disorders Identification Test
e Date Given: 1/15/2009
01,/09/2009 BRADEMN SCALE Clinician: Mhprovider, Cne
1241242008 BOMC Location: 1 Test (north)
12/02/2008  CAGE Veteran: Mhpatient, Cne
12/01/2008 CAGE BEN: xxx-xx-Z241Z
DOE: Feb 1,192ZZ (87)
12/00/2008 AUDIT cender: Female
12452008 ALUDIT
AUDIT Zcore: 0
11/24/2008  AUDC & score of 8 or more indicates a strong likelihood of hazardeous or
12/08/2006 IEC harmful alcchol consumption.
11/20/2006  CAGE
Cuestions and Answers
11116/2008  CAGE 1. How often do you have a drink containing aleohol?
MAGZ006  CAGE MNever
11/16/2008 CAGE Z. How many drinks containing alcochol do you have on a typical day
when you are drinking?
11/16/2006 CAGE Mot asked ({due to responses to other questions)
10/31/2006  CAGE 3. How often do you have six or more drinks on one occasion?
Not asked (due to responses to other guestions)
104312008 AUDIT 4, How often during the last year hawve you found that you were not
10/31/2006 | ALUDC akle to stop drinking once you had started?
Mot asked (due to responses to other gquestions)
10/30/2006 ALDIT 5. How often during the last year have you failed to do what was
10430/2006  CAGE vl|/|normally expected from you because of drinking?
Not asked (due to reswonses to other guesstions) s
Bepants | Graph & Table
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Use of the Software

Saving a Graph, Report, or a Table to a File

To save a graph, report, or table, click on the drop-down File Menu > Save As... menu item and
then click on Graph, Report, or Table. To save a graph or a table, the “Graph and Table” tab must be
selected first.

Example: A message dialog appears that asks the user to enter a filename and storage location for
the table, report or graph file to be saved. A graph is saved as a bitmap, a table is saved as an Excel
file and a report is saved as a text file.

@ Mental Health Assistant in use by MHPROYIDER ,ONE

FIEN Edit Wiew Tools Help
Select Patient. .. lm e Dy . CI]Ck One Mhpatient
W SSN: 0002412
i ”~
vt ” Alzohol Use Disorders Identification Test
r £ Date Given: 1/15/2009
01/08/2009 BRADEN SCALE “linician: Mhprovider, One
1241242008 BOMC Location: 1 Test (north)
12/02/2008  CAGE Veteran: Mhpatient, One
12/01/2008 CAGE BEM: xx-xx-Z2412
DOB: Feb 1,13%ZZ (87)
120172008 AUDIT cender: Female
11/24/2008  AUDIT
AUDIT Score: O
11/24/2008  AUDE & score of 8 or more indicates a strong likelihood of hazardous or
12/08/2006 IECQ harmful aleohol consumption.
12002006 CAGE )
Questions and Answers
TA1B/2008  CAGE 1. How coften do you have a drink containing aleohaol?
MAEZ006 CAGE Never
11/16/2006 CAGE Z. How many dr:!_nkls containing aleohol do you have on a typical day
when you are drinking?
11/16/2006 CAGE HNot asked (due to responses to other guestions)
1043172006 CAGE 3. How often do you have six or more drinks on one occasion?
Not asked (due to responses to other guestions)
10/31/2006 AUDIT 4., How often during the last year have you found that you were not
10/31/2006 | AUDC akble to stop drinking once you had started?
Not asked (due to responses to other guestions)
10/30/2006 ALDIT 5. How often during the last year hawve you failed to do what was
10430/2008 CAGE vl ||normally expected from you because of drinking?
Not asked (due to reswonses to other cuestions) b
Beponts | Graph & Table
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Use of the Software

Example: Save As form.

Save i |B by Documents

IChAnnual Leave CMHASZ [ My irkual Machines
ICiCreatar [Ty eBooks &) TestBlug)
IChedipse @My Music lﬂTest Scores.bmp
I)Elementk. Classes EM}.H Pictures )
|5)Email Archive |=3My Received Files Type a new filename, or
I GAF @MY videos keep the default
e

File name: .zt Scores.bmpl
Save az twper | Bitmap files [*.brp] j Cancel
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Use of the Software

Printing a Graph, Report or Table.

To print a graph, report, or table, click on the drop-down File Menu > Print... menu item and then
click on Graph, Report, or Table menu item.

A copy of the table, report or graph is sent directly to the default printer.

Example: Printing a graph, report, or table.

% Mental Health Assistant in use by MHPROVIDER ,ONE
GIEN Edit Wiew Tools Help

Select Patient. .. :
- ; Cine hdhpatient
cave e , isults Review: AUDIT SN o001
”~
Alcohol Use Disorders Identification Test
01/15/2003 Date Given: 1/15/2009
01/08/2009 BRADEN SCALE “linician: Mhprovider, One
124 242008 BOMC Location: 1 Test (north)
12/02/2008  CAGE Veteran: Mhpatient, One
12/01/2008 CAGE FEN: xxx-xx-Z41Z
DOB: Feb 1,15%2Z2 (87)
120142008 AUDIT cender: Female
12452008 AUDIT
AUDIT Score: 0
11/24/2008  AUDC & score of 8 or more indicates a strong likelihood of hazardous or
12/08/2006 IEC harmful alcohol consumption.
11/20/2006 CAGE )
Questions and Answers
TA1B/2008  CAGE 1. How often do you have a drink containing alcohol?
111642006 CAGE Never
11/16/2006 CAGE Z. How many dr:!_nkls containing alcohol do you have on a typical day
when you are drinking?
11/16/2006 CAGE Not asked (due to responses to other guestions)
10/31/2006  CAGE 3. How often do you have six or more drinks on one occaslon?
Not asked (due to responses to other guestions)
104312008 AUDIT 4, How often during the last year have you found that you were not
10/31/2006 | AUDC able to stop drinking once you had started?
HNot asked (due to responses to other guestions)
10/30/2006 ALIDIT 5. How often during the last year have you failed to do what was
10/30/20068 CAGE ||||normally expected from you because of drinking?
Not asked (due to reswonses to other ouestions) b
Beports [ Graph & Table
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Use of the Software

Copying a Graph, Report, or Table to the Windows Clipboard.

To copy a report, graph, or table to the Windows clipboard, click on drop-down Edit Menu >
Copy... menu item and then click on Graph, Report, or Table. A copy of the table, report or graph is
sent to the Clipboard. The contents of the Clipboard can then be pasted onto an MS Word or Excel

document.

Example: Copying a report the Windows clipboard.

% Mental Health Assistant in use by MHPROYIDER ,ONE

Fil= N[ view Tools Help
G oo o Click One Mhpatient
Insrrument eview: AUDIT - SN oomocr 1
Instrurnents: ~
Date Mame Alzohol Use Disorders Identification Test
‘ Date Given: 1/15/2009
01/08/2009 BRADEN SCALE “linician: Mhprovider, One
1241242008 BOMC Location: 1 Test (north)
12/02/2008  CAGE Veteran: Mhpatient, One
12/01/2008 CAGE BEM: xx-xx-Z2412
DOB: Feb 1,13%ZZ (87)
120172008 AUDIT cender: Female
11/24/2008  AUDIT
AUDIT dcore: O
11/24/2008  AUDC & score of 8 or more indicates a strong likelihood of hazardous or
12/08/2006 IEQ harmful aleohol consumption.
12002006 CAGE )
Questions and Answers
TA1B/2008  CAGE 1. How coften do you have a drink containing alcohaol?
MAEZ006 CAGE Hever
11/16/2006 CAGE Z. How many dr:!_nkls containing aleohol do you have on a typical day
when you are drinking?
11/16/2006 CAGE HNot asked (due to responses to other guestions)
1043172006 CAGE 3. How often do you have six or more drinks on one occasion?
Not asked (due to responses to other guestions)
10/31/2006 AUDIT 4., How often during the last year have you found that you were not
10/31/2006 AUDC akble to stop drinking once you had started?
Not asked (due to responses to other guestions)
10/30/2006 ALDIT 5. How often during the last year hawve you failed to do what was
10430/2006  CAGE normally expected from you hecause of drinking?
Not asked (due to reswonses to other cuestions) b
Beponts | Graph & Table
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Use of the Software

Example: Message displayed after copying to the clipboard.

Information [5_(|

i J The repark has been copied ko the Windows clipboard,

If vau like, wou may paste it inka an open text docurment.
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Use of the Software

Exiting the Instrument Results Review Form

To exit the Instruments Results Review form, click on the File > Exit menu item. The Instrument
Results Review form will close and the user is returned to the MHA3 Main form. Alternately, you

can press the “ESC” key or click on the “X” in the upper right-hand corner of the form.

Example: Exiting the Instruments Results Review form.

% Mental Health Assistant in use by MHPROVIDER ,ONE

GIEN Edit Wiew Tools Help

Select Patient. .

Save As.., 3
Print... 3

01/08/2009
122/2008 | BOMC
12/02/2008  CAGE
12/01/2008  CAGE
12j0n/z008  AUDIT
11j24/2008  AUDIT
112402008 AUDC
12/08/2006  |IEQ

11/20/2006  CAGE
MA6/2006 CAGE
MA6/2006 CAGE
MA6/2008  CAGE
MA6/2006 CAGE
10/31/2006 CAGE
10/31/2006  AUDIT
10431/2006  AUDC
10/30/2006  AUDIT
10/30/2006 CAGE

sults Review: AUDIT

clinician: Mhprovider, One
Location: 1 Test (north)

Veteran: Mhpatient, One
HEM: xxx-xx-Z41Z2

DOE: Feb 1,1922 (87)
Gender: Female

AUDIT Score: 0
& score of 8 or more indicates a strong likelihood of hazardous or
harmful alcohol consumption.

Questions and Answers
1. How often do you have a drink containing alcohol?
Newver
Z. How many drinks containing alcohol do you hawve on a typical day
when you are drinking?
Not asked (due to responses to other guestions)
3. How often do you have six or more drinks on one occaslon?
Not asked (due to responses to other guestions)
4, How often during the last year have you found that you were not
able to stop drinking once you had started?
HNot asked (due to responses to other guestions)
5. How often during the last year have you failed to do what was
normally expected from you because of drinking?

Not asked (due to reswonses to other ouestions)

Beports [ Graph & Table

October 2010

MHAS3 User Manual
Patch YS*5.01*96

131



Use of the Software

Switching Views from Reports to Graph and Table and Back

Example: To switch between views, click on View > Reports and View > Graph and Table, to
switch between views on the form. The navigation tabs at the bottom-left of the form serve the same

purpose.

%. Mental Health Assistant in use by MHPROVIDER,ONE =13
File  Edit Tools  Help
; Cine hdhpatient
Instrui w: AUDIT SN comoc 41
Shaow walues on graph
Instruments: Click here... ~
&leohol Use Disorders ldentification Test
Date Siven: 1/153/Z009
01/08/2009 BRADEM SCALE Clinician: Mhprovider, Cne
12/12/2008 BOMC Lozation: 1 Test (north)
12/0z/2008 | CAGE Veteran: Mhpatient, One
1270172008 CanE HEN: xxx-xx—Z412
DOE: Feb 1,1%ZZ (87)
12012008 ALDIT cender: Female
11/24/2008  AJDIT
AUDIT Score: 0O
11/24/2008  AUDC & score of 8 or more indicates a strong likelihood of hazardous or
12/08/2006 IEC harmful alcohol consu.mption.
112002006 CAGE
Cuestions and Answers
1116/2006  CAGE 1. How often do you have a drink containing aleohol?
11/6/2006  CAGE Never
11/16/2008 CAGE Z. How many drinks containing alcochol do you have on a typical day
when you are drinking?
1116/2006  CAGE Not asked (due to responses to other guestions)
10/31/2006  CAGE 3. How often do you hawve six or more drinks on one occasion?
Hot asked ({due to responses to other guestions)
10/31/2006 ALDIT 4. How often during the last year hawve you found that you were not
10/31/2006 | ALDC rinking once you had started?
{due to responses to other guestions)
1073072008 AUDIT during the last year have you failed to do what was
10/30/2006  CAGE Jl|||normally expected from you because of drinking?
4 Hot asked (due to reswonses to other ouestions) s
Beports | Graph & Table |
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Use of the Software

Appending Comments to an Existing Record

Comments can be appended to existing reports in Vista:

1.
2.
3.
4.
S.
6.

Example: Mental Health Assistant Tools menu > Append comments...item

Select the instrument to which to append comments

Click on the Tools > Append comments... menu item

The Comments Editor Form is displayed.

Type a new comment in the Comments Editor

Click on File > Save Comment in the Comments Editor menu
Comment appears appended to the administration’s report text

w- Mental Health Assistant in use by MHPROYIDER ,ONE
File Edit Wiew

HAREIS - One thpatient
Instrumen  Dpelete administeation Del =20 :00(—)(?(—241 2
METRIC Instrument Reviews. ..
Instrurnents: options. .. -~

Tzokhol Use Disorders Identification Test

Marme

. - Date Given: 1/15/2009
01/08/2009 BRADEMN SCALE Clinieian: Mhprovider, One

1241242008 BOMC Location: 1 Test (north)
12/02/2008 | CAGE Veteran: Mhpatient, One
1240172008 CAGE SEN: xxx—xx—241Z

DOBE: Feb 1,192Z2 (87)
Gender: Female

12/01/2008 AUDIT
112402008 AUDIT

11242008 AUDC AUDIT Score: O

& score of B8 or more indicates a strong likelihood of hazardous or

12/08/2006 IEC harmful alcchol consuwmption.
11/20/2006 CAGE .
CDuestions and Answers
11/16/2006  CAGE 1. How often do you have a drink containing alcchol?

11/16/2008 CAGE Never
11/16/2006 CAGE Z. How many drinks containing alcohol do you have on a typical day

when you are drinking?

11/16/2006 CAGE Mot asked (due to responses to other guestions)
10/31/2006 | CAGE 3. How often do you have six or more drinks on one occasion?
HNot asked (due to responses to other guestions)
10/31/2008 AUDIT 4, Heow often during the last year have you found that you were not
10/31/2006 | AUDC akle to stop drinking once you had started?

Not asked (due to responses to other guestions)
5. Heow often during the last year have you failed to do what was
normally expected from you because of drinking?

HNot asked (due to resvonses to other guestions)

10430/2008  AUDIT
1043072006  CAGE

Beports | Graph & Table
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Use of the Software

Example: Comments Editor form displays previous and new comments.

& Append Comments E]E]

File Help
AUDIT 1115/2009 Ss?ajn?oghﬁaztﬁnzt

Previous Comments

Maone

Mew Cormments

\ Type comments here
’ Sawe and Exit
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Use of the Software

Example: Save Comment and Exit.

& Append Comments : El[‘&__(I
File Help

One Mhpatient
AUDIT 1/15/2009 S

Previous Comments
Mone

Mew Comments
Here are my new comments for thiz AUDIT administration.|

Save Emd Exit
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Use of the Software

Example: Comment added to a report.

%.|Mental Health Assistant in use by MHPROVIDER,ONE =13

File Edit ‘ew Tools Help

Instrurnents:

Instrument Results Review: AUDIT SEN: oo 2417

Cine hdhpatient

Date Marme

myog/z008  BRADEM SCALE
1212/2008  BOMC
12/02/2008  CAGE
12j01/2008  CAGE
12j0njza0s  AUDIT
112452008 AUDIT
112402008 AUDC
12/08/2006  |EQ
11/20/2006 CAGE
11/16/2006 | CAGE
116/2006 | CAGE
1A16/2006  CAGE
11/16/2006 CAGE
10/31/2006 | CAGE
10431/2006 AUDIT
1043102006 AUDC
1043002006 ALUDIT
10/30/2006 | CAGE

7. How often during the last year have you had a feeling of guilt or a
remorse after drinking?
Not asked {due to responses to other guestions)
8. How often during the last year have you heen unakle to remember
what happened the night before because you had been drinking?
HNot asked {due to responses to other guestions)
9. Have you or someone else been injured as a result of your
drinking?
No
10. Has a relative or friend, or a doctor or other health worker heen
zoncerned about your drinking or suggested that you cut down?
No

Information contained in this note is based on a sel
azssessment and 1= not sufficient to use aldhe for dia Comment added

Irlaccuracy arn to report

Assessment results should be verified
conjunction with other diagnostic ag

CommentS—————————————— ==

*+*  Comment Entered By: MHPROVIDER, ONE Comment Date: 5/5/2009
Z2:00:28 PM

Here are my new comments for this AUDIT administration.

Beports | Graph & Table |

Removing data entered in error

Select the administration of the instrument you wish to remove. The instrument’s name and the
date of the administration will be highlighted, and its report will appear in the right window. In
this example, notice that there are five administrations of the CAGE on 11/16/2006.
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Use of the Software

w- Mental Health Assistant in use by MHPROVIDER ,ONE

File Edit Yiew Tools Help

Instrument Results Review: CAGE

One Mhpatient

1gfz008  AUDIT
11/24/2008 AUDIT
11/24/2008  AUDC

-—— CAGE ---
--- ITEM RESPONSES —--

1116/2006 | CAGE
11/16/2006 | CAGE

A

1116/2006 | CAGE

11/1E i

11/16/2006 | CAGE

10/31/2006 | CAGE

1043172006 AUDIT

104312006 AUDC

1043042006 | AUDIT

10/30/2006 | CAGE

10/30/2006 | AUDIT

10/30/2006 | CAGE

10/27/2006 AUDIT &

SEN: oo--2412

Instruments: Mot walid unless signed: Reviewed by ... ... ... ...
Date |Name |g Printed by: MHPROVIDER, ONE

oOrdered by: MHPROVIDER, ONE
01/09/2008  BRADENSCALE ||| oo o0 ¥
1222008 BOMC *rrggprEt
12/02/2008 CAGE

000-00-2412 MHPATIENT, ONE F AGE 86 01/15/2009 11/16/2006
12/01/2008  CAGE PRINTED ENTERED

12/08/2006  IEQ 1w Z N 3N 4 % - .
11/20/2006 | CAGE / Administration to be deleted

Beports | Graph & Tahle |

There are three ways to initiate the deletion process:

1) Select « Delete administration » from the Tools option in the Main Menu.

2) Press the « DEL » key.
3) Right click, then select « Delete » from the pop-up menu.
These three methods are illustrated below.

October 2010 MHAS3 User Manual
Patch YS*5.01*96

137



Use of the Software

& Mental Health Assistant in use by MHPROVIDER ,ONE
File Edit Wview BIEEEN Help

Append Camments., .,

Instrumen EEEEETEET

METRIC Insktrument Reviews...

Instrurments: Options. .. lid unless signed: Re
T — e
01/08/2008 BRADEMN SCALE | — \ ;
1212/2008 BORMC FrEogopr
12/02/2008  LAGE 000-00-241% MHPATIENT, ONE
1240142008 CAGE
12/01/2008 | AUDIT
11242008 | ALUDIT -
11242008 AUDC
12/08/2006  IEQ tw o enw 3N 4N
1142042006 CAGE
1111 6/2006 CAGE
1111 6/2006 CAGE
1111 6/2006 CAGE
11/16/2008
1111 6/2006 CAGE
10/31/2006 CAGE
10/31/2006 | ALIDIT
10/31/2006  ALDC
1043042006 | ALIDIT
1043042006 CAGE
1043042006 | ALIDIT
1043042006 CAGE
10/27/2006 | ALIDIT .
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Use of the Software

@ Mental Health Assistant in use by MHPROVIDER ,ONE
File Edit Wiew Tools Help

Instrument Results Review: CAGE

[nstruments: Mot walid 1
Diate Matre #| ||Printed by:
GrecloEesl o
01/09/2008 BREADEMSCALE =~ | |- --r=% =¥
12A12/2008  BOMC $rtogpthr

12/02/2008  CAGE
12/01/2008  CAGE
12/01/2008  AUDIT
11/24/2008  AUDIT
11/24/2008  AUDC W
12/08/2006 | IEQ L
11/20/2006  CAGE
11/16/2006  CAGE
11/16/2008
11/16/2008
11416/2008 oelete * |
11/16/2006  CAGE T

10/31/2006  CAGE
10/31/2006  AUDIT
10/31/2006  AUDC

ooo0-00-Z41:

2. Click

Once you press the « DEL » key, or one of the above methods, this warning dialog will appear.

Jate |Name |A Printed by: MHEROVIDER, ONE
Ordered by: MHPROVIDER, ONE

1n/08/2008  BRADEM SCALE | —

2

2 (=
1) This operation can not be reversed laker. 1/15/200¢

2 ! RINTED

2 23 Only the data are removed From Wista; any progress noke, consults, etc, based on these data are not deleted or changed by this
ackion,

1 Are you sure you want to permanently delete the results of the CAGE administered on 11/16/20067

1

2 [ Yes,

1

1162006 CAGE

Ui LALGE ‘ ‘
1HRMSNNR ACE

[ e ]
O e
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Use of the Software

If you are sure that the deletion is proper, click on the « Yes » button. If the data are removed
successfully, this prompt will appear. In addition, the list of instruments will have been
refreshed.

Eraden #cale tor Predaicting Pressure Uloer Risk
Date Giwven: 1/759/2009

“linician: Mhprovider, One

Location: 1 Test (north)

Mhi

Veteran: atient, One

The data were deleted.

J\.:.

AL hring ful

ALl Remember that progress notes, consults, ete, are not deleted or changed by this process.

AL to mols

[EC P P .
Aotiwvity ——- ability to <change and control body posi

CAGE Walks frequently.

CAGE Mobility -- ability to change and control body posi

Ho limitation.
CAGE Hutrition —-- usual food intakepatterns
AT Formal ]l arnt+

Notice that only four administrations of the CAGE are listed for 11/16/2006.
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w- Mental Health Assistant in use by MHPROVIDER ,ONE

File Edit Wiew Tools Help
. One Mhpatient
Instrument Results Review: BRADEN SCALE SN 01
Instruments: EBraden Scale for Predicting Pressure Ulcer Risk
Date ~||/|lDate Given: 1/3/2009
BRADE =||/|¢linician: Mhprovider, One
A Location: 1 Test (north)
BOMC Veteran: Mhpatient, One
12/02/2008 CAGE Egg :xi_fxlggéz (8a)
: Fe g
12/01/2008 CAGE Gender: Female
12/01/2008  AUDIT densory perception -- ability to respond meaningfully to pressure-related
discomfort
11/24/2008 AUDIT No impairment.
11/24/2008  AUDC Moisture -- degree to which skin is exposed to molsture
Rarely moist.
12/08/2006 | 1EQ Aotivity —- ability to change and control body position
11/20/2006 CAGE Walks freguently.
11416/2006 CAGE Mobii:i_tfrr ——Iability to change and control body position
No limitation.
11/16/2008 CAGE Nutrition -- usual food intakepatterns
1116/2006 | CAGE Excellent.
11/16/2006 CAGE Friction and shear
No apparent problem.
10/31/2006 | CAGE
*** Braden Zcale Score ***
1043172006 AUDIT
Ay devere risk 2 or lower.
1043142006 AUDC High risk:10-1Z2.
1043042006 ALDIT Moderate risk: 13-14.
Mild risk: 15-18.
10/30/2005 | CAGE P
1043072006 AUDIT Copyright Barbara Braden & Nancy Eergstrom, 1988
10/30/2006 | CAGE
10/27/2006 AUDIT
10/27/2006  AUDC &
Beports | Graph & Tahle
October 2010 MHA3 User Manual 141

Patch YS*5.01*96



Use of the Software

Addiction Severity Index Manager Functions

Orientation

The ASI Manager lists all previous interviews and makes it easy to view either the item report or
narrative report for a selected interview.

Additional views of ASI data are provided. Both the Domain Scores and Item Trends functions
present graphical and tabular data across multiple interviews. The Domain Scores option gives the
user the opportunity to see either problem severity ratings or evaluation factor scores (see Alterman,
et al., [1998] "New scales to assess change in the Addiction Severity Index for the opioid, cocaine,
and alcohol dependent”, Psychology of Addictive Behavior, 12, 233-246). The Item Trends option
displays responses to selected individual items. It is hoped that these data views will help with
treatment planning and treatment outcome monitoring.

A user-friendly interface for entering interview data is provided. This "New ASI" option enables
staff to quickly enter data, to easily jump from one item to another, and to enter free text comments at
any time. This option should greatly reduce data entry time, whether transcribing interview results
from a paper form or entering them on-line during an interview. It is not a self-administered version
of the ASI, though, and should not be used for patient entry of ASI responses.
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Use of the Software

Example: Addiction Severity Index Manage form

} Selected patient identification

w.- Mental Health Assistant in use by MHPROVIDER  ONE
File Edit Wview/ Tools Help

Addiction Severity Index Marager—
Frevious ASI

Title bar EE—

Previous List of

=

One Mhpatient
SEM: o212

Ordered By BNASIS
12482006 MHPROWIDER, MEW
6/13/2006 LITE MHPROVIDER. MEWY Incomplete

Completed

|>

False
B/2006 LITE MHPROVIDER MEW Completed True
:3?9 igllfs SInee » T FUNEWY Feady to sign False 3
ast X ASI editing buttons
Y
MHPATIENT,OWE O0O00-00-Z41Z AST LITE on 1E/702/72006 by: MHPROVIDER, NEW i3
*** PEYCHOSOCIAL HISTORY ***
GENEDRAL INFO 0N
M=. Mhpatient is 87 wear old White (not Hisp), married female NEC weteramn.
She lists her reliNious preference as Protestant. She was admitted to the v
MNarrative Report | ltern Trends | Domain Scores
Last ASI days
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Use of the Software

Main Menu
The Main Menu offers user functions in the context of the ASI Manager form, such as tools and help.

Selected Patient Identification Label
The Selected Patient Identification label displays information about who is the currently-selected
patient within MHAZ3. All functions performed in the ASI Manager form will apply to this patient.

Title Bar

The Title Bar is a visual artifact that is used throughout MHAS3 to display information about the
context that applies to the current activity. In this case, the Title Bar displays the current instrument’s
name.

List of Previously-Administered ASIs
This is the list of all ASIs that have been administered to the selected patient. The list is also used for
selecting which ASI to process.

Report View
The Report View displays an administration report in textual form, based on the patient’s data stored
in Vista for the selected administration.

Navigation Tabs
These tabs are used to switch between the various views of the data.

ASI Editing Buttons
The ASI Editing Buttons are used to create new ASIs or edit existing ones.

Days Since Last ASI Label
The Days Since Last ASI label is a reminder about how long ago the current patient had an ASI.
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Use of the Software

Determining the Number of Days since the Last ASI for Selected Patient

To determine when the last ASI was for the current patient, observe towards the middle-left of the
ASI Manager form. Read the text label that states ““x” days since last ASI.”

Example: The last ASI for this patient was administered 879 days ago.

% Mental Health Assistant in use by MHPROVIDER,ONE =13
File Edit W¥iew Tools Help

One Mhpatient

Addiction Severity Index Manager QSN oo 0417
Previous ASl
Mew ;
Date Twpe Ordered By Status Signed A
12 1[5 MHPROVIDER, NEW Completed B
61372006 LITE MHPROVIDER. MEWY Incomplete False
22006 LITE MHPROVIDER NEW Completed True
879 days since .
It AG| 2842006 LITE MHPROWIDER, MNEW Ready to sign False 2
.
MHPATIENT,ONE OQO0-00-Z412 ASI LITE on 1270872006 by: MHPROVIDEER,NEV =
**+ PETCHOSOCIAL HISTORY *+%
GENERLL INFORMATION
M=. Mhpatient i=s a 37 year old White i(not Hisp), married female NEC wveteran.
She lists her religious preference as Protestant. She was admitted to the v
MNarrative Repart ltem Report | tem Trends | Domain Scores
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Selecting a Previous Interview

To select from previously-administered interviews, click on the row for the desired interview on the
table that lists all previous interviews (upper section of form). The clicked row will be highlighted,
and the corresponding report type (Item or Narrative) will be shown below the table.

Example: The ASI interview dated 12/8/2006 is selected, and the Narrative Report is shown below.

@ Mental Health Assistant in use by MHPROVIDER ,ONE

B=E

File Edit Miew Tools Help
- . One Mhpatient
Addiction Severity Index Manager SN 00eec D417
Frewvious Al
Mew - ;
Date Type Ordered By Status Signed A
MHPROVIDER. MEWY Completed
6/13/2006 LITE MHPROWIDER MEW Incomplete False
2/af2006 LITE MHPROVIDER. MEWY Completed True
879 days since .
last AS| 2/8/2006 LITE MHPROVIDER MEW Feady to sign False 2
s
MHPATIENT ,ONE 000-00-2412 ASI LITE on 1Z/08/2008 by: MHPROVIDER,NEW =
=% PETCHOSOCTAL HISTORY **+
GENERLL INFORMATION
Nz, Mhpatient is a 27 wear old White (not Hisp), married female NSC wveteran.
She lists her religious preference as Protestant. She was adpitted to the o
MNarrative Report ltem Report | term Trends | Domain Scaores
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Selecting a Report Type

To select a report type, click on a navigation tab at the bottom of the form. Switch between
Narrative Report and Item Report. The selected report type will be shown for the selected

(highlighted) interview.

Example: The Item Report for the 12/8/2006 interview is shown. Note that more than one signed
ASI record must be available for displaying the Domain Scores or Item Trends tabs.

@ Mental Health Assistant in use by MHPROVIDER ,ONE

FBX

File Edit Wiew Tools Help
. . One Mhpatient
Addiction Severity Index Manager SN oo 0412
Frewvious AS|
Date Type Ordered By Status Signed w
MHPROYIDER MNE'W Completed W
£/13/2000 LITE MHPROYIDER MEWY Incomplete False
879 daye since | 2/6/2006 LITE MHPROVIDER, MEWY Completed True
= 2482006 LITE MHPROVIDER NEW Ready to sign False v
ey
MHPATIENT,ONE 0O00-00-241Z ASI LITE on lZ/08/2006 by: MHPROVIDER,NEV =
*x%%%t CENERAL INFORMATION **+%%
Hame: MHPATIENT i
52 No.: 00040Z41Z 2. CIICk
Admission Date: C 08, z00&
Interview:/DEC 08, E00&
Time Be )
Time Endgd: o
Contact : IN PERSON 1. Click
: LITE
: FEMALE v
Report ltem REPDﬁTltem T[endsJ Diomain Sc:u:nresJ
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Restarting an Unsigned ASI

NOTE: This option can be used to complete, edit, or sign an unsigned ASI.

Example: To restart and unsigned ASI, select an unsigned ASI in the table that lists previous ASIs
on the ASI Manager. Click on the Edit button. The data entry form will appear, and previous

answers will be inserted.

& Mental Health Assistant in use by MHPROVIDER ,ONE

File Edit Wiew Tools Help

Addiction Severity Index Manager

One Mhpatient

e 1. Sel
Frewvious ASl Select
Mew .
Date ‘Typy ‘Ordered By Status Signed =
Edit 12/8/2006 LI MHPROVIDER NEWY Completed True =

6/13/2006 TE MHPROVIDER MNEW Incomplete False
2/8/2006 LITE MHPROVIDER MEW Completed True

?;sgt igﬁl’s Sl LITE MHPROWIDER, MEWY Ready 1o sign

MHPATIENT ,ONE 0Q00-00-241Z2 AST LITE on 0Z2/08/Z006 by: MHPROVIDER , NEW
#HifE Thsioqned Drafr FEFEE

F** PETCHOSOCIAL HISTORY ***
GCENEDMAL INF

M=. Mhpatient i=s a 27 year old Black i(not Hisp), married female NEC wveteran.
She lists her religious preference as Protestant. She was admitted to the
Conzultation/liaison program on Feb 08, Z20056. In the past 30 days, she has not
heen in a controlled environment. Zhe has liwed at her current address for 2
wears, 2 months.

Thisz report is based om an ASI Lite interwview conducted in person on Feb 08,
2006 by New Mhprowvider. Ms. Mhpatient completed the interwview.

Composite Score
MEDICAL a.aoao

Marrative Report | jam Feport | ltem Trends | Domain Scores
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Starting a New ASI

To start a New ASI, click on the New ASI button, and then click on the Full menu item. There are
two types of New ASI data which can be entered: Full or Lite. The ASI data entry form will appear,
and will be formatted corresponding to the choice made by the user of Full or Lite.

Example: File > New ASI... menu item

& Mental Health Assistant in use
Edit View Tools

Mew ASL.. L4

Select Patient. ..

Follow-Lp

Example: The Addiction Severity Index Manager form.

% Mental Health Assistant in use by MHPROVIDER ONE M=1E3
File Edit Wiew Tools Help

One hhpatient

Addiction Severity Index Manaier SN oo 4] ?

= S Type Ordered By Status Signed A
Ul

e 12/8/2006 LITE MHPROYIDER NEW Completed Trus 3
Follow-Up R 64132006 LITE MHPROVIDER NEW Incomplete False
2/3/2006 LITE MHPROVIDER NEW Completed True

879 days since AT =D =
Y LITE MHPROVIDER NEW
last AS X
\W E
MHPATIENT,ONE OO 2 (:Iicl( LITE on 0270872006 by: MHPROVIDEER NEW 3
' ed Draft $§E£§# =
*** DEYCHOEOCIAL HISTORY *+*
GENERAL INFORMATION
M=_. Mhpatient is a 87 wear old Black (not Hisp), married female NEC weteran.
Bhe lists her religious preference as Protestant. She was admitted to the
Consultation/Liaison program on Feb 08, Z00&. In the past 30 days, she has not
been in a controlled enwiromment. She has lived at her current address for &
wears, 3 months.
This report is based on an AST Lite interwview conducted in person on Feb 08,
2006 by Mew Mhprowvider. Ms. Mhpatient completed the interwiew.
Composite Score
MEDICAL [npn]ully] ot
Marrative Report | jam Report| ltem Trends | Domain Scores
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When the ASI data entry form first begins, it highlights the first item. The first item, G3, is
automatically set to the user's last selection. In addition, the fields “G4. Date of Admission” and “G5.
Date of Interview,” contains today’s date as defaults; field “G9. Contact Type” is set to “1. In
person” and “G11. Interviewer” and “G11a. Ordered By” are set to the staff member who logged on
to MHA, field “G12. Special” is set to “N. Interview completed.”

ASI Type Items with default values

Full G4, G5, G8, G9, G11, G1la and G12.

Lite G3, G4, G5, G8, G9, G11 and G11a.

Follow-up G3, G4, G5, G8, G9, G11, Gllaand G12.
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Example: G8 is “grayed-out” because it is modifiable. However, G8 displays the selected ASI type.

Default items based on ASI type

Addiction Severity Index

File Taools Help

General Information

53 Program Type: lpatient Acute Care j

Gd. Date of Admission;| 2020058 - G4, Date of Interiew; 3NQ200s -

G4 Contact Type:

IU |_ |_ |7 1.ln person |_ 2. Phone
G11. Interviewer : |Iu1hprwider1 ane -
G11a. Ordered By:  |Mhprovidert One -
G12. Special:

[T 1. Patient terminated [ 3. Patient unable to respond

[T 2 Patient refused [ M. Interdew completed

*G14. How long hawe you lived atthis address? Years: jl Months: i‘

G148 15 this residence owned by you aryoor family?

|_ 0. Mo |_ 1.%es |_ #. Mot Answered
G17. Race
|_ 1.White (not Hispanic) |_ 4. Alaskan Mative |_ 7. Hispanic - Puerto Rican
|_ 2. Black (not Hispanic) |_ 4. Asian or Pacific Islander |_ 2. Hispanic - Cuban
|_ 3. American Indian |_ . Hispanic - Mexican |_ 9. Other Hispanic

G18. Relinious Preference -
Jd _ _ | ;H

General Comments:

G General Info | i wedical | E Employment QDrugIAIcnhnl] I:Legall H Family H}{] Fﬁcu:ial] B Psvchia 4 | p

Click on dowen arrow for list of programs. F1 for help.
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Selecting a New Patient

NOTE: Refer to the CPRS documentation for instructions on patient selection procedures.

Example: To select a different patient, click on the File > Select Patient menu item. After a brief
pause, the familiar CPRS patient-selection form is displayed. After selecting a new patient, both
CPRS and MHAS are synchronized and updated to identify the same new patient.

s Mental Health Assistant in use by MHPROYIDER , ONE
N Edit Wiew Tools Help

Mew ASTL., 4 .
. One hhpatient
rity Index Manager :
e raent | g SEN: s000c2412
Save As... b 2vious ASI
Print... P hte Type Ordered By Status Signed A5
Ext MHPROVIDER MEW Complated
06/13/20086 LITE MHFROVIDERMEW Incomplete False
02/08/20086 LITE MHFROVIDER MNEW Completed True
lgaasntigﬁl’ss'”':e 02/08/2006 LITE MHPROVIDER, MEW Ready 1o sign False 2
”
MHPATIENT,ONE O0O00-00-Z241Z ASI LITE on l2/08/Z00& by: MHPROVIDER NEW 3
*** DEYCHOEOCIAL HISTORY *+* —
GENERAL INFORMATION
M=. Mhpatient is a 87 year old White (not Hisp), married female NEC weteran.
She lists her religious preference as Protestant. She was admitted to the
Consultation/Liaison program on Dec 08, Z200&6. In the past 30 days, she has not
bheen in a controlled enwviromment . She has lived at her current address for 32
wears, 3 months.
This report is baszed on an AST Lite interview conducted in person on Dec 08,
2006 by MNew Mhprowider. Ms. Mhpatient completed the interwiswr.
Composite Score
MEDICAL 0.0ZEZ
EMPLOTMENT 0.5386 b
Marrative Report Item Fieport | llem Trends | Domain Scores
October 2010 MHAZ3 User Manual 152

Patch YS*5.01*96
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Saving a Report, Graph or Table to a File

To save a graph, report or table, click on File > Save As... menu item and then click on Graph,
Report or Table. To save a graph or a table, the “Graph & Table” tab must be selected first.

The following types of reports are available:
e Narrative Report

Item Report

Item Trends Report

Items Trends Graph

Domain Scores Report

Domain Scores Graph

Select the report or graph types by clicking on each of the four tabs at the bottom of the form.

Example: A message dialog appears that asks the user to enter a filename and storage location for
the table, report or graph file to be saved. A graph is saved as a bitmap, a table is saved as an Excel

file and a report is saved as a text file.

m. Mental Health Assistant in use by MHPROVIDER ,ONE

GIEN Edit  wiew Tools Help

Mew ASI...

Select Patient. .

.3
Frily Index Manager

One Mhpatient
SEM: wooeoe2412

Ordered By

Exit o o MHPROWIDER. MEW Completed 3
06413720086 LITE MHFPROWIDER.NEW Incamplete False
D2/08/2006 LITE MHPROWIDER,MNEW Completed True
880 days since p5,08/5008 LITE MHPROWYIDER, MEW Ready o sign False v
last ASI
A
MHPATIENT,ONE O000-00-Z417 AST LITE on 1Z/087Z006 by: MHPROVIDER,NEW E
**+ PEYCHOSOCIAL HISTORY *++ —
GENEPRAL INFOBRMATION
M=. Mhpatient is a 87 year old White (ot Hisp), married female N3C weteramn.
She lists her religious preference as Protestant. She was admitted to the
Consultation/Liaison program on Dec 08, Z00&. In the past 30 days, she has not
been in a controlled enviromment. She has lived at her current address for 3
years, 3 months.
Thi=z report is based on an AST Lite interwview conducted in person on Dec 08,
2006 by New Mhprowider. Ms. Mhpatient completed the interwiew.
Composite Score
MEDICAL O.0ZE2
EMPLOYMENT 0. 5356 v
Marrative Repart Itern Fieport | Item Trends | Domain Scores
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Example: Save As form.

Save i |B by Documents

IChAnnual Leave CMHASZ [ My irkual Machines
ICiCreatar [Ty eBooks &) TestBlug)
IChedipse @My Music lﬂTest Scores.bmp
I)Elementk. Classes EM}.H Pictures )
|5)Email Archive |=3My Received Files Type a new filename, or
I GAF @MY videos keep the default
e

File name: .zt Scores.bmpl
Save az twper | Bitmap files [*.brp] j Cancel
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Printing a Report, Graph, or Table

To print a graph, report, or table, click on File > Print menu item and then click on Graph,
Report/Table item. A copy of the table, report, or graph is sent directly to the default printer.

The following types of reports are available:
e Narrative Report

Item Report

Item Trends Report

Items Trends Graph

Domain Scores Report

Domain Scores Graph

Example: Printing a Report, Graph, or Table.

o Mental Health Assistant in use by MHPROVIDER ,ONE M=
FEN Edit  MWiew Tools Help
Mew A5IL., 4

. One Mhpatient
rity Index Manager SEN oocror 2412

Select Patient...

Save As... » 2wious ASI

Exit

Repork

Status

Completed

S NEW Incomplete Falze
Qz/na/z006 Completed True

Iﬁaﬁsﬂt i%ﬁ’s SINCE | 02/08/2006 LITE MHPROYIDER NEW Ready to sign False

MHPATIENT,ONE O000-00-241Z7 AZT LITE on 1E708/Z00& by: MHPROVIDER, NEW
*** PEYCHOSOCIAL HIZSTORY *** =

GENERAL INFORMATION

M=. Mhpatient is a 87 wear old White i(not Hisp), married female NSC wveteran.
She lists her religious preference as Protestant. She was adpitted to the
Consultation/liaison program on Dec 02, Z00&6. In the past 20 days, she has not
been in a controlled environment.. Zhe has liwed at her current address for 3
years, 3 months.

Thi=z report is based on an AST Lite interwiew conducted in person on Dec 08,
2006 by New Mhprowider. Ms. Mhpatient completed the interwiew.

Conposite Score
MEDICAL 0.0zzZz
EMPLOTMENT 0. 6356 i

MNarrative Report ltem Report | term Trends | Domain Scaores
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Copying a Report, Graph, or Table to the Windows Clipboard

To copy a report, graph, or table to the Windows clipboard, click on Edit > Copy menu item and
then click on Graph, Report or Table. A copy of the table, report or graph is sent to the Clipboard.
The contents of the Clipboard can then be pasted onto an MS Word or Excel document.

The following types of reports are available:

e Narrative Report

Item Report

Item Trends Report
Items Trends Graph
Domain Scores Report
Domain Scores Graph

Example: Copying a Report, Graph, or Table to the Windows Clipboard.

& Mental Health Assistant in use by MHPROVIDER ,ONE

EBX

View  Tools  Help
a One Mhpatient
3 SSM: womc-2 412
Click
New - :
Date Type Ordered By Status Signed W
12/08/2006 MHFROVIDER, MEW Completed e B
06/13/2006 LITE WMHFROVIDERMNEW Incomplete False
02/08/2006 LITE MHFROVIDER MEW Completed True
F}aastligblfs SINCE | o006 LITE MHPROVIDER,MEW Ready 1o sign False ¥
Y
MEHPATIENT,ONE O0O00-00-Z41Z ASI LITE on lz/08/2006 by: MHPROVIDER,NEW 3
*** PEYCHOSOCIAL HISTORY *** —
GENERAL INFORMATION
M=. Mhpatient is a 27 year old White (not Hisp), married female MNSC veteramn.
Bhe lists her religious preference as Protestant. 2he was adwmitted to the
Consultation/liaison program own Dec 08, Z006. In the past 30 days, she has not
been in a controlled environment. She has lived at her current addreszs for 2
wears, I months.
This report is based on an ASI Lite interview conducted in person on Dec 08,
2008 by New Mhprovider. Ms. IMhpatient completed the interwiew.
Composite Score
MEDICAL 0.022Z2
EMPLOTMENT 0.8386 h
MNarrative Report | pam Feport | ltem Trends | Domain Scores
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Example: Message displayed after copying to the clipboard.

Mental Health Assistant [z|

i ] The ASI domain scores graph has been copied ko the Windows clipboard.

If vou like, wou may paste it inko a kext docurment,
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Navigating through the Different VViews on the ASI Manager Form

To navigate, click on View > and then to any of the following menu entries:

Narrative Report
Item Report
Item Trends
Domain Scores

Example: The four tabs at the bottom of the form do the same thing.

% Mental Health Assistant in use by MHPROVIDER ,ONE =] E3]

File Edit BUEEN Tools Help
Marrative Report 0 .
. ne Mhpatient
Addict e report X Manager ST ooen2d12
Item Trends
Darnain Scares
MNegw Show Graph Labels ~
Completed B
061 3/2006 LITE MHPROWIDER, MNEW Incomplete False
02/08/2006 LITE MHPROVIDER MEW Completed True
Iﬂi@rs SINCE | noina/006 LITE MHPROWIDERNEW Ready 1o sign False ¥
Y
MHPATIENT,ONE 0QO00-00-2Z41Z2 ASZT LITE on 1lE708/2008 by: MHPROVIDER, NEW 3
*** PESTCHOSOCIAL HISTORY *** —
GENEPAL INFORMATION
M=. Mhpatient i= a 287 wear old White i(not Hisp), married female NEC weteran.
She lists her religious preference as Protestant. 5he was admitted to the
Consultation/liaison program on Dec 02, Z006. In the past 30 days, she has not
been in a controlled environment. She has liwed at her current address for 32
years, I months.
This report is based on an ABT Lite interview conducted in per - ns,
2006 by New Mhprowvider. Ms. Mhpatient completed the ijaferwview. C:Iu:k
Composite Score
MEDICAL [
EMPLOTMENT 0.5356 hd
MNarrative Repart tern Report | tem Trends | Dormain Scores
—
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Data Entry
This section of the guide illustrates the action of different types of form components such as combo

boxes, option button groups, etc. Not every instance of each type of component is shown, but the
user can learn from these examples how every component of the data entry form is to be used.

Combo Boxes

Navigation and Selection: To navigate this list with the keyboard, use the up and down keys, or type
the first few letters of program type. Using the mouse, slide the scroll bar or click on the up and
down arrows on the scroll bar. To select a program type using the keyboard, press the “tab” or
“enter”. The highlighted item is selected. Using the mouse, left click on the desired program type and
the list will disappear.
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Example: From the ASI Data Entry Form, click on the down arrow of Item G3. Program Type,

(light colored arrow above). A list of 21 ASI Program types will be displayed, eight at a time. Status

bar will have context sensitive hints.

Addiction Severity Index

File Tools Help

General Information

G3. Program Tpe: |

Early InterventionfEducation/R eferral
Detoxification Services
|7 Amhulatory except Opioid Substitution
Dpinid Substitution
Inpatient Acute Care
Substance Abuse Residential Rehahilitation Treatrment Program

G11. Interviewer :

G11a. Ordered By :

G12. Special:
|_ 1. Patient terminated |_ 3. Patient unahble to respond
[T 2 Patient refused V' M. Interview completed

*314. How long have you lived atthis address? Years: jl Maonths: il

B Dt o Al feaian Consultation/Liaison i‘

Compensated Work TherapyTransitional Residence ﬂ

[ 2. Black (not Hispanic)
|_ 3. American Indian

G18. Relinious Preference
|_ 1. Protestant

[ 2. catholic
<

G145 |5 this residence owned by yau aryour family?

[T 5. Asian or Pacific Islander [ 8.

|_ 6. Hispanic - Mexican

[ 3. Jewish

[ 4. 1slamic

[a

[
[e.

|_ 0. Mo |_ 1.%es |_ H. Mot Answered
G17. Race
|_ 1. White (not Hispanic) |_ 4. Alaskan Mative |_ T. Hispanic - Puetto Rican

Hispanic - Cuban
Other Hispanic

Cther
Mane

s

o

General Comments:

G General Info | wadical | E Employiment QDrugIAIcnhnI] LLegaI] H Family H}{I Fﬁcu:iall B Psychia 4 | p

Click an dovwn arrowe for list of programs. F1 far help.
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Date Fields

Navigation and Selection: To navigate this calendar using the keyboard, press the left and right keys
to change days and shift-left and shift-right to change months. Pressing the "home" key moves to the
1% day of the month. Press the "tab" or "enter" key to select the date and close the calendar. Clicking
the mouse on a day will select the day and close the calendar. Clicking on the left and right arrows
will change the month.
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Use of the Software

Example: From the ASI Data Entry Form, click on the down arrow of Item G4. Date of Admission.

A calendar is displayed. The status bar will update its hint.

Addiction Severity Index

File Tools Help

General Information

G3. Program Type: |InpatientAcute Care

G4, Date of Admission:| 3102005 - 5. Date of Interyiew:

|7 1.ln person |_ 2. Phone

312, Special: 20 2 22023 24 25 U6

|_1.F'atientterm 2
[T 2 Patient refus

|

March, 2005 [ » | 8. Contact Type:
s
I_ Sun Mon e WWed Thu Fri Sat
G11. Interviewer : [ 1 2 2 4 5 j

B 7 3 9 @11 12
G11a. Ordered By : [13 14 15 16 17 18 14 :|’

Fatient unahle to respond
. Imtervienwy completed

= aToday: 3/10/2005

*G14. How lang hawe you lived atthis address? Years: | jl Manths: lijl
G148, |5 this residence owned by yau aryour family’?

|_ 0. Mo |_ 1.%es |_ H. Mot Answered
G17. Race

|_ 1. White (not Hispanic) |_ 4. Alaskan Mative |_ T. Hispanic - Puetto Rican

[T 2. Black (not Hispanic) [T 5. asian or Pacific Islander [ 8. Hispanic - Cuban

|_ 3. American Indian |_ 6. Hispanic - Mexican |_ 4. Other Hispanic
G18. Religious Preferance

[T 1. Protestant [7] 3. Jewish [T 5 other

[T 2. catholic [ 4. 1slamic [T 6. Mone

Mo2ins -

j =1

o

General Comments:

G General Info | 1 medical | E Employment QDrug!AIcnhnI] LLegaI] H Family H}{I Fﬁcu:iall E Psychia 4 | »

llze down arrow to see calender. Do not use future dates. F1 for help.
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Example: The date can be typed directly in the edit box. The following formats are accepted:
4/14/2001, 4-14-01, 4.14.01, and 4,14,2001. Notice that the year can be entered as last two digits or
four digits. Acceptable delimiters are the backslash, period, comma and dash. Dates in the future are
not accepted.

Addiction Severity Index

File Tools Help

General Information

G3. Program Type: |Inpatient Acute Care j =]

G4, Date of Admission: Eﬂ 02005 - <+——— 5. Date of Interiew: anorz00s -

GY9. Caontact Type:

v I_ I_ M 1. inperson [ 2. Phone
11, Interdewer ; |Iu1hprwider1,0ne j
G11a. Ordered By:  |Mhprovider!, One -
312. Special:

|_ 1. Patient terminated |_ 3. Patient unahble to respond

|_ 2. Patient refused |7 M. Interview completed

*314. How long have you lived atthis address? Years: jl Maonths: i‘

314 15 this residence owned by yau aryour family?

[T o.nNo [ 1.ves [ Mot Answered
G17. Race
|_ 1. White (not Hispanic) |_ 4. Alaskan Mative |_ ¥. Hispanic - Puetto Rican b
|_ 2. Black {not Hizpanic) |_ A, Asian ar Pacific Islander |_ 2. Hispanic - Cuban
|_ 3. American Indian |_ B. Hizpanic - Mexican |_ 9. Other Hispanic
318, Religious Preference
[T 1. Protestant [T 3. Jewish [T 5 other
[T 2 cathalic [T 4 1stamic [T & Mone f
‘| | B

General Comments:

G General Infd | y piadical | E Employment | D Drugiélcohol I I:Legalj H Family H}{I Fﬁncial] E Psychia 4 | p
Uze doven arrow to see calender. Do naot use future dates. F1 far help.
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Use of the Software

Option Button Groups

Press the keys "1", "2", or "3" and the appropriate box will be checked and the user will be taken to

the next item. While mouse input is effective, experienced users find keyboard entry to be quicker

and easier. If an incorrect key is pressed, an error message will appear.

Example: From the ASI Data Entry Form, click on one of the boxes in item, G17. By clicking on a

box or its text a check will appear in that box and other checks will be removed from other boxes.

Addiction Severity Index

File Tools Help

General Information

G3. Program Type: |InpatientAcute Care

G4, Caontact Type:

*314. How long have you lived atthis address? Years: jl Maonths: il

G145 |5 this residence owned by yau aryour family?

|_ 0. Mo / |_ 1.%es |_ #. Mot Answered
G17. Race

when race is unknown, leave question blank|

G18. Relinious Preference
[T 1. Protestant [ 3. Jewish [T 5 other

[T 2 catholic [T 4 1stamic [T & Mone
<

G4, Date of Admission:| 21072005 - 5. Date of Interyiew: Mor200s -

M~ I_ I_ M 1. inperson [ 2 Phone
G11. Interdewer : |ru1hprwider1 Ore j
G11a. Ordered By:  |Mhprovider!,One -
G12. Special:

|_ 1. Patient terminated |_ 3. Patient unahble to respond

V| 2. Patient refused [ M. Interview completed

|_ 1. White (not Hispanic) |_ 4. Alaskan Mative |_ T. Hispanic - Puetto Rican
[T 2. Black (not Hispanic) V' 5. Asian or Pacific Islander [ 8. Hispanic - Cuban
|_ 3. American Indian |_ B. Hizpanic - Mexican |_ 9. Gther Hispanic

j =1

o

General Comments:

G General Info | pedical | E Employment QDrugIAIthDII I:Legalj H Family H}{I Fﬁucial] E Psychia 4 | »

When race is unknown, leave question blank
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Spin Edit

Type the number of years

an acceptable number is from 0 to 99—and then press either the "tab" or

"entry" key. The "Months:" will then become the active item and will be highlighted. If an incorrect

number is entered, an error message will appear.

Example: From the ASI Data Entry Form, type in the year and press tab or enter keys. The next item

will then be highlighted, ready for input.

Addiction Severity Index

File Tools Help

General Information

G3. Program Type: |Inpatient Acute Care

GY. Caontact Type:

v I_ I_ M 1. inperson [ 2. Phone
G117, Interdewer ; |Iu1hprwider1,0ne j
G11a. Ordered By:  |Mhprovider!, One -
312. Special:

|_ 1. Patient terminated |_ 3. Patient unahble to respond

[ 2 Patient refused M M interview completed

»71514. Howe long have you Iived at this address? Years: | jl Maonths: i‘

314 15 this residence owned by yau aryour family?

[T o.nNo [ 1.ves [ Mot Answered
G17. Race
|_ 1. White (not Hispanic) |_ 4. Alaskan Mative |_ ¥. Hispanic - Puetto Rican
[ 2 Black inot Hispanic) [T 5 Asian or Pacific Islander [ 8. Hispanic - Cuban
|_ 3. American Indian |_ B. Hizpanic - Mexican |_ 9. Other Hispanic
318, Religious Preference
[T 1. Protestant [T 3. Jewish [T 5 other
[T 2 cathalic [IEREEL [T & Mone

Jdl

G4, Date of Admission:| 31072005 - 5. Date of Interiew: anorz00s -

j =l

o

General Comments:

G General Infd | y piadical | E Employment | D Drugiélcohol I I:Legalj H Family H}{I Fﬁncial] E Psychia 4 | p

Enter nurmber with keyboard, or Up _Dowen arrowes, or mouse click on arrowes. F1 for help.
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The spin-edit field can be increased by one when the up arrow receives a mouse click, or when the
up-arrow key is pressed. To decrease the value, click on the down arrow or press the down arrow
key. A number will not increase beyond the limit of the acceptable range. To move to the next item,
press the "tab™ or "enter” key.

Example: From the ASI Data Entry Form, click on the up or down arrows of the spin-edit field of
G14. The number in the spin-edit box will increase or decrease by one.

Addiction Severity Index

File Tools Help

General Information

3. Prograrn Type: |Inpatien1 Acute Care - =

Gd_ Date of Admission:| 2102005 Ga. Date of [ntervigw: aoizots -

9. Contact Type:

IF |_ |_ |7 1.0 person |_ 2. Phone
311, Interviewer ; |Mhprnvider1,0ne j
G11a. Ordered By:  |Mhprovidert,One -
G12. Special:
[ 1. Patient terminated [T 3. Patient unable to respond
|_ 2. Patient refused |7 M. Interview completed
*314. How long have you lived at this address? Years: B jl mMonths: j‘
314. 15 this residence owned by you or your family?
[ omo [ 1. ves [ Mot Answered
G17. Race
[T 1. white (not Hispanic) [T 4. alaskan Mative [T 7. Hispanic - Puertn Rican o
|_ 2. Black {not Hispanic) |_ A Asian ar Pacific [slander |_ 3. Hispanic - Cuban
[ 3. American Indian [ B Hispanic - Mexican [ 9. other Hispanic
318. Religious Preference
[T 1. Protestant [T 3. Jewish [T 5 other
[T 2 catholic [ 4. 1slamic [T 6. Mone f
4| | E

General Comments:

G General Info | w padical | E Employment | D Drugilcohol I LLegaI] H Farmily H}{I Fﬁn:u:ial] E Psvchia 4| »
Enter nurmber with keyhoard, or Up _Down arrowes, of mouse click on arrows. F1 for help.
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Use of the Software

Item G12
From the ASI Data Entry Form, click on
1. Patient Terminated or
2. Patient Refused or
3. Patient unable to respond” on Item G12.

A dialog-message will appear indicating that default values will not be set for the user.

Mental Health Assistant E|

i The many default answers provided on this Farm will not be honored when an A31 is only partially
. ) completed, Only the items that wou actually answer will be saved,
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Item G19

The edit box is active only when item G19 has response "6. Other (Specify)" checked. Otherwise the
edit box is disabled (user cannot write to it).

Example: From the ASI Data Entry Form, click on 6. Other (Specify) on Item G19. The edit box
below will become active.

Addiction Severity Index

File Tools Help

General Information

312. Special: J
[ 1. Patient terrminated [T 3. Patient unable to respond
|_ 2. Patient refused |7 M. Interview completed

*314. How long have you lived atthis address? Years: jl Maonths: i‘

314 15 this residence owned by yau aryour family?

[T o.nNo [ 1.ves [ % Mot Answered
G17. Race
[ 1. white (not Hispanic) [T 4. Alaskan Mative [ 7. Hispanic - Puerto Rican
|_ 2. Black {not Hizpanic) |_ A, Asian ar Pacific Islander |_ 2. Hispanic - Cuban
|_ 3. American Indian |_ B. Hizpanic - Mexican |_ 9. Other Hispanic
318, Religious Preference
[T 1. Protestant [T 3. Jewish [T 5 other
[T 2 cathalic [T 4 1stamic [T & Mone
*319. Have you been in a controlled environment in the past 30 days?
[T 1. Mo [T 4. Medical Treatment [T rotAngwered
[T 2 Jail [T 5 Psychiatric Treatrnent [ M. not Applicable
[ 3. Alcohol or Drug Treatment W 6. Other (specify)
320 Howe many days? [0 = | A

|
1 | B

General Comments:

G General Info | 1 tedical | E Employment | D Drugiélcohol I LLEgaI] H Family H}{I Fﬁnciall E Psychia 4 | »
A place, theoretically, without access to drugs or alcohol. F1 for help.
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By clicking on “1. No” the edit box becomes disabled as does item G20. Item G20 will have a

response of “N.” This will also occur with “X. Not Answered”” and “N. Not Applicable.”

From the ASI Data Entry Form on Item G19, click on
1. Noor
X. Not Answered or

Example: The edit box below will, if active, will become inactive and G20 will also become inactive

with a value of “N”.

Addiction Severity Index

File Tools Help

General Information

T = ﬂ
512, Special:

|_ 1. Patient terminated |_ 3. Patient unahble to respond

[ 2. Patient refused M M. interview completed

*314. How lang have you lived at this address? Years: il Maonths: i‘

314 |5 this residence owned by you ar your family?

|_ 0. Mo |_ 1.%es |_ H. Mot Answered
G17. Race
|_ 1. Wyhite (not Hispanic) |_ 4. Alaskan Mative |_ ¥. Hispanic - Puerto Rican
[T 2. Black (not Hispanic) [T 5 Asian or Pacific Islander [ 8. Hispanic - Cuban
|_ 3. American Indian |_ 6. Hizpanic - Mexican |_ 9. Other Hispanic
518 Religious Preferance
[ 1. Protestant [T 3 Jewish [T 5 other
[T 2. catholic [ 4. 1slamic [T 6. Mone
*319. Have you been in a contralled enviranment in the past 30 days?
> |7§1.N|:| { 4 Medical Treatment |_ H. Mot Answered
[ 2. Jail [T & Poychiatric Treatrnent [ M. Mot Applicable

|_ 3. Alcahol or Drug Treatmentl_ 6. Other (specifil

| i
4| |_"ﬁ

General Comments:

G General Info | w pedical | E Employment | D Drugi®lcohol I IzLegaI] H Farmily H}{I Fﬂncial] B FPsvchia 4| »

& place, theoretically, without access to drugs or alcohal. F1 for help.

October 2010 MHAS3 User Manual
Patch YS*5.01*96

169



Use of the Software

Medical Tab
The Medical Status page has a unique color on its title bar.

Example: From the ASI Data Entry Form, click on the tab, Medical. The form will move to the
Medical Status page.

Addiction Severity Index

File Tools Help

Medical Status

*M1. How many times in your life have you heen hospitalized for medical problems O for neven? ili

M2, How long agao was vour last hospitalization for a physical problem? Years: il honths: il
*M3. Do you have any chranic medical problems which cantinue ta interfere with yaur life?
|_ 0. Mo |_ 1.%es (specify) |_ . Mot Answered

*M4. Are you taking any prescribed medication on a regular basis far a physical problem?

|_ 0. Mo |_ 1.%es |_ H. Mot Answered
*ma. Do you receive a pension for a physical disahbility?  (Exclude psychiatric disahility)
|_ 0. Mo |_ 1.%es (specifi) |_ H. Mot Answered
*MG. How many days have you experienced medical problems in the past 307 il
*M7. How trouhled or hothered have you been by these medical problems in the past 30 days?
[T o motatan [T 2. Moderately [T 4 Extremely
[T 1. Slightly [T 3. considerably [ % Mot Answered b
*M3. How impoartant to you novw is treatment for these medical problems?
[T 0 mMotatal [T 2. Moderately [T 4. Extremely
[T 1. slightly [ 2 considerably [ % Mot Answered
Ma. Interviewar: How wiould you rate the patient's need far medical treatment?
™ . .. I~ ™ . .. .. _— — . - _— ™ . - . x
1| | »

Medical Status Comments:
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Item M1

If the patient has never been hospitalized in their life, it follows that their last hospitalization queried
in M2 is not applicable.

Example: From the ASI Data Entry Form, type an “N” (case insensitive) in the spin-edit field for
M1. The spin-edit fields for M2 will be changed to “N” and will become inactive.

Addiction Severity Index

File Tools Help
Medical Status
*M1. How many times inyour life have you been hospitalized for medical prohlems K" for never}?N ili
M2. How long ago was your last hospitalization for a physical problem? Years: :l Manths: :l
*13. Do yvou have any chronic medical problems which cantinue ta interfere with yaur life?
[T o.M [T 1. ves specif) [ % Mot Answered
*14. Are you taking any prescribed medication on a regular hasis for a physical prablem?
|_ 0. Mo |_ 1.%es |_ H. Mot Answered
*ma. Do you receive a pension far a physical disability?  (Exclude psyehiatric disahbility)
|_ 0. Mo |_ 1.%es (specify |_ H. Mot Answered
*MG. How many days have you experienced medical problems in the past 307 il
*M7. How trouhled or bothered have you been by these medical problems in the past 30 days?
[ 0.Motatal [T 2 Moderately [T 4. Extremely
[ 1. Slightly [T 3 considerably [ % Not Answered e
*M3. How impoartant to you now is treatment for these medical problems?
[T 0.mMotatal [T 2 Moderately [T 4. Extremely
[ 1. Slightly [T 2 considerably [ | % Mot Answered
Ma. Interviewar: How would you rate the patient's need far medical treatment?
™ - .. I~ ™ . .. .. _— m— . - _— ™ . - . _— x
4| | B
Medical Status Camments:
G General Info M Medical | E Epmployment QDrugIAIcnhnI] LLegaI] H Family H}{I Fﬁcu:iall E Psychia 4 | »
Include O.0's, D T.'s. Exclude detox, alcoholfdrug and psychiatric treatment and childhirth (it without
camplications). F1 far help.
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Medical Status Comments

The medical status Comments field is an edit field that accepts free text.

Example: From the ASI Data Entry Form, type comments in Medical Status Comments field. The
memo field will accept free text.

Addiction Severity Index

File Tools Help

Medical Status

*M1. How many tirmes in your life have you been hospitalized for medical prokblems N for never) 2N ili

M2, How long agao was vour last hospitalization for a physical problem? Years: :l honths: :l
*M3. Do you have any chranic medical problems which cantinue ta interfere with yaur life?
|_ 0. Mo |_ 1.%es (specify) |7 . Mot Answered

*M4. Are you taking any prescribed medication on a regular basis far a physical problem?

|_ 0. Mo |_ 1.%es |_ H. Mot Answered
*ma. Do you receive a pension for a physical disahbility?  (Exclude psychiatric disahility)
|_ 0. Mo |_ 1.%es (specifi) |_ H. Mot Answered
*MG. How many days have you experienced medical problems in the past 307 il
*M7. How trouhled or hothered have you been by these medical problems in the past 30 days?
[T o motatan [T 2. Moderately [T 4 Extremely
[T 1. Slightly [T 3. considerably [ % Mot Answered b
*M3. How impoartant to you novw is treatment for these medical problems?
[T 0 mMotatal [T 2. Moderately [T 4. Extremely
[T 1. slightly [ 2 considerably [ % Mot Answered
Ma. Interviewar: How wiould you rate the patient's need far medical treatment?
™ . .. o ™ - .. .. I — . - I ™ . - . x
1| | »

Medical Status Comments: This is an example of medical status comments  —m——oo—

G Genaral Infio M Medical | £ Employment | D Drugiélcohol I LLegaI] H Family H}{I Fﬁnciall E Psychia 4 | »
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Ending an ASI Data-entry Session

Example: To end an ASI session, click on the File > Exit menu option on the ASI data-entry form to
invoke the Close ASI form. The Close ASI form is displayed

Addiction Severity Index

ZEN Tools  Help

Exit.
G3. Program T'g.-'F.I'E-_.

G4, Date nfﬁdmissiun:| AN 4rz00s - 55,
4.
V I I

G11. Interviewer |Mhprwider1,@ne

G11a Ordered By:  |Mhprovider!,One
12, Special:

Example: ASI Close form.

Addiction Severity Index

Close

[ Eieturn to AS| J

[ Exit |

’ Einish later ]

’ Sawve and Sign ]

Cinly the intepdewer (MHEREOWIDER, OME) may sicl
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Closing ASI Data-entry Session with “Exit, lgnore Changes this session’ option.

Example: To exit a session, ignoring all changes made, click on Exit, then in the next dialog box,
select YES.

Addiction Severity Index

Close

[ Eeturn to AS J

Exit * |

Einigh later ]

|
|
’ Sawve and Sign ]

Only the interdiewer (MHPEROVIDER, OME) may sicn

Example: Message box warning that ASI hasn’t been saved.

Confirm [‘5_(|

Are wau sure yau wank ko exit this 851 withouk saving?

Y

[ ies/ ’ Mo ]
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Closing ASI data-entry session with “Finish Later” option

Example: To finish a session “later”, click on Finish Later option on the Close ASI form. Work in
progress is saved and the data-entry form is closed. No messages are displayed. The ASI is listed on
the ASI Manager form as an incomplete ASI.

Addiction Severity Index

Close

[ Eeturn to AS| J

Exit |

Einish later ‘(l

|
|
’ Sawve and Sign ]

Oy the intervaewer (MHPROWIDER, QMNE) masy sicl
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Closing ASI data-entry session with “Save and sign”

Example: To save and sign an ASI, click on Save and sign option on the Close ASI form.

Addiction Severity Index

Close

[ Eeturn to AS J

[ Exit |

’ Einigh later /
Sawve and Sign

1 Only the interdiewer (MHPEROVIDER, OME) may sicn

Example: Electronic signature form contains the option to sign ASI.

Electronic Signature

=ign the Addiction Sewverity Index

Signature Code

(08 ] ’ Cancel
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Example: Option to save a progress note.

Mental Health Assistant b__<|

\i:) Wiould you like to save a narrative progress noke Faor this A5T7
-
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Business Rules

Business rules check to see whether pairs of responses are logically consistent. The table below lists
all of these rules and their actions.

Item #'s Coding Error Cross Check Message Yes/No Cursor movement
OK

Gl19and [G19>1, and In the last question (G19), you recorded that the patient has been in a OK Pop-up after G20 is

G20 G20=0,00, or N | controlled environment in the past 30 days, this question, (G20) how entered. Cursor
many days, should be greater than 0. doesn't move.

Gl19and [G19=4, and You recorded in the general information section (G19), that the Yes/No | Pop-up after M1 is

M1 M1=0, 00, N. patient had been hospitalized for medical problems in the past 30 entered. If ""Yes",
days. This hospitalization would usually be coded in this question. the cursor doesn't
Do you want to recode M1? move. If "No",

cursor moves to M3.

Gl19and ([G19=4and M2 |Inthe general information section (G19), you recorded that the Yes/No | After M2 is entered.

M2 years or months | patient had been hospitalized this month for medical problems. If ""Yes", the cursor

>0, 00, or N. The correct coding in M2 is usually 00 00 in this case. Do you doesn't move. If
want to recode M2? ""No", cursor moves
to M3.

M6 and M6>0, and In the last question, you recorded that the patient experienced Yes/No | After M7 is entered.

M7 M7=0. some medical problems in the past 30 days. If this were true, then If ""Yes", the cursor
we would expect that the patient would be at least slightly doesn't move. If
bothered by these problems. Do you want to recode M7? ""No", cursor moves

to M8.

M6, M7 M6=0 or 00, and [ In question M6, you recorded that the patient experienced no OK After M8 is entered.

and M8 M7 or M8>0. medical problems in the past 30 days, since they report being Cursor moves back to
troubled or wanting treatment (M7 or M8), it is fair to expect that M6.
they had some problem days. Go back to M6 and identify the
number of days the problem has bothered them.

Ela Ela<4 You are reporting that the patient has had less than 4 years of Yes/No | Pop-up after E1b is
education, this is rare. Please review this, did you include home entered. If ""Yes",
schooling, grade school, etc.? Do you want to change E1? the cursor moves to

Ela. If "*No", cursor
moves to E2.

E4 and E5 |E4=0and E5=1 | If the client does not have a driver's license, E5 is always coded as OK Pop-up after E5 is
"No". This is because E5 asks about the car as a way of evaluating entered.
ability to travel to and from a job. If the client does not have a This is a forced
license, they cannot "get credit" for having a car! The computer change — there is not
has made this change for you. an option to leave

E5=1 if E4=0.

E8 and E9 |E8=0and E9=1 | In the last question (E8), you said no one contributes to the client's Yes/No | Pop-up after E9 is
support, and in this question, you are saying the client gets most of entered. If ""Yes", the
his or her support from someone. Do you want to change your cursor moves to E8.
answer in E8? If ""No"", cursor

moves to E10.
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Item #'s Coding Error Cross Check Message Yes/No Cursor movement
OK
E11 and E11=0 or 00 and | In the last question (E11), you recorded that the patient was not Yes/No | Pop-up after E12 is
E12 E12>0 paid for working at all in the past month. If this is the case, E12 is entered. If ""Yes",
generally $ 0. Do you want to change E11? the cursor moves to
E11. If "No", cursor
moves to E13.
E11>0 and In the last question (E11), you recorded that the patient was paid Yes/No | Pop-up after E12 is
E12=0, 00, 000, [ for working this month. If this is the case, E12 is generally not $ entered. If ""Yes",
or 0000 0, unless the patient has collected no money for their work. Do you the cursor doesn’t
want to change E12? move. If ""No",
cursor moves to E13.
E15 and E15=0, 00, 000, | You recorded earlier (M5), that the patient receives a pension for a Yes/No | Pop-up after E15 is
M5 0000, or 00000 | medical problem. This income is generally recorded in E15 unless entered. If ""Yes", the
and M5=1 they did not receive any cash this month. Do you want to change cursor doesn’t move.
E15? If "No", cursor
moves to E16.
E19 and E19>0 and In E19, you recorded that the patient experienced some Yes/No | Pop-up after E20 is
E20 E20=0 employment problems in the past 30 days. If this were true, then entered. If "Yes",
we would expect that the patient would be at least slightly the cursor doesn’t
bothered by these problems. Do you want to recode E20? move. If ""No",
cursor moves to E21.
Dlaand |D2a>Dla You recorded that the patient drank "to intoxication" (D2) more OK After D2a is entered.
D2a days than total number of days drinking any alcohol at all (D1). Cursor moves to
Probe and recode D1. Remember D2 is a sub-set of D1. Dla.
Dlband |D2b>D1b You recorded that the patient drank "to intoxication" (D2) more Ok After D2b is entered.
D2b years than total number of years drinking any alcohol at all (D1). Cursor moves to
Probe and recode D1. Remember D2 is a sub-set of D1. D1b.
D1-D12 G20>0 and any | You recorded in the general information section that the patient Yes/No | Pop-up after D12a is
and G20 |item Dla- had been in a controlled environment in the past month, yet they entered. If "Yes",
D12a=30 used either drugs or alcohol every day. Please review this. Do the cursor moves to
you want to change any information in the drug/alcohol grid? Dla. If "No", cursor
moves to D12b.
D14 and |D14=3-12or 16 |You report that the patient's problem does not include alcohol, Yes/No | Pop-up after D14 is
D1-D12 and D1a>15 however, the patient used alcohol at least 15 days in the past entered. If ""Yes",
month. Please review this and consider option "Alcohol and one the cursor does not
or more drugs" for question D14. Do you want to change D14? move. If "No",
cursor moves to D15.
D16and |D16=0or00and |You recorded that the patient is "still sober", however, drug or Yes/No | Pop-up after D16 is
Dla-D12a | Dla-D12a>0 alcohol use in the past 30 days is documented in the drug and entered. If "Yes",
alcohol grid. Please review this. Do you want to change D16? the cursor does not
move. If ""No",
cursor moves to D17.
D17 D17>5 You recorded more than 5 episodes of DT's for this patient. This Yes/No | Pop-up after D17 is
is extremely rare, please review the definition of DT's if you are entered. If ""Yes",
unsure. Do you want to change it? the cursor does not
move. If *No",
cursor moves to D18.
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Item #'s Coding Error Cross Check Message Yes/No Cursor movement
OK
D19and |D19=0o0r00and | You recorded that the patient never had any treatments for alcohol Yes/No | Pop-up after D21 is
D21 D21>00 abuse, so # of detox treatments is not applicable. Do you want to entered. If ""Yes",
recode (D19), the total number of treatments received? the cursor moves to
D19. If ""No", cursor
moves to D23.
D19and |D19>0, and You recorded that the patient had more detox treatments than the Yes/No | Pop-up after D21 is
D21 D21>D19 total number of treatments received for alcohol abuse. Remember entered. If ""Yes",
D21 is a sub-set of D19. Do you want to recode D19? the cursor moves to
D19. If "No™, cursor
moves to D23.
D20and |D20>0, and You recorded that the patient had more detox treatments that the Yes/No | Pop-up after D22 is
D22 D22>D20 total number of treatments received for drug abuse. Remember entered. If ""Yes",
D22 is a sub-set of D20. Do you want to recode D20? the cursor moves to
D20. If ""No", cursor
moves to D24.
D20and | D20=0or 00 and |You recorded that the patient never had any treatments for drug Yes/No | Pop-up after D22 is
D22 D22>00 abuse, so # of detox treatments is not applicable. Do you want to entered. If "Yes",
recode (D20), the total number of treatments received? the cursor moves to
D20. If "*No", cursor
moves to D24.
Dlaand |Dla=0or00and [You recorded no days of drinking in the past 30, but recorded the Yes/No | Pop-up after D23 is
D23 D23>0 client has spent money on alcohol. This is unlikely. Please review. entered. If "Yes",
Do you want to change D23? the cursor does not
move. If *No",
cursor moves to D20.
D1la, D2a, |Dla+D2a>0and |You recorded the client's drinking in the past 30 days (D1 and D2), [ Yes/No |Pop-up after D23 is
andD23 D23=0, 00, 000, |[but no money spent on alcohol. Please review this, do you want to entered. If "Yes",
0000, or 00000 | change D23? the cursor does not
move. If "No",
cursor moves to D20.
D3a-D12a, | All items D3a You recorded zero days of drug use in the past 30, but the patient Yes/No | Pop-up after D24 is
and D24  [through D12a = 0 | acknowledges spending money on drugs this month. Please entered. If "Yes",
or 00 and D24 >0 | review, and coded those drugs used in the past 30 days. Do you the cursor moves to
want to change # of days of drug use in the drug grid? D3a. If ""No", cursor
moves to D25.
D3a-D12a, | Any item D3a- You recorded days of drug use in the past 30 days, but no money Yes/No | Pop-up after D24 is
andD24 D12a>0 and spent on drugs, please review this. Do you want to change D24? entered. If "Yes",
D24=0, 00, 000, the cursor does not
0000, or 00000. move. If "No",
cursor moves to D25.
D26, D28, | D26>0 and D28 | In an earlier question (D26), you recorded that the patient had Yes/No | Pop-up after D30 is
and D30 | and/or D30=0 experienced some days with alcohol problems in the past 30 days. entered. If ""Yes",
If this is true, then we would expect the patient would be at least the cursor moves to
slightly bothered or slightly in need of treatment for these D28. If "*No", cursor
problems. Do you want to change your code on D28 and/or D30? moves to D27.
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Item #'s Coding Error Cross Check Message Yes/No Cursor movement
OK
D26, D28, | D26=0 or 00 and | In an earlier question (D26), you recorded that the patient had no OK Pop-up after D30 is
and D30 | D28 or D30>0. |alcohol problems in the past 30 days. Since they report being entered. Cursor
troubled or wanting treatment, it is fair to expect that they had moves to D26.
some problem days. Go back to D26 and identify the number of
days the problem has bothered them.
D27, D29, | D27>0 and D29 | In an earlier question (D27), you recorded that the patient had Yes/No | Pop-up after D31 is
and D31 |and/or D31=0 experienced some days with drug problems in the past 30 days. If entered. If ""Yes",
this is true, then we would expect the patient would be at least the cursor moves to
slightly bothered or slightly in need of treatment for these D29. If ""No", cursor
problems. Do you want to change your code on D2 and/or D31? moves to D32.
D27, D29, | D27=0and D29 | In an earlier question (D27), you recorded that the patient had no OK Pop-up after D31 is
and D31 | or D31>0. problems with drugs in the past 30 days. Since they report being entered. Cursor
troubled or wanting treatment, it is fair to expect that they had moves to D27.
some problem days. Go back to D27 and identify the number of
days the problem has bothered them.
L3-L16 L3 through L16 | You recorded the patient had more convictions than the total Yes/No | Pop-up after L17 is
and L17 |total > L17 number of times they were arrested and charged (L3 to L16). This entered. If "Yes",
is unusual. Do you want to change L17? the cursor does not
move. If "No",
cursor moves to L18.
L2 and L2=1and all L3- |In an earlier question (L2), you indicated the patient is on Yes/No | Pop-up after L20 is
L3-L16, |L16andL18- probation or parole. However, no arrests or charges are entered. If "Yes",
L18-L20. |L20=0 or 00. documented in items L3-L20. Do you want to recode any legal the cursor moves to
charges? L3. If ""No", cursor
moves to L21.
L24 and L24=1,and L3- |You recorded the patient is awaiting charges, trial or sentence Yes/No | Pop-up after L24 is
L3-L16, L16 and L18- (L24), but no arrests and/or charges are coded in L3-L16 or L18- entered. If "Yes",
L18-L20 |L20=0 or 00 L20. Do you want to recode any of the charges? the cursor moves to
L3. If "No", cursor
moves to L25.
L24 and L24=0, and You recorded the patient was not awaiting charges, trial or Yes/No | Pop-up after L25 is
L25 L25>0 sentence (L24), yet you coded a charge in L25 (which would be entered. If "Yes",
not applicable). Do you want to recode L24? the cursor moves to
L24. If "No", cursor
moves to L26.
L26 and G19=2 and In the general information section, you recorded that the patient Yes/No | Pop-up after L26 is
G19 L26=0 or 00 had been in jail in the past 30 days, this is usually also represented entered. If ""Yes",
in L26. Do you want to change your code on L26? the cursor does not
move. If “*No",
cursor moves to L27.
L27 and E17>0 and In the employment section, you recorded that the patient had Yes/No | Pop-up after L27 is
E17 L27=00 illegal income in the past 30 days, this is usually also documented entered. If ""Yes",
in L27. Do you want to change your code on L27? the cursor does not
move. If ""No",
cursor moves to L28.
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Item #'s Coding Error Cross Check Message Yes/No Cursor movement
OK
F30, F32, |F30>0and F32 | Inan earlier question (F30), you recorded that the patient had Yes/No | Pop-up after F34 is
and F34 and/or F34=0 some family conflicts in the past 30 days. If this is true, then we entered. If ""Yes",
would expect that the patient would be at least slightly bothered or the cursor moves to
slightly in need of treatment. Do you want to recode F32 or F34? F32. If "No"", cursor
moves to F31.
F30, F32, |F30=0o0r00and |[Inan earlier question (F30), you recorded that the patient had no Yes/No | Pop-up after F34 is
and F34 F32 and/or family conflicts in the past 30 days. Since they report being entered. Cursor
F34>0. troubled or wanting treatment, it is fair to expect that they had moves to F30.
some problem days. Do you want to go back to F30 and identify
the number of days the problem has bothered them?
F31, F33, |F31>0and F33 [In an earlier question (F31), you recorded that the patient had Yes/No | Pop-up after F35 is
and F35 and/or F35=0 some conflicts with others in the past 30 days. If this is true, then entered. If "Yes",
we would expect that the patient would be at least slightly the cursor moves to
bothered or slightly in need of treatment for this recent problem. F33. If ""No", cursor
Do you want to recode F33 or F35? moves to F36.
F31, F33, |F31=0and F33 or | In an earlier question (F31), you recorded that the patient had no Yes/No | Pop-up after F35 is
and F35 F35>0. conflicts with others in the past 30 days. Since they report being entered. Cursor
troubled or wanting treatment, it is fair to expect that they had moves to F31.
some problem days. Do you want to go back to F31 and identify
the number of days the problem has bothered them?
P1, P2 and |P1+ P2=00r 00 |You recorded that the patient has not had inpatient or outpatient Yes/No | Pop-up after P10a
P10a/b and P10aorb treatment for psychiatric problems (P1 and P2), yet they have and b are entered. If
(past 30 days or | attempted suicide. Please review treatment they may have "Yes", the cursor
lifetime)=1 received for the suicide attempt. Do you want to recode P1 or P2? moves to P1. If
""No", cursor moves
to P11a.
P1,P2and [P1+ P2=00r00 |You recorded that the patient has not had inpatient or outpatient Yes/No |Pop-up after P11a
P1la/b and P1laorb treatment for psychiatric problems (P1 and P2), yet they have been and b are entered. If
(past 30 days or | prescribed medications for psychiatric problems. Please review ""Yes", the cursor
lifetime)=1 treatment they may have received. Do you want to recode P1 or moves to P1. If
p2? "No", cursor moves
to P12.
P3 and E15=0, 00, 000, [ You recorded that the patient receives a pension for a psychiatric OK Pop-up after P3 is
E15 0000, or 0000 problem (P3). Unless they did not receive any cash this month, this entered.
and P3=1 income is generally recorded in the employment question about Cursor doesn’t move.
pension money received (E15). Go back and change E15 in the
Employment section.
P4a-P10a |[P4a through You report that the patient has had problems in the past 30 days, Yes/No | Pop-up after P12 is
and P12 P10a=0 or 00, but none are recorded in the psychiatric symptom list P4 through entered. If ""Yes",
and P12>0 P10. Please review P4 through P10, do you want to go back and the cursor moves to
change the code of any of the symptoms? P4. If ""No", cursor
moves to P13.
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Item #'s Coding Error Cross Check Message Yes/No Cursor movement
OK
P4a-P10a |[P4a through You report that the patient has had no problems in the past 30 OK Pop-up after P12 is
and P12 P10a>0 and days, but problems are evident from the psychiatric symptom list entered. Cursor does
P12=0 P4 through P10, please probe about the number of days these not move.
symptoms bothered the client and recode P12.
P9a and P9a and/or You report that the client has said they have either suicidal OK After P10a is entered.
P10a P10a=1 ideation or have attempted suicide in the past 30 days. Probe Cursor moves to
further for a plan for the suicide and/or dates of the suicide P10b.
attempt. Notify your supervisor of these responses.
P12, P13, |P12>0and P13 | You report that the patient had psychiatric problems in the past 30 OK After P14 is entered.
and P14 and/or P14=0. days, (P12). Given these problems, we would expect that the Cursor moves to P12.
patient would be at least slightly bothered or slightly in need of
treatment for this recent problem, please recode P13 and/or P14.
P12, P13, |P12=0o0r00and | You report that the patient had no psychiatric problems in the past OK After P14 is entered.
and P14 P13 or P14>0. 30 days (P12). If they report being troubled or wanting treatment, Cursor moves to P12.
it is fair to expect that they had some problem days. Go back to
P12 and identify the number of days the symptoms have bothered
the client.
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Changing User Preferences

Example: Some system parameters are user-configurable and can be changed by clicking on the
Tools > Options... menu item.

Addiction Severity Index

File W= Help
Opkions., .. i i .
. Cpkions : o Highlight Calar Status
w Default Form Size/Position w Speed Tab
*M1. How many times in your lifg v 3how Hint alized for medical problems N far nevery 7N il:
M2 How long ado was your last hospitalization iy a physi mY Years: :l Manths: :l
*M3. Do yvau have any chronic medical problems whic nterfere with waur life?
|_ 0. Mo |_ 1.¥es (specify) W W Mot Ahswered

*m4. Are you taking any prescribed medication on a regular hasis for a physical problem?

|_ 0. Mo |_ 1.%es |_ H. Mot Answered
*m5. Do ywou receive a pension for a physical disability?  (Exclude psychiatric disability)
|_ 0. Ko |_ 1.%es (specifiy |_ . Mot Answered
*MG. How many days have you experienced medical problems in the past 307 il
*M7. How trouhled or bothered have you been by these medical problems in the past 30 days?
[ 0. Motatal [T 2 Moderately [T 4. Extremely I
[ 1. Slightly [T 3 considerably [ % Mot Answered
*M3. How impoartant to you now is treatment for these medical problems?
[T 0 Motatal [T 2 Moderately [ 4. Estremely
[ 1. Slightly [T 2 considerably [ | % Mot Answered
Ma. Interviewar: How would you rate the patient's need far medical treatment? f
4| | E

Medical Status Comments: This is an example of medical status comments

G General Info MMedical | E Employment QDrugIAIcnhnI] IzLegaI] H Family H}{I Fﬂcu:ial] B Psvchia 4 | »
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Default Form Size/Position

When the Default Form Size/Position option is checked, this function is used. If it is not checked,
the Default Form Size/Position that was true when the MHA session was closed the last time is used.
The status of the Default Form Size/Position option (i.e., checked or not checked) is saved from one
MHA session to another, so the Default Form Size/Position settings or the user-preferred settings can
always be used. The first time a MHA session is started, the Default Form Size/Position option is
checked and the default settings are used.

From the Mental Health Assistant window, click on Tools, and click on Default Form
Size/Position. The check-mark symbol displayed beside the Default Form Size/Position option
toggles on and off and the window size will adjust accordingly.

Speed Tab

The Speed Tab is provided to make data entry faster. ASI Items that require a simple click (or single
keystroke) will move to the next item without the user pressing the Tab or Enter keys. This is
particularly helpful on the Social and Psychiatric sections of the ASI.

Highlight Color

The colors depicting the highlighted items on the ASI form can be modified by the user. The default
colors are black lettering on a yellow background. To change the foreground or background, use the
combo box to select the desired colors. If the user selects the same color for both foreground and
background, the item would not be visible and an error message would appear. No checks are
conducted for tasteless color choices.

Example: Highlight color-selection form.

AS| Options

Sample ltem.

Highlight Color Foreground:

Highlight Color Background:

|‘r‘e|lnw [ Ij

Daone Cancel |
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Help Menu Options

Opening the ASI Help File

Click on Help > Contents... on the help menu, to access the ASI Help file, from the ASI Data Entry
Form. The help file for the clinician is opened. This is from the University of Pennsylvania/Veterans

Administration Center for Studies of Addiction (1977).
Example: ASI help file.

> ASLhlx
File Edit Bookmark DOptions Help

IS [=] E3

anlentsl Index | sk | Frint |

GENERAL INSTRUCTIONS

I. INTRODUCTION

Il. PATIENT'S RATING SCALE

ll. ESTIMATES

IV. CLARIFICATION

V. INTERVIEWER SEVERITY RATINGS

GENERAL NOTE REGARDING SEVERITY RATINGS

SEVERITY RATING DERIVATION PROCEDURES
V1. CONFIDENCE RATINGS
VIl. DIFFICULT OR INAPPROPRIATE SITUATIONS
Vill. FOLLOW-UP INTERVIEWS

Frequently asked questions
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Using the Help Index

From the ASI Data Entry form, click on Help Index on the help menu to access the Help Index. The

help file will be opened. This file has information concerning the operation of the program.

Example: ASI Help Index.

Help Topics: ASI.hlx =]

Index |Fin-:| |

1 Twpe the firgt few letters of the word vou're looking for.

i

& Click the index entry you want, and then click Dizplar.

Clarification

Confidence B atings

Critizal [bermns

Crozg Checking ltems

Drata Entry Suggestions
Diifficult Situations

E ztimates

Follow-up [nterviews
Frequently asked questions
General Instructions
Hollingshead Job Categories
Introduction

Introduction to patient

Job Categories

Fatient Rating Scale
Fragram Operation

Cuestions LI
Dizplay I Bt | Cancel
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Close Form

The user is given several options when exiting the form. 1) The user may return to the form; a
graceful way of acknowledging that more work is needed on the ASI. 2) The user may exit the form
without saving any data. 3) The user may save the ASI in the intention of finishing it later. 4) Save
the ASI and sign it. This option will verify the items for appropriate responses—see business rules—
and ensure that the ASI is complete. Once the ASI is verified and saved, the user can provide an
electronic signature.

Example: To close the ASI Data Entry Form, click on " X" in the form's upper right corner, or press
ALT-F4, or click on "FILE" on Main Menu, then “Exit”. The close menu will appear.

Addiction Severity Index

Close

[ Eeturn to A J

Exit |

Einish later ]

|
|
’ Sawve and Sign ]

Cinly the intersdewer (MHEEOWIDER, OME) may sicl
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Domain Scores

Example: To view the Domain Scores, click on Domain Scores tab. The ASI domain results will be
displayed in graph and text form.

& Mental Health Assistant in use by MHPROVIDER ,ONE

File Edit Wiew Tools Help

Addiction Severity Index Manager

AS] Evalustion Factars

One Mhpatient
SEMN: w2412

| + 1200872006 = 0200872006 + 031572005 * 031502005 » 031002005 & 0272502005 = 02032005 4 01202005 ¥ 0105722005 I

AS| Scares

T T T T T
Alcohal (EF) Drrug (EF) Legal (EF) Psychistric (EF) FamilySocial (EF

Ewaluation Factors

1270872006 02/08/2006 03/1572005 0341542005 03/10£2005 02/28/2005

Aleohol (EF) 52 51 40 40 40 40
Drug (EF) 40 42 35 ; 35 35
Click
Lagal (EF) 59 53 45 45 45
Psychiatric (EF) 41 RZ 41 41 41 41
PR — R an p an an an ¥
-
Marrative Repor‘t‘ term Report | tem Trends Domain Scores J
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Item Trends

To view the Items Trend, click on Item Trends tab. Item-level data will be presented in tabular and
graphical form across interviews.

& Mental Health Assistant in use by MHPROVIDER ,ONE

File Edit Wiew Tools Help
P . One Mhpatient
Addiction Severity Index Manager SEN: w000 2412
AS| tems
AS]E12 Money earned
ltem = £ 000 g e .
ME Diays medical prokblem
E11 Days worked 4'500_1:""" T
apood Locoocccasssssesssessssnsasasassd i
E17 lllegal income
BB - - =l m o o e e e e '
D1 Days used alcohaol g g g
D2 Days alcahal intoxicatic 3,000 5 i :
D3 Days used heroin 2,500
D6 Days used other opiate 0
D7 Days used sedfhypn,fr 20001
D8 Days used cocaine 1so0 k|
D23 Money spent on alcoh g
1,000 -
D24 Money spent on drugs 0
L27 Days illegal activites 500 1:-
F30 Dianys of farnily condlict ok : :
- A " s 01/05/2005 02i08/2005 12/08/2005
Marrative Report | [tem Repon lterm Trends | Dgmain Scares
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Graphing a Different ltem

To graph a different item, click on different row in table of item data. The new row will be
highlighted and the data for that item will be graphed.

Example: The item was changed from E12 (previous example) to M6 by clicking on the M6 row.
M6 data are graphed.

w- Mental Health Assistant in use by MHPROVIDER . ONE

File Edit W¥iew Tools Help

Addiction Severity Index Manager

One Mhpatient
SEM: oo=e-2412

Ifnf":] tems - o AS| ME Days medical problems
s medical problem) 25
E11 Days worked 251
E1Z baney earned 244
E17 lllegal income 224
D1 Days used alcohal 20
D2 Days alcohal intoxicatic 184
D3 Days used herain Lk
D& Days used other opiate Ty
D7 Days used sedfhypnitr 2y
Dd Days used cocaine B
D23 Money spent on alcoh ::,
D24 Money spent on drugs 4_'
L27 Days illegal activities il
F20 Days of tamily conflict ol; : :
zn- - - > M 01 052005 020872008 12082008
Marrative Repart | tem Repart ltem Trends | Domain Scares
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Use of the Software

Returning to the Narrative Report View

Example: To return to the Narrative Report View, Click on the Narrative Report tab. The original
view of the ASI tab is restored.

& Mental Health Assistant in use by MHPROVIDER ,ONE

File Edit Wiew Tools Help
P . One Mhpatient
Addiction Severity Index Manager SEN: w000 2412
Frewvious ASI
Mew .
Date Twpe Ordered By Status Signed =
124082008 MHPROVIDER MEW Completed
06/13/2006 LITE MHPROVIDER, NEW Incomplete False
02/08/2006 LITE MHPROVIDER. MEW Completed True
Iﬁfsntigﬁ’ss'”ce 02/08/2006 LITE MHPROWIDER, NEW Ready 1o sign False v
Eal
MHPATIENT,ONE O000-00-Z41Z2 AST LITE on 12/08/2006 by: MHPROVIDER, NEW 3
*+* PEYCHOSOCIAL HISTORY *+* —
GENEPRAL INFORMATION
M=_. Mhpatient is a 27 wear old White (not Hisp), married female HNEC wveteran.
She lists her religious preference as Protestant. 5he was admitted to the
Consultationsliaison program on Dec 08, Z2006. In the past 30 days, she has not
heen in a controlled environment.. Zhe has liwed at her current address for 32
wears, I months.
This report is base Mnterview conducted in person on Dec 08,
Z00& by New Mhprovider. I completed the interwview.
Composite Score
MEDICAL O.02Zz
EMPLOTMEN 0. 5356 v
Marrative Report | jam Feport | ltem Trends | Domain Scores
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Use of the Software

GAF Manager Functions

Orientation

The GAF Manager gives the user an easy way to enter GAF ratings and to see previous ratings,
which are graphed to indicate trends. When entering a new rating, the rating is associated with the
GAF rating criteria. It is hoped this association will increase the reliability of ratings and reduce
inter-rater variability in the assignment of GAF ratings.

Main menu Selected patient identification

% Mental Health Assistant in use by MHPROVIDER ,ONE M=
File Edit Wiew Action Tools Help

<+ Title bar
P OneWhpatient
Global Assessment of Functioning Manager ST w000 2d 2
100 :
Date |GAF | Clinician E D BOf T T
02/03/2005 54  MHPROVIDERNEW Tt [ S Y S
I e
DBYRNEE 28 MHRROMIDERNEW - v N -
01/21/2005 37 MHPROVIDERMNEW ok 5 5 ;
Mark Bisting "Entered in Error" \ 01/21/2003 01/03/2005  07/19/2006 12/12/2008
GAF Criteria & revious

GAFs List

Criteria
) persistent inability to maintain
tion of death.

= mpts without clear expectation of death; frequently
violent: OF occasionally fails to maintain minimal peremmelbygiene (e.g. smears fe S i
in cormrmunication (e.g. largely incoherent or mute). GAF Criteria Table (score
- . i . S — ranges and associated
21-30 Behawioris considerably influenced by delusions or hallucinations OF satious impaeiesry)

judament (e.q., sometime incoherent, acts grossly inappropriately, suicidal preocc
function in almost all areas (e.q.. staws in bed all day; no job, home or friends).

31-40 Sorme impairment in reality testing or communication (e.q. speech is attimes illogical, obscure. or irrelevant)
OR. major impairment in several areas, such as work or schoal, family relations, judgment, thinking, or mood
(e.g. depressed man avoids friends, neglects family. and is unable to waork; child frequently beats up younger
children, is defiant at home and is failing at school). .

|‘ Mew GAF rating: |1 = Evaluation Date: 5/ Bf2009 -

GAF entry area

October 2010 MHAS3 User Manual 193
Patch YS*5.01*96



Use of the Software

Main Menu
The Main Menu offers user functions in the context of the GAF Manager form, such as tools and
help.

Selected Patient Identification label
The Selected Patient Identification label displays information about who is the currently-selected
patient within MHAS3. All functions performed in the GAF Manager form will apply to this patient.

Title Bar
The Title Bar is a visual artifact that is used throughout MHAS to display information about the
context that applies to the current activity. In this case, the Title Bar displays the form’s name.

List of Previous GAF Ratings
This is the list of all GAF ratings given to the selected patient. The list is also used for selecting
which GAF record to process.

Graph View
The Graph View displays a graphical representation of rating data values over time.

GAF Criteria Table
The GAF Criteria Table is a reference tool for clinicians to enable them to review the different
criteria narratives and their associated rating ranges.

GAF Editing Button
The GAF Editing Button is used to edit a saved GAF rating that is still editable or to mark a saved
GAF rating as “Entered in error”.

New Rating Artifacts
The New Rating Artifacts are a group of controls that are adjusted to save a new GAF rating.

GAF Rating Is Due Alert label
Despite being displayed on MHA3’s Main Form, the GAF Rating Is Due alert label is actually a
component of the GAF rating activities in MHA3.
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Use of the Software

GAF Due Notification Message

If the selected patient has no previous GAF ratings or who’s most recent rating is older than 90 days,
the GAF Is Due alert label is displayed. Otherwise, the label is not displayed.

Example: “GAF rating is due” notification message on MHA’s Main Form.

% Mental Health Assistant in use by MHPROVIDER ,ONE MiSE
File Tools Help

One Mhpatient

Mental Health Assistant S

Instrument Administrator
Instrument Results Review
Addiction Severity Index Manager

Global Assessment of Functioning Manager

PEEEES e Notification
GAF rating i1z due
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Use of the Software

Selecting a Previous Rating

Example: To select a previous rating for processing, click on the row of the desired rating on the
table that lists all previous ratings. That row will be highlighted.

& Mental Health Assistant in use by MHPROVIDER,ONE
File Edit Mew Action Tools Help

COne khpatient

Global Assessment of Functioning Mangigs ST w000 2d 2
Click
100
Date |GAF [Clinician || & 80
02/03/2005 54 MHREGYIDER NEW @ o
L 40f
O2OH205 28 MHPRROVIDERMEW = ol : : ,
01/21/2005 37 MHPROVIDERMEW. . : : :
Mark Bating "Entered in Enar” 01/21/2003 01/03/2005  07/1%/2006 12/12/2008

GAF Criteria

Range Criteria 2

11-20 Sorme danger of hurting self or others (e.0. suicide atternpts without clear expectation of death; frequenthy
wiolent O occasionally fails to maintain minimal personal hygiene (e.g. smears feces) OR gross impairment
in communication (e.q., largely incoherent ar mute).

21-30 Behawior is considerably influenced by delusions or hallucinations OR serious impairment in communication or

judgment (e.g.. sometime incoherent, acts grossly inappropriately, suicidal preoccupation) OR inability to
function in almaost all areas (e.q.. stays in bed all day; no job, home or friends).

31-40 Some impairment in reality testing or communication (e.q. speech is attimes illogical, obscure. or irrelevant)
OR major impairment in several areas, such aswork or school, family relations, judgment, thinking, or mood
(e.g. depressed man avoids friends, neglects family. and is unable to waork; child frequently beats up younger
children, is defiant at home and is failing at school).

Mew GAF rating: |1 = Evaluation Date: R Bj2009 -
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Use of the Software

Selecting a New Patient

Example: To select a different patient, click on the File > Select Patient menu item. After a brief
pause, the familiar CPRS patient-selection form is displayed. After selecting a new patient, both
CPRS and MHAS are synchronized and updated to identify the same new patient.

NOTE: Refer to the CPRS documentation for instructions on patient selection procedures.

& Mental Health Assistant in use by MHPROVIDER,ONE
GIEN Edit  Wiew Action  Tools

Help

11-20

21-30

31-40

Seleck Patient. .. /_m

< P COne khpatient

ment of Functioning Manager ST w000 2d 2
Save As... 3
Print... L3

100y :
Exit o o B
o el | Clinician E e R L W
020032005 54  MHPROVIDERNEW, Tt [ S Y S
T e O GOt TECREEERERPT P

28 3 2|:|_: _____________________________ U s o

01/21/2005 37 MHPROVIDERMEW . 5 : 5
hark Rating "Ertered in Error" 01/21/2003 01/03/2005  07/19/2006 12{12/2008

GAF Criteria.
Range Critaria L5

Zome danger of hurting self ar others (e.q.. suicide attempts without clear expectation of death; frequently
wiolent O occasionally fails to maintain minimal personal hygiene (e.g. smears feces) OR gross impairment
in communication (e.q., largely incoherent ar mute).

Behawior is considerably influenced by delusions or hallucinations OR serious impairment in communication or
judgment (e.q.. sometime incoherent, acts grossly inappropriately, suicidal preoccupation) OR inability to
function in almaost all areas (e.q.. stays in bed all day; no job, home or friends).

Some impairment in reality testing or communication (e.q. speech is attimes illogical, obscure. or irrelevant)
OR major impairment in several areas, such aswork or school, family relations, judgment, thinking, or mood
(e.g. depressed man avoids friends, neglects family. and is unable to waork; child frequently beats up younger
children, is defiant at hame and is failing at school).

Mew GAF rating: |1 = Evaluation Date: R Bj2009 -
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Use of the Software

Entering a Rating Using GAF Criteria (Save a new rating)

The GAF Criteria table displays all GAF criteria. When the user starts the GAF Manager for the first
time after selecting a new patient, the first row of GAF criteria is selected; a rating of 1 is in the New
GAF Rating spin edit control, the Evaluation Date date-picker is set to today's date, and the Save
Rating button disabled. The previous ratings view (above-left) includes a tabular and graphical
representation of all previous GAF ratings as well as the rating criteria for the specified new GAF

rating.

To save a new rating:

1.

wmn

o

Click on one of the Criteria ranges and fine-tune the rating by adjusting the New GAF
Rating spin-edit.

Select a different Evaluation Date, or leave the default date set.

Click on the File > Save New Rating menu item or the Save New Rating button.

The rating displayed in the spin edit control will be saved to Vista. The rating will be
assigned the date displayed in the Evaluation Date date-picker, and the session user will be
the rater. Soon after the new rating is saved, the new rating is displayed in the table and graph
on the GAF Manager form.

The Save New Rating button and menu item will be disabled.

The GAF Due notification on the MHA Main Form will not visible.
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Use of the Software

Example: A rating of 25 is entered for a date of 2/22/2005.

& Mental Health Assistant in use by MHPROYIDER,ONE

GI=N Edit Miew Action  Tools  Help

Select Patient, ..

One Mhpatient
SEM: w0212

4. Save the new rating

s ment of Functioning Manager

Save As... ]
Print... 3
100 .

Exit

rehF | Clinician ES{I
02/03/2005 54 MHPROVIDERNEY: o By

L 40
01/21/2008 37 MHPROVIDERMEW
1241242008

hdark Bating "Entered in Errar"

GAF Critefia / :
Range Critatia / A

1-10 Persistent danger pf severely huring self o crsistertinahility to maintain | —
minimal persong yglene OF: sepfous suic 2 Fine- tune the rating

11-20

K} AdJUSt the date,
if necessary

(e.g. depress

childran, is deh 2
v
Mew GAF rating: 25| = Ewvaluation Date: |5f Bf2ong j [ﬁa\xeNewF’ia‘ting ]
199
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Use of the Software

Entering a Rating Using the Spin Edit Control

To enter or change a rating:

1. Change the rating by typing a number between 1-100 in the spin edit control or by clicking
on the up or down arrows.

2. The rating in the spin edit control will change.

3. Alpha characters or numbers outside the 1-100 range are not accepted.

4. The Save Rating button is enabled.

Example: Changing the rating to 25 displays the appropriate criteria row in the Criteria view and
enables the Save New Rating button.

% Mental Health Assistant in use by MHPROYIDER ONE M=
Eile Edit Mew Action Tools Help

COne khpatient

Global Assessment of Functioning Manager ST 2412
100
Date | GAF | Clinician E L I At Wb
024032005 54 MHPROVIDER.NEYy ! ED N
W, A4 fessscsssncpeBasad oficocostoonsfoadiosascaascacsss
SfH2005 28 MEPROHBERREY o | e i LN .
0142142005 37 MHFROVIDERMNEW 0 & :
Mark Bating "Entered in Errar" 0142142003 01/03/2005  07A19/2006 1211 2/2008
GAF Criteria
Range Critatia L0
1-10 Persistent danger of severely hurting self or o . . ersistent inahility to maintain | —
minimal personal hygiene OF serigds suicidg Fine-tune the rating
11-20 Some danger of hurting self or others (e.0. suicide attempts without clear expectation of death; frequenthy
wiolent DR occasionally fails to/maintain minimal persanal hygiene (e.g. smears feces) OR grass impairment
in communication (e.g. largelyincoherent ar mute).

1 ICIcal o
joh. ho EEE

31-40 Same impairment in rgality testing or communication (e.q. speech is attimes illogical, obscure. or irrelevant)
OR major impairment in several areas. such as work or school, family relations. judgment, thinking, or mood
{e.0. depressed lan avoids friends, neglects family, and is unable to wark; child frequently beats up vounger
children, iz defight at home and i failing at school).

¥

MNew GAF rating: 25| = Evaluation Date: |5f Bf2004 j [ﬁa\xeNewRa‘ting
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Use of the Software

Changing the Evaluation Date

To change an evaluation date:

Click on the down arrow of the Evaluation Date date-picker

Clicking on the down arrow produces a calendar artifact.

Clicking on a previous date inserts the new date into the date-picker text box.
Future dates cannot be selected.

Select a new date

arwbdPE

Example: Clicking on the down arrow produces a calendar with the current evaluation date selected
(today's date is the default). Click on the left arrow at the top of the calendar to go to a previous
month. Click on today's date or an earlier date to select it as shown in the following example.

& Mental Health Assistant in use by MHPROVIDER ,ONE
File Edit ‘Wiew Ackion Tools Help

Global Assessment of Functioning Manager s Mhpetiont
100

Date |GAF [Ciinician [a] || & 80%
02/03/2005 54 MHPROVIDER. MEYy & BOT
02032005 38 WHPROVIDERNEW % :g i ! !
0142142005 37 MHFROVIDERMEM ok . . .

tark Bating "Entered in Error" 0142142003 01/03/2005  07719/2006 1241242008
GAF Criteria
Fange Critaria 2
1-10 Fersistent danger of severely hurting self ar others (e.q. recurrent vialence) OR persistent inahility to maintain - | —

minimal personal lvgiene OR serious suicidal actwith clear expectation of death.

11-20 Sorne danger of hurting self or others (e.q. suicide attern
wiolent OR occasionally fails to mai
in cormrmunication (e.q., largely incoh

pts without clear expectation of death; frequently
| M 2009 mears feces) OR gross impairment
ay.

=un bon Tue WWed Thu Fri

Behawviar is EEW ious impairment in communication or

judgment (e.g 1 2 cupation) OR inakility to
function in alm | 1 4 K @ 7 8 g p&ib
31-40 Some impairment inreality testingor| 10 11 12 13 14 15 16 |es illogical, obscure, orirrelevant)

OR majorimpairmentin severalareg 17 18 19 @20 21 22 23 lions, judgment, thinking, or mood
(e.g. depressed man avoids friends) 24 o5 25 27 25 =29 3p [ childfreguently heats up younger
children, is defiant at home and is fail 3

© JToday: 5/6/2009 w
MNew GAF rating: 25 2 Ewaluation Date: |5,." B/20049 j lgaveNewting l
AN

N

Adjust the date,

as necessary

October 2010 MHAS3 User Manual 201
Patch YS*5.01*96



Use of the Software

Saving a Graph or a Table to a File

Example: To save data to a file, click on File > Save As menu item and save one graph and one
table. A message dialog appears that allows the user to enter a filename and storage location for the
table or graph file to be saved. A graph is saved as a bitmap and a table is saved as an Excel file.

@ Mental Health Assistant in use by MHPROVIDER ,ONE
Edit  Wiew Action Tools Help

Select Patient. .

Save new Rating L-.p_.ni of Fu One Mhpatient

iloning Manager SEN: 3000002412

Graph
Print... 3
100
Exit
b | Clinician L LB e A ARERRRRRAIELLLLEERY
02/03/2005 54 MHPROVIDERNEW 7 Tk R - Hiiy A S S
L AT lig=ffessseseososfoadhoccccsossonass ]
=8 5 ] e L e
0142172005 37 MHPROVIDERMEY 0 : :
Mark Bating "Entered in Error" 0142142003 01/03/2005  07A9/2006 1212/2008
GAF Criteria
Range Criteria A
1-10 Persistent danger of sewverely huring self or others (e.q. recurrentwviolence) OR persistent inahility to maintain
minimal personal hygiene OR serious suicidal actwith clear expectation of death.
11-20 Zome danger af huring self or others (e.q., suicide attempts without clear expectation of death; frequently
wiolent OR occasionally fails to maintain minimal personal hygiene (e.g. smears feces) OR gross impairment
in cormmunication (e.q. largely incoherent ar mute).

etious impairment in communicatian or

Linability to

ils . home or friends).

31-40 Sorme impairment in reality testing or communication (e.g. speech is attimes illogical, chscure, or irelewvant)
OR major impairment in several areas, such as work or school, family relations, judgment, thinking, or mood
(e.g. depressed man avoids friends, neglects family. and is unable to work; child frequently beats up younger
children, is defiant at home and is failing at schoal).

MNew GAF rating: |25 2 Ewaluation Date: |5f Bf20049 j [EaveNewF’iating

October 2010 MHAS3 User Manual 202
Patch YS*5.01*96



Use of the Software

Example: Save As form.

Save i |B by Documents

IChAnnual Leave CMHASZ [ My irkual Machines
ICiCreatar [Ty eBooks &) TestElue]
IChedipse @My Music lﬂTest Scores.bmp
I)Elementk. Classes EM}.H Pictures ) )
|5)Email Archive |=3My Received Files ASS'Qn a new filename,
) 1GAF ™ty videns or keep the default
7

File name: .zt Scores.bmpl
Save az twper | Bitmap files [*.brp] j Cancel
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Use of the Software

Printing a

Graph or a Table

Example: To print a GAF graph or table, click on File > Print menu item and print one graph and
one table. A copy of the table or the graph is sent directly to the default printer.

w- Mental Health Assistant in use by MHPROVIDER ,ONE

Edit

File

View Action  Tools

Select Patient. .,

Help

One Mhpatient

- Rati _ )
Save nevy Rating ent of Functioning M Click SEN: xoaemec 2417
ave As... 3
Sroph
iy
peF | Clinician |'_‘ % EE """"""""""""""""""""""""""""
02/03/2005 54 MHPROWVIDERMNEW o T Ay e
L, 4l feesscsssmoperBasadiiaficscassoocsfossioasanasosasase
Bi2005 28 WHERROMADERRE ool NN T .
01/21/2005 37 MHFRCOWIDERMNEWY 0 '
Mark Bating "Entered in Error" 0142142003 014/03/2005  07A19/2006 12f12/2008
GAF Criteria.
Fange Criteria A5
1-10 Fersistent danger of severely hurting self or others (e.g. recurrentviolence) OR persistent inahility to maintain - —
minimal personal hygiene OR serious suicidal actwith clear expectation of death.
11-20 some danger of hurting self or others (e.g.. suicide atternpts without clear expectation of death; freguently

violent OF occasionally fails to maintain minimal personal hygiene (e.g. smears feces) OR gross impairment
in communication (e.q. largely incoherent or mute).

occupation) OR
2 or friends).

all day: no job, hor

Zome impairment in reality testing or communication (e.g., speechis attimes illogical. ohscure, or irrelevant)

3-40
OR majorimpairment in several areas, such as work or school, family relations, judgment, thinking, ar mood
e.g. depressed man avoids friends, neglects family, and is unable to work; child frequently beats up younger
children, is defiant at home and is failing at schoal). 3
MNew GAF rating: (25 5 Ewaluation Date: | B/ B/20049 j [ aawve Mew Rating
October 2010 MHAZ3 User Manual 204

Patch YS*5.01*96



Use of the Software

Exiting the GAF Manager Form

Example: To exit the GAF Manager form, click on File > Exit menu item. You can also press the
“ESC” key of click on the “X” in the upper right-hand corner of the form. The GAF Manager form
closes and user is returned to the MHA3 Main form.

@ Mental Health Assistant in use by MHPRO¥IDER ,ONE
-8 Edit Wiew Action Tools Help

Select Patient. .

fluence: L serious impairment in communication or
""" ( inc it gros EQRropta Jicidal preaccupation) OR inability to
tfriends).

31-40 Sorme impairment in reality testing or communication (e.g. speech is attimes illogical, chscure, or irelewvant)
OR major impairment in several areas, such as work or school, family relations, judgment, thinking, or mood
(e.9. depressed man avoids friends, neglects family. and is unable to wark; child frequently beats up younger
children. is defiant at home and is failing at schaal).

ssvereniaing . ment of Functioning Manager G e
Prit... el C|ick 0
_I F | Clinician L B0 e A ARRRRRRRAIELLLLEERY
020032005 54  MHPROVIDER.NEW @ B Ty L
B B i ot ) i VA N
0142172005 37 MHPROVIDERMEY 0 . . . :
Mark Bating "Entered in Error" 0142142003 01/03/2005  07A9/2006 1212/2008
GAF Criteria
Range Criteria A
1-10 Persistent danger of severely hutting self or others (e.q. recurrentwviolence) OF persistent inahbility to maintain - | —
minimal personal hygiene OR serious suicidal actwith clear expectation of death.
11-20 Some danger of hurting self ar athers (e.g. suicide attempts without clear expectation of death; frequenthy
wiolent OR occasionally fails to maintain minimal personal hygiene (e.g. smears feces) OR gross impairment
in communication (e.q., largely incoherent or mute).

MNew GAF rating: |25 2 Ewaluation Date: |5," B/20049 j [EaveNewF’iating
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Use of the Software

Copying a Graph or a Table to the Windows Clipboard

Example: To copy data to the clipboard, click on Edit > Copy menu item and copy to clipboard one
graph and one table. A copy of the table or the graph is sent to the Clipboard. The contents of the
Clipboard can be pasted onto an MS Word or Excel document.

w- Mental Health Assistant in use by MHPROYIDER ,ONE
File BS:[8® Wiew Ackion Tools  Help

P— One Mhpatient
Global Asse Functioning Manager SEN: roomm 2417
100
Date |GAF | Clinician E 2 80
02/03/2005 54 MHPREOWIDER MEYY @ el
L 40y
B 2aas 28 RERPRESADEREY g 20_-
0142142005 37 MHPROVIDERMEM ok ! ! !
tark Bating "Entered in Error" 0142142003 01/03/2005  07/19/2006 121242008
GAF Criteria
Range Criteria £
1-10 Fersistent danger of serverely hurting self or others (e.q. recurrent violence) OR persistent inability to maintain - —
minimal personal yvgiene OR serious suicidal actwith clear expectation of death.
11-20 mome danger of hurting self or others (2.g. suicide attempts without clear expectation of death; frequently
violent OR occasionally fails to maintain minimal personal hygiene (e.g. smears feces) OR gross impairment
in cammunication (e.q., largely incoherent ar mute

in b i ous impairment in communication or
' ' ation) OR inahility to

31-40 Some impairment in reality testing or communication (e.g., speech is attimes illogical, obscure, or irrelesvant)
OR major impairment in several areas, such as work or schoal, family relations, judgment, thinking, or mood
(e.g. depressed man avoids friends, neglects family, and is unable to work; child frequently beats up vounger
children, iz defiant at home and is failing at schoal).

Mew GAF rating: 25 3 Ewaluation Date: |5,." G/20049 j lgaveNewRating

Example: Message displayed after copying to the clipboard.

Mental Health Assistant [zl

i ] The table has been copied ko the Windows clipboard,

If vou like, wou may paste it into an open M5 Excel spreadsheet,
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Use of the Software

Marking a Rating Entered in Error

NOTE: Only GAF ratings previously entered by you may be modified. This applies to entering
ratings in error as well as changing or deleting a rating.

Example: To mark a rating as “entered in error”, select a rating from the list of previous ratings
table. Click on the Action > Mark Rating “Entered in Error” menu item. The Mark Rating
“Entered in Error” button does the same thing.

& Mental Health Assistant in use by MHPROYIDER,ONE

File Edit Wiew BEEGS Tools  Help

One Mhpatient
SSMN: ooe-2412

Date |GAF ‘Clinician \
05/06/2009 25 MHPROVIDER.OMN

1241 EIEDDE 45 MHPROWVIDER.OME | EI

[ Ma&ﬁaﬂng"Entered in Error* 7 0142142003 01/03/2005  07415/2006 12f12f2005

GAF Critetia N\
— 1. Select =

Zome danger of hurting self ar others (e.q.. suicid
wiolent O occasionally fails to maintain minimal personal hygiene (e.q. smears feces) OR gross impairment
in communication (e.q., largely incoherent ar mute).

21-30 Behawior is considerably influenced by delusions or hallucinations OR serious impairment in communication or

judgment (e.q.. sometime incoherent, acts grossly inappropriately, suicidal preoccupation) OR inability to
function in almost all areas (e.q.. staws in bed all day; no job, home or friends).

SAF Score

31-40 Sorme impairment in reality testing or communication (e.q. speech is attimes illogical, obscure. or irrelevant)
OR. major impairment in several areas, such as work or schoal, family relations, judgment, thinking, or mood
(e.g. depressed man avoids friends, neglects family. and is unable to waork; child frequently beats up younger
children, is defiant at home and is failing at school). .

Mew GAF rating: |1 = Evaluation Date: 5/ Bf2009 -
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Use of the Software

Example: A warning message appears. Click YES to mark the selected rating by marking with
strikethrough the rating text in the table. Click NO to abort any changes.

Mental Health Assistant b—<|

2 3

Marking a rating as "Entered in Error" cannaot be undone,

Do wou wank ko conkinue?
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Use of the Software

Example: Rating marked as entered in error, labeled in strikethrough text.

& Mental Health Assistant in use by MHPROVIDER,ONE M=1E3

File Edit Wiew Action Tools Help
. One Mhpatient
¢ Marked “Entered in Error” SSN:)O-O(—)E:—ZMZ

Global Assessment of Funclioning

1007
GAF | Clinician 2 a0 f
05/06/2009 MHPROVIDEF ON IR RS
o =
12/12/2008 45 MHPROVIDERONE Y S S S
| Change/Delete Rating 01/21/2003  01/03/2005  07/19/2008 12/12/2008

GAF Critetia

Criteria
nce) DR persistent inability to maintain
n of death.

{e.0. suicide attempts without clear expectation of death; frequently
wiolent O occasionally fails to maintain minimal personal hygiene (e.q. smears feces) OR gross impairment
in communication (e.q., largely incoherent ar mute).

21-30 Behawior is considerably influenced by delusions or hallucinations OR serious impairment in communication or
judgment (e.q.. sometime incoherent, acts grossly inappropriately, suicidal preoccupation) OR inability to
function in almost all areas (e.q.. staws in bed all day; no job, home or friends).

31-40 Sorme impairment in reality testing or communication (e.q. speech is attimes illogical, obscure. or irrelevant)
DR major impairment in several areas, such as wark or schaal, family relations, judgment, thinking, or maod
(e.g. depressed man avoids friends, neglects family. and is unable to waork; child frequently beats up younger
children, is defiant at home and is failing at school).

W
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Use of the Software

Changing or Deleting a Rating

NOTE: A GAF rating may only be changed or deleted within two days of the date of the initial
rating. After two days, the rating may only be marked in error. Ratings allowing modification or
deletion are indicated in the table by bold text.

NOTE: Only GAF ratings previously entered by you may be modified. This applies to entering
ratings in error as well as changing or deleting a rating.

Example: To delete or change a rating, select a rating which can be deleted or changed from the list
of previous ratings. Click on Action > Change/Delete Rating menu item. A message dialog appears
that allows the user to either delete or change the rating of the selected GAF. Any change or deletion
is reflected in the updated ratings table. User may abort changes before they are saved.

w- Mental Health Assistant in use by MHPROYIDER ,ONE
File Edit ‘iew BSESGS Tools  Help

Change|Delete Rating . One Mhpatient
errarren0ning Manager SEM: 100002412

100 :
GAF | Clinician o At
O(FJJ ED'": """"""""""" B
L D R ELRel UL TELLLRREEL PP b
B 20§ Y SRR CE L CERE LR
12/12/2008 45 N. : : :
| Change/Delete Rating 01/21/2003 01/03/2005  07/19/2006 1241242008
GAF Criteria

Range Critetia

0. recurrent vialence) OR persistent inability to maintain

minimal personal hygiene OR serious suicidal actwith clear expectation of death.

11-20 Some danger of huting self or others (e.g., suicide attempts without clear expectation of death; frequently
wiolent OR occasionally fails ta maintain minimal personal hygiene (e.qg. smears feces) OR gross impairment
in communication (e.q. largely incoherent ar mute).

21-30 Behawvior is considerably influenced by delusions or hallucinations OR serious impairment in communication ar
judgment (e.q. sometime incoherent, acts grossly inappropriately. suicidal preoccupation) OR inahility to
function in almast all areas (e.g. stays in bed all day: no jol. home ar friends).

31-40 Some impairment in reality testing aor communication (e.q., speech is attimes illogical, obscure, or irrelewvant)
OR major impairment in several areas, such as work or school, family relations, judgment, thinking, or mood
(e.g. depressed man avoids friends, neglects family, and is unable to work; child frequently beats up vounger
children, is defiant at home and is failing at schoal).

o
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Use of the Software

Example: Rating which may be deleted or changed, labeled in bold text.

Date GAF | Clinician .
05/06f,2009 2h |MHPROYIDER. O jgulp S S——
252008 = HERROABERONE
121242008 45 tMHFPROWIDER,OMNE
Change/Delete Bating

bl

GAF Criteria
= T

Example: Deleting a rating

& Mental Health Assistant @

ecify the editing action you wish to take for
the rating: 25 an 05/06/2009

| Change Rafing

2. Click
3 =

izancel
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Use of the Software

Example: Changing a rating

Date GAF | Clinician -

05/06/2009 26 |MHPROVIDER.OM g

F2HEL20EE 2 WHEHRROBERDME

121272008 45 MHFROYVIDER.OME |
Change/Delete Bating

GAF Criteria

& Mental Health Assistant

Edit GAF rating

Specify the editing action vo
the rating: 25 an 05/06/2009

[ Delete Rating W Change Ratin

Cancel

ish to take for

3

1. Click

2. Adjust rating

/ 3. Click

October 2010
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Use of the Software

Access Copyright Information

Example: To access GAF copyright information, click on Help > Copyright Info menu item. The
Copyright information message dialog is displayed.

& Mental Health Assistant in use by MHPROVIDER ,ONE =3
File Edit Miew Action Tools SEl

Crine Suppert.. Click One khpatient
Global Assessment| Abot.. ager SSN:)oo(-xS-Efq'IE

Date GAF | Clinician e S

05/06/2009 MHPROVIDER.Oh A

R0 77 MHRROMDERONE ':5" |

12/12/2008 45 MHPROVIDEROME ok

| Change/Delete Rating 01/21/2003 01/03/2005  07/19/2006 12/12/2008
GAF Criteria

Criteria

nice) OR persistent inahility to maintain - e
h of death.

(e.0. suicide attempts without clear expectation of death; frequently
wiolent, OF accasionally fails to maintain minimal personal hygiene (e.g. smears feces) OR gross impairment
in communication (e.q. largely incoherent or mute).

21-30 Behavior iz considerably influenced by delusions or hallucinations OR serious impairment in communication or
judgment (e.g. sometime incoherent, acts grosshy inappropriately, suicidal preoccupation) OR inability to
function in almost all areas (e.g.. stays in bed all day; no jobk, home or friends).

31-40 Some impairment in reality testing ar communication (e.q. speech is attimes illogical, cbscure, or irrelevant)
DR major impairment in several areas, such as work or school, family relations, judgment, thinking, or mood
(e.g. depressed man avoids friends, neglects family, and is unable to wark; child frequently beats up wounger
children, i= defiant at home and is failing at school).

Mew GAF rating: |1 = Evaluation Date: &/ Bf2009 -

Example: Copyright information message dialog.

Mental Health Assistant [5__<|

Fourth Edikion,

i J GAF criteria:  Reprinted with permission from the Diagnostic and Statiskical Manual of Mental Disarders,
Copywright 1994 American Pswchiatric Association,
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Use of the Software

User Preferences Functions

Orientation

Example: The User Preferences form enables the user to customize the manner in which several
functions are performed and displayed in MHA3. Additionally, the font and display functions are an
attempt to comply with Section 508 requirements in MHAZ3’s user interface.

Form title

& User Preferences X

Navigation tabs
Highlight Cu:llclr] Miscellaneuuﬂ/_

Font on display: MS Sans serif Size: 0

Font

Instructions:
This menu will demonstrate fonts selected below.

Click the "Done" buttan to incorporate afont in kMHA,
-
CPRS Fant [ Windows Font |

Cancel Done

\ Command
buttons
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Use of the Software

Form Title

The Form Title simply identifies the form.

Navigation Tabs

The Navigation Tabs are used to access the various functions that are distributed across three panels.

Editing Panel

The Editing Panel displays the various artifacts that the user manipulates to make adjustments to
preferences. There are three panels, but only one of them is visible at any one time.

Command Buttons

The Command Buttons are used to either cancel all actions or close the window and save the changes
made.
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Use of the Software

Changing MHA3System Font

There are three types of fonts that the user may select to provide the best viewing comfort possible:
The CPRS Font, the Windows Font, or a New Font. Selecting the CPRS Font will change MHA3’s
font to match that with CPRS uses. If the user is comfortable with the CPRS font, then this may be a
good choice. The Windows Font is the “default” Windows font. This font is used by the other
programs on the system too. The New Font option enables the user to select from any of the fonts
found on the PC. With this option it is possible to change font characteristics, such as size and bold,
etc. In most cases, the font will not need to be changed from the one offered initially by MHA3. To
change Font options:

1. Click on any of the three font Option Buttons.
2. Click on the Done button

Example: Font tab. Clicking on Cancel ignores any choices made.

& User Preferences @

Eont lﬂighlight Cl:ull:ur] Miscellaneuus]

Font on display: M5 Sans Senf Size: 0

Instructions:
Thizs menu will demonstrate fonts selected below.
Click the "Done" button to incorporate afont in kMHA,

(ttroows Fort

P
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Use of the Software

Example: If the New Font Option Button is selected, the New Font selection prompt is displayed.

Font; Font style: Size:
|MS Sanz Serif FRegular |E ] |
M5 Sans: Senf ~
M3 Seri — [italic 10 Eenzel
M5 SpgtemE s Bold 12
B T Extra Eold Italic 14
(} My Buli B 18
Miagara Engraved
(} Miagara Solid v
S ample
AaBhbY Sz
f
Script;
|"-.-'-.-"estern ﬂ
October 2010 MHAS3 User Manual
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Use of the Software

Changing the Displayed Highlight Colors on the All-Questions Data-input Form

As a navigational aide, the selected question on the All-Questions form is highlighted with a different
color from the form’s color. This color can be changed by choosing the Highlight Color tab and
selecting colors from the artifacts on the Editing Panel.

Example: Highlight Color tab. Clicking on Cancel, ignores any choices made.

& User Preferences

Font

Highlight Calar lMisceIIaneuus l

Highlight Color Foreground: |. Black

Highlight Color Background:

|:| el o

Samp

Cancel

[hese nstructions change
depending upon the location of the
MOUSE Or CUrsar.
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Use of the Software

Toqgling Visual Feedback On/Off

Visual Feedback displays error messages in addition to sound beeps.

1. Click on the Miscellaneous tab
2. Click on the “Provide visual feedback...” Option Button, so that a checkmark is displayed.

Example: Miscellaneous tab. Clicking on Cancel ignores any choices made.

& User Preferences

Font | Highlight Color | Miscellaneous ]

Frovide visual feedback in addtion to heeps.

& screen reader !
Spe

m choice itemns, go to nextitern
without pressing tan key.

L] Maintain ariginal font (Recommended).

(Instruments are designed using a standard font and changing its

size may produce unsatisfactory visual results) .
/— ?2_Click
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Use of the Software

Toqqgling Speed Tab On/Off

Speed Tab is a feature that some users may prefer to enable them to increase data entry speed. Speed
Tab is actually an automatic “Tab” key press that is triggered after the user makes a choice from a
question with multiple choice answers. This saves the user from having to press the Tab key to move
on to subsequent questions on the form. However, the Speed Tab option has no effect on Multiple-
Line Text Boxes, Single-Line Text Boxes and Spin Boxes.

To toggle Speed Tab:

Click on the Miscellaneous tab

Click on the “Speed Tab...” Option Button, so that a checkmark is displayed

Click on the Done button

Speed Tab functions are enabled in the data-entry forms, based on whether the checkmark
was visible at the time of clicking on the Done button.

el NS =

Example: Miscellaneous tab. clicking on Cancel, ignores any choices made.

& User Preferences §|

Font | Highlight Color | Miscellaneous ]

[ Provide visual feedback in addtion to heeps.

[ ] Use screen reader !

speed Tah. For multiple choice items, go to next item
Rhout pressing tab key.

(] Maintain Gk O o rmmended).

(Instruments are designed using a standard font and changing its

size may produce unsatisfactory visual results) .
/— 2. Click

Toggling Maintain Original Font on/off

The Original Font is maintained, based on whether the checkmark is set for this toggle. To set this
toggle:

1. Click on the Miscellaneous tab.
2. Click on the “Maintain Original font...” Option Button, so that a checkmark is displayed.

Example: Misc. tab. Clicking on Cancel ignores any choices made
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Use of the Software

& User Preferences

Font | Highlight Color | Miscellaneous

[ ] Provide visual feedhack in addtion to beeps.

[ ] Use screen reader !

=peed Tah. Far multiple chaoice items, go to next item
without pressing tab key.

[ haintain ariginal fant (Frecommended).

(InstmarmL] & standard font and changing its
size may prod hywisual results.) S ik

Cancel Done
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Use of the Software

Off-line Administrations Functions

Orientation

Most users are likely to use MHAZ in the standard way, that is, by administering instruments while
their computer is connected to a VistA system. However, MHA3 offers “off-line” testing features for
users needing such functionality, such as at CBOCs. Off-line testing enables the user to administer an
instrument when the user’s computer is not able to connect to a Vista system, temporarily saving the
administration’s results in an encrypted local file. When a user returns to the office and resumes a
connection to VistA, the user is asked to match the off-line patient information for a selected
administration with the Vista patient information. If the user is satisfied with the match, the results
can be uploaded to VistA, at which time the temporary local file is deleted.

The only way that MHAS3 can connect to Vista is by being “launched” from the CPRS Tools menu.
This is different from previous versions of MHA. So, to invoke MHAS for off-line use, users will
need to double-click on the Mental Health Assistant icon on the desktop.

Stored Off-line administrations are not useful until they are uploaded to Vista, at which time they
become part of the patient’s official record.
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Use of the Software

Example: There are two principal forms that are used for processing off-line administrations. The
Off-line Patient Manager is used while disconnected to VistA, while the Off-line Results

Synchronizer is used once a connection to VistA is restored.

& Mental Health Assistant

Select existing off-ine patient

Patient detailz [Edit as needed]

Off-Line Patient Manager

Patient Selector
/ Patient Edit Area

First Marne:
Lazt Marme:
S5M:
DOE:

Sex

|THREE

\MHPROVIDER

|EEE-12-3456

| 810190 =)
& Male " Female

MHew Delete

Cancel
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Use of the Software

Patient Selector

The Patient Selector Drop-Down List Box is used to choose from a list of existing off-line patients.

Patient Edit Area

The Patient Edit Area contains the input artifacts that are used to edit and display patient information.

New button

The New button is used to prepare the form for entering information about a new patient.

Delete button

The Delete button removes the selected patient from the list of patients and deletes the local record.

Cancel button

The Cancel button closes the Off-line Patient Manager without selecting a patient.

Ok button

The Ok button selects the current patient for processing of off-line administrations.
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Use of the Software

Off-line Results Synchronizer

To use the Off-line Results Synchronizer, the following must be true:

e The PC is connected to Vista.
e MHABS is launched from the CPRS Tools menu.

e The user has previously administered at least one off-line instrument that has not yet been

uploaded to Vista.
The following functionality is restored once connected to VistA:

Instruments Ordered-by selection
Interviewer selection

Visit Location selection

Online Support

Example: O-Ichronizer.

% Mental Health Assistant
File Help

B=(E3

Off-line records list

Fick an offline record, find a matching patient in CPRS, and upload the

Off-Line Results Synchronizer record

Off-Line Records

Marme 55N Dog Sex Inztrument | Date

|2

MHPATIENT, OMNE 000-00-2412 | 0340541992 DIT-2005 04,2 05 [
MHPATIENT, OME 000-00-2412  03/05/1992  FEMALE CAGE 04,/22/2005 (
MHPATIENT, T'w0 000-00-2455  04/10/1940  FEMALE AUDC 04,/22/2005 (| ¥
Search for Matching CPRS Patient Results of Match
Cenah Er ’W M Dff-Line Patient CPRS Patient
. Marme| MHPATIEMT, OWE  MHPATIEMT, OME
Erics om gl eetr ot e S9N, o et of st ramephsle || s |covonzrrz  cmao2utz
DOE |03/05/1992 211922

Marmne SSN DOB Sex Sew |FEMALE FEMALE
MHPATIENT. ONE : 22

tatch Confidence Level Good

Exit button

Upload button

x
Delete Off-Line Record | \ Upload E it
Bl CPRS patient search panel
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Use of the Software

Main Menu
The Main Menu offers user functions in the context of the Off-line Results Synchronizer form, such
as file and help.

Off-line Records List
This is the list of all tests that have been administered off-line, which haven’t been uploaded to Vista
yet. The list is used to select which administration to process.

CPRS Patient Search Panel
This group of artifacts is used to search for, and list, CPRS (VistA) patients which closely match the
off-line patient that is selected in the Off-line Records List.

Patient Match Panel

This panel displays a table on which both the off-line and CPRS patient information is shown side-
by-side to aid in determining the possibility of a match. All of the off-line patient information is
assumed to come from the patient during an interview. In most cases, the information provided will
be a perfect match to the information in Vista for the same patient. This matching scheme is a way
for the clinician to verify that it is the same patient and to make any adjustments for typos and other
minor errors.

Delete Off-line Record Button
This button triggers the deletion of the currently-selected off-line administration record. A
confirmation prompt is displayed before deleting the record.

Upload Button
This button starts the process of uploading to Vista the currently-selected record.

Exit button
The Exit button closes the Off-line Results Synchronizer form.
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Starting MHAZ in off-line mode from the desktop icon

To start MHAS for off-line use:
1. Locate the Mental Health Assistant 3 icon, as pictured below, on the Windows Desktop
2. Double-click the icon
3. Click on the Yes button on the “Do you want to work off-line” prompt.
4. Clicking on Yes causes the Off-line Patient Manager form to display.
Clicking on the No button aborts MHA3.

Example: The Mental Health Assistant icon on the Windows Desktop.

73]

Mental Health

AL Double-click

Example: “Do you want to work off-line”” prompt

Mental Health Assistant

9 | MHAisnot able to connect to VistA, Do you want to wark offdine?
\‘_#
The only thing you can do offdine is administer a test. You can upload the results the next time you're
connected to VistA,
If you can start CPRS from this machine, you should do so and then start MHA from the CPRS tools
MenL. ]
Click
Mo
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Use of the Software

Selecting an Existing Patient from the Drop-Down List Box

To select an existing off-line patient record:

1. Click on the down-arrowhead to open up the Drop-Down List Box

2. Click on the name of the desired patient.

Example: The patient selected becomes the active patient on the Drop-Down List Box. Demographic
information belonging to the selected patient fills the form.

& Mental Health Assistant

Select exzting off-ine patient

Firzt Mame:
Lazt Mame:
S5M:
DOE:

Sex

Hew Delete

Off-Line Patient Manager

MHPATIEMT, W0

|OME

[MHPATIEMT

|000-00-2412

| 3 B9z =
i~ Male ¥ Female

1. Click to open

2. Click to make
a selection

Cancel
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Use of the Software

Adding and Selecting a New Off-line Patient

To add a new patient to the list of off-line patients:

1. Click on the New button.
2. Enter the new patient information in the corresponding fields.
3. Click on the Ok button.

Example: The data entry fields are cleared and appear blank and ready for input. After clicking on
the Ok button, the user is presented in the Instrument Administrator form

& Mental Health Assistant

Off-Line Patient Manager

Select exizting off-line patient
| =l

Patient detailz  [Edit as needed]

First Mame:| | TWi0

Last Mame:| |MHPATIENT

2. Enter patient __an| [oooooesss
information in DOB:| | 4101340 _~|

provided fields

to Wz O el 3. Click, to save patient

and administer an

instrument

Hew Delete Cancel ok
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Use of the Software

Example: Instrument Administrator form.

w- Mental Health Assistant in use by Off Line

File Tools Help
. Fifty Mhpatient
Instrument Administrator SIS w1 00
Date of Administration: Awailable Instruments and Batteries: Instrurments Chosen:
5/ B/2009 = .
| / Bf J Show: |A|I j
Instructions:
Selectthe instrument by checking its MHLE A J
box with the mouse, or use the arrow H mMHLC-C
keys and space-barto select. . J
Undetlined instrurnents are MISE
incomplete. MAPES J
Bold indicates a battery which
containg many instruments. MbPI2
MORSE FALL SCALE
PCPTSD
PCLC ¢ s
PCLM
PHO-2 Display:
__l|IN g i i
- One Cuestion ata Time
RLOC || | ¥ AllQuestions at Once
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Use of the Software

Selecting a Different Off-line Patient from the Instrument Administrator Form

To select another off-line patient from the Instrument Administrator form:

1. From the Instrument Administrator form, click on File > Select Patient... menu option.

2. The Off-line Patient Manager form is displayed, offering an opportunity to choose a
different existing or new patient.

3. Choose a different off-line patient from the Off-line Patient Manager form. After selecting
another patient, and clicking Ok, the new selected patient is identified.

Example: Instrument Administrator Form.

o Mental Health Assistant in use by Off Line

FEN Tools Help

i ’ﬁ'nms istrator }
- . 1. Click _
Date of Adrministration: _ struments and Batteries:

| 5/ Bf2009 j Show: |A|| j

Instructions:

Fifty Mhpatient
SSM: w0100

Instrurments Chosen:

MHLE ~
MHLC-C

MISE

MMPZS

MMPI2

MORSE FALL SCALE

FCPTSD

FCLC

FCLA

These instructions change
depending upon the location of the
MOUse ar CUrsar.

&= =

8 i i B o i i i

PHO-2
PHOS
RLOC

Display:
" One Question ata Time

* All Questions at Ohce
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Use of the Software

Example: Off-line Patient Manager Form.

& Mental Health Assistant

Off-Line Patient Manager

Select exizting off-line patient

MHPATIENT. IIINE 2. Click
MHPATIEMT, T'w/0

First Mame: | THREE

Last Mame:  |MHPROVIDER

S5M:  |BRE-12-3456

Doe: | 8A0M90 -
Ge ¢ Male " Female

3. Click \

)

Hew Delete | Cancel | k.
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Deleting an Existing Off-line Patient

To delete an off-line patient:

Click on the Delete button.

PoppE

deletion.

Example: Selecting the name of an off-line patient using the Drop-Down List Box.

& Mental Health Assistant

Off-Line Patient Manager

Select exzting off-ine patient

The delete warning message is displayed
Click on Yes to delete the selected patient from the list OR click on the No tab to abort the

MHPATIENT. ONE 1. Click
MHPATIENT. Tw/0

First Mame: | THREE

Last Mame:  |MHPROVIDER

S5M:  |FER-12-3456

DOB: | 8101980~
Sew % Male i~ Female

Select the name of an off-line patient using the Drop-Down List Box.

Cancel

Example: Delete warning message.

Mental Health Assistant

This action cannot be undone!

"j Are you sure you want to delete Three Mhprovider from the offHine patient file?
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Use of the Software

Canceling Selection of an Off-line Patient

To exit the Off-line Patient Manager without selecting a patient:

Click on the Cancel button.

The cancel warning message is displayed.

Respond with Yes to the cancel warning message prompt.
Clicking on Yes closes the Off-line Patient Manager form.
Clicking on No returns to the Off-line Patient Manager form.

arwbdPE

Example: Exiting the Off-line Patient Manager without selecting a patient.

& Mental Health Assistant

Off-Line Patient Manager

Select exzting off-ine patient

Patient detailz  [Edit az needed]

First Mame: | THREE

Last Mame:  |MHPROVIDER

S5M:  |FER-12-3456

DOB: | 8101980~
Sew % Male i~ Female

- BN

Hew | Delete | Cancel | ok

Example: Cancel warning message prompt

Mental Health Assistant

=

Mo patient is selected. Are you sure you want to dose?
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Selecting an Existing Off-line Patient from the Off-line Patient Manager

Patients that are already included in the list of existing patients may be selected:

1. Select the name of an off-line patient using the Drop-Down List Box

2. Click on the Ok button
3. The Off-line Patient Manager form is closed

Example: Off-line Patient Manager Form.

& Mental Health Assistant

Offline Patient Manager

Select existing off-line patient

FMHEATIEMNT, FIF T 1. Click

MHEATIENT, ST

First Mame: |FII-_|"T”

LastName:  [MHPATIENT

SSN; |000-00-0100

DOB: | 5/ 61956 ~|

X

IR l ’ Delete l ’ cancel l ’ [8]:4

l
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Use of the Software

Example: Instrument Administrator form, shown as modified for off-line use. The Instrument
Administrator form is displayed, identifying the selected off-line patient. After completing and
saving the administration in the Instrument Administrator, the exit reminder prompt is displayed.
MHAS shuts down, as expected

@ dMental Health Assistant in use by Off Line

e Tools Help Selected patient \
Fifty kdhpatient

Instrument Administrator SEN: woooec ] 00
Date of Administration: Available Instruments and Batteries: Instrurments Chosen:
5/ B/2009 -
| /B J Shiowy: |A|I j
Instructions:
= MHLE v 4]
The presentation of instruments can | mHLCC
he filtered: show all (na filter), only l J
batteries, or only incomplete MISS
instruments. MMP2ES J
hbAPI2
MORSE FALL SCALE
PCPTSD
PCLC $ 5
PCLM
PHO-2 Display:
PHQY = " One Question ata Time
RLOC || | ® AllQuestions at Once
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Use of the Software

The following functionality is disabled in off-line operating mode:

Instruments Ordered-by selection
Interviewer selection

Visit Location selection
METRIC Instruments Reviews
Battery Wizard

Instrument Description

Online Support

Example: Exit reminder prompt.

Mental Health Assistant

i The next time you're connected to VistA, you'll be prompted to upload the answers to any instruments
\‘) administered during this session,
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Use of the Software

Recognizing the Availability of Off-line Administrations, and Initiating the Upload
Process

If any records exist on the PC that was administered off-line, the user is reminded about them once
MHAZ is launched from the CPRS Tools bar. A notification prompt is displayed and the user is
offered a choice to upload these records at this time.

To upload existing off-line records:

1. Start CPRS

2. Invoke MHA3 from the CPRS Tools menu

3. Ifany off-line administration files are found on the PC, the “Do you want to upload to
VistA...” prompt is presented. Otherwise, uploading functionality is bypassed and MHA3
starts up in normal VistA mode.

4. Uploading the confirmation prompt.

Example: Click on the Yes button, on the “Do you want to upload to VistA...” prompt.
After clicking on Yes, the Off-line Results Synchronizer form is displayed.

Mental Health Assistant
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1. After clicking on Yes, the Off-line Results Synchronizer form is displayed. Clicking on the
NO button cancels the upload process and starts MHAS3 in normal Vista mode. Clicking on
the Yes button displays the Off-line Results Synchronizer form.

Example: Off-line Results Synchronizer form.

& Mental Health Assistant Z| |Elgl
File Help
Oﬁ-Line RESUItS SynChTOnizer Fick an offline record, find a marté:gior:g.patient in CPRS, and upload the
Off-Line Records

Mame 55M Dog Sex Instrument | Date i

MHPATIENT, OME 000-00-2412 (03/05/1992 | FEMALE DIT-2005 05 (=

MHPATIENT, OMNE 000-00-2412  03/05/1992  FEMALE CAGE 04,/22/2005 (

MHPATIEMT, T'w0 000-00-8455  04/10/1940  FEMALE AUDC 04,/22/2005 (| %
Search for Matching CPRS Patient Results of Match

Search for: [M2412 Go Dff-Line Patient CPRS Patient

Narme| MHPATIEMT, ONE | MHPATIENT. ONE

Ertter same or all the latters of lazt name, or S5M, ar the first letter of the last name pluz last four

digits of 55M. Search results below [click on name to select). E5L 0000024712 0022
DOE |03/05/15992 211922
Marne SSN DOE Sex Sew |FEMALE FEMALE

MHPATIEMT, OME

Match Confidence Level: Good

Delete Off-Line Record Upload E xit
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Selecting an Off-line Record for Uploading

To select a record for uploading to VistA, click on the desired record from those presented on the
Off-line Records list.

1.
2.

The clicked-on record becomes the selected record

The left column of the Results of Match grid is populated with demographic information
from the selected off-line patient’s record.

A search in the CPRS database is automatically triggered, to find and list the closest
matching CPRS patient(s) on the CPRS Patient Search Panel

The right column of the Results of Match grid is populated with demographic information
from the selected CPRS patient’s record.

If more than one CPRS patient match is found, the first one in the list is automatically
selected, although it may not necessarily be the best match.

Off-Line Records

Example: Off-line Recordsyxﬂa}records.

Mame

/ |SSN |DDB |SEH ||nstlument |Date -

MHPATIENT, ONE 000002412 03/05/1952 FEMALE  CAGE 04/22/2005 (
002412 [03/05/1992 [FEMALE  [AUDIT  |04/22/2005(
MHPATIENT, Tw0 000-00-8455  04/10/1340 FEMALE  ALDC 04/22/2005 (¥
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Searching for a Matching CPRS Patient

There are two kinds of search methods available for finding a matching CPRS patient: The automatic
initial search and a manual search.

The automatic initial search uses a text filter that is built from the selected off-line patient’s first
letter of the last name, followed by the last four of the SSN—the same way it is done in VistA. This
text filter is automatically placed in the “Search for” Text Box, and is used for the initial search,
which is triggered automatically.

Occasionally, the automatic initial search returns no results or returns poor matching results. In this
case, the search text filter may be changed to customize a new result set. To start a manual search,
replace the text in the Search for Text Box, and click on the Go button to trigger a new search, and a
refreshed listing of possible matches.

Any text may be entered into the Search for Text Box, however, the patient’s last name or the
default search text typically works best.

Example: The CPRS Patient Search Panel with search results.

Search for Matching CPRS Patient

Search for |M2412 M/_ 2. Click

Enter zome ar all the letfers of lazt name, or SSM, or the first letter of the lazt name plus last four
digitz of S5M. Search resultaNglow [cli

1. Enter custom search filter
LI G

MHPATIEMT, OME | 000-00-2412 | 24141922 FEM&LE

\ List of possible matches
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Evaluating the results of a possible match

After a search, hopefully the off-line patient’s demographic information results in an obvious match
to the CPRS Patient, based on information stored in Vista. However, there will be exceptions, in
which case the user is forced to make a judgment of whether there is a valid match or not. To aid in
making this decision, the “Results of Match” grid displays information about the Off-Line Patient
and the selected CPRS Patient.

Example: Results of Match grid with data from two patients.

Results of Match

il Cineliel gl | LPRS Patient | The “Results of Match” grid showing the
Marme| MHPATIEMT, OME WI}NE Off-line and CPRS patients.
SSH | 000002412 0-00-2412
DOB | 034051992 211922
Sex |FEMALE FEMALE While MHAS3 offers a calculated evaluation
i P of the match, it is ultimately the user‘s
Match Confidence Level Good < responsibility to decide on the validity of a
match before uploading results to Vista
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Example: A poor match: No patient was found in the VistA database that matches the search text.
The “Search for” text filter must be changed, and a new search initiated. Try the last name.

% Mental Health Assistant |:| |§|gl
File Help
O"—Line RESUItS SynCthnizer Fick an off-ine record. find a martgglor:g.patlent in CPRS. and upload the

Off-Line Aecords

MHame SEN Dog Sex Inztrument
MHPATIENT, OMNE 9

Search for Matching CPRS Patient Results of Match
Search for: |M2413 Oiff-Line Patient CPRS Patient
Name| MHFATIENT, ONE
55N |000-00-2412
DOB | 03/05/15992

Enter some or all the letters of last name, ar SSN, ar the first letter of the last name plus last four
digitz of 55SM. Search rezults below [click on name to select).

Mame [s5m [Dog [5ex Sex | FEMALE

tatch Confidence Level Low

Delete Off-Line Record Exit
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Example: A good match: Three out of four fields match perfectly, and the search results list a single
patient. It’s possible that the unmatched field is the result of a typo or other type of data-entry

mistake.

% Mental Health Assistant

File Help

Off-Line Results Synchronizer

Fick an off-ine record, find a matching patient in CPRS, and upload the

FEH@IE“E@]_ -00-2412 | 0340541992
MHPATIENT, T'w0 000-00-2455  04/10/1940  FEMALE AUDC

record,
Off-Line Records
Mame |SSN DOE |Se:< |Instrument |Date )
MHPATIENT, ONE 000-00-2412 | 03/05/1992 | FEMALE CaGE

Search for Matching CPRS Patient

Rezultz of Match

MHPATIENT. ONE 1 FEMALE

Delete Off-Line Record

Search for (M2412 Go Oiff-Line Patient | CPRS Patient
— Mame| MHPATIENT, ONE | MHPATIEMT, ONE
Enter same or all the letters of last name, ar S5M, ar the first leter of the last name plus st four SSN | 000-00-2412 000-00-2412
digits of 55M. Search results below [click on name to select).
DOB | 03/05/1332 24141922
Mame 55N DOB Sex Sex |FEMaLE FEM&LE

tatch Confidence Level Good

Upload E it
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Uploading an Off-line Record to VistA

To upload a record to VistA:

1. Verify that the patient on the selected record is one that matches the CPRS patient.
2. Click on the Upload button.
3. Click Yes on the upload confirmation prompt
4. The additional required information prompt is displayed.
5. Enter the additional required information at the prompt, and then click Ok. The upload
confirmation prompt is displayed.
6. The selected administration record is uploaded to VistA.
7. After uploading the record, the record is removed from the list of off-line records, which
means that the record was deleted from the local file system too.
Example: To upload a record to VistA.
@ Mental Health Assistant |Z||E|E|
File Help
Ofi-Line Results Synchrc:-nizer Pick an aff-ine recard, find a martgrior:g.patient it CPRS, atd upload the
Off-Line Records

MHame

|SSN DOoE |Se:< |Instrument |Date a5

MHFATI

e o127
MHPATIEMT, T'W0 000-00-2455 041041940 FEMALE all0C 04/22/200

ENT, OME 000-00-2412 | 03/05/1332 | FEMALE CAGE 04,/22/2006 (| =
0442242005 (

5 (]

Search for Matching CPRS Patient ¥ 1. Select the desired record

Search for: |M2412 Go Ult-Ling Fahien FHS Patient
Name| MHPATIEMT, ONE | MHPATIENT, ONE
Enter some or all the letters of last name, or 55N, or the first etter of the last name plus last four SSN | 000-00-2412 000400-2412
digits of SSM. Search results below [click on name to select).

DOB | 03/05/1532 2411922

Mame

MHPATIENT, OME

55N DOB Sex Sex |FEMALE FEMA&LE

tatch Confidence Level Good

2. Click

Delete Off-Line Record Upload Exit

October 2010 MHAS3 User Manual

Patch YS*5.01*96

245



Use of the Software

Example: Upload confirmation prompt. Responding with “No” will abort the upload.

Mental Health Assistant

\:i) The DIT-2005 administered on 04/22/2005 01:51:03 PM to MHPATIENT, OME is selected to be uploaded.
-

All questions have been answered, .
Click

Are you sure you want to upload this administration?

Example: Additional required information prompt requesting Ordered By, Interviewer and Visit

Location data. Change accordingly and then click Ok.

& Mental Health Assistant

=1

MHPATIENT, ONE
DIT—2DD5 S5M- 000-00-2412
Ordered By:
MHPROVIDER OME -
Irntervigwer:
MHPROVIDER ONE =

Lo

Wizt Location

ADMISSIONS j

ok Cancel |

October 2010
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Deleting an Off-line Record

WARNING: Off-line records, by definition, have not been uploaded to VistA. Deleting a record

cannot be undone.
To delete and off-line record:

Select the record to be deleted.

Click on the Delete off-line Record button.

The delete confirmation prompt is displayed.

Click on the Yes button on the delete confirmation prompt.

PN

Example: The selected record is removed from the list of records and from the local file system.

& Mental Health Assistant |'-_||'E|E|
File Help
Ofi-Line Results Synchronizer Fick an off-line recard, find a martgslor:glpatlent in CPRS, and upload the
Off-Line Records
Marmne |SSN DOB |58H |Instrument |Date G
MHPATIENT, OME 000-00-2412 | 03/05/1992 | FEMALE CAGE 04/22/2005( =
e ] M ]
MHPATIENT, W0 000-00-8455 | 04/10/1940 | FEMALE AUDC 04,/22/2005 (|

Search for Matching CPRS Patie Reszultz of Match

Search for: |M2412 Go

Erter some or all the |etters of last name, or S5N., or the first letter 8
digitz of S5M. Search results below [click on name to select).

d record HPATIENT, ONE
o0-00-24 000-00-2412
DOE | 03/05/1992 21922

MName 55N DOB Sex Sex |FEMALE FEM&LE

1. Select the desire

MHPATIENT, OME

tatch Confidence Level Good

2. Click
3

Delete Off-Line Recard | Upload Exit
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Example: Delete confirmation prompt. Clicking on No will abort deleting the record.

Mental Health Assistant

2

The AUDC administered on 04/22/2005 02:19: 36 PM to MHPATIENT, TWO is selected for deletion.

All questions have been answered,

You will not be able to undelete this administration,

Are you sure you want to delete it?
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Exiting the Off-line Results Synchronizer Form

Example: To exit the Off-line Results Synchronizer form, click on the Exit button, or select File >

Exit from the main menu. The Off-line Results Synchronizer form is closed and the MHA3 main

form is displayed.

% Mental Health Assistant

Exit

Off-Line Aecords

Ut-Line Results Synchronizer

=3

Fick an off-ine record, find a matching patient in CPRS, and upload the

record.

MHame

MHPATIEMT, OME

03/05/1992 |FEMALE 04/25/2005 02:C

Search for Matching CPRS Patient

Search for: |M2412 Go

Enter some or all the letters of last name, ar SSN, ar the first letter of the last name plus last four
digitz of 55SM. Search rezults below [click on name to select).

Rezultz of Match
Oiff-Line Patient CPRS Patient
Mame| MHPATIEMT, OWE  MHPATIEMT, OME

MHame 55N DOB

MHPATIENT, OME

Delete Off-Line Record

55N | 000-00-2412 000-00-2412
DOB | 03/09/1332 24141922
Sex |FEMALE FEM&LE

tatch Confidence Level Good
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Single-Instrument Administrator Functions

Orientation

The Single-Instrument Administrator is useful when the goal is to quickly and frequently administer
only one instrument and there is no need to select from a list of other instruments or batteries.

Using the Single-Instrument Administrator bypasses the MHA3 Main form and the Instrument
Administrator and proceeding directly to administering the instrument.

The Single-Instrument Administrator can only be invoked from the CPRS Tools menu and requires

the Clinical Applications Coordinator to configure the Tools menu in VistA. See the Appendix F for
instructions on how to add the name of the instrument to the CPRS Tools menu.

Example: The CAGE as viewed from the Single-Instrument Administrator.

B

w- Mental Health Assistant in use by MHPROYIDER ,ONE

File Edit Wiew Action Tools Help
B Title bar e e bhoat
ne Mhpatient
CAGE SEMN: weome-2412
Administrations
Mew Date Given |Date Sawved |Ordered By |Status ] ]
— - List of previously-
11/16/2006 11,/16/2006 Mhprovider.New Co administered
10/31/2006 | 10/31/2006 | khprovider Mew Caomplete instruments.
10/30/2006 10/30/2006 Mhprovider,New Complete
10/30/2006 1043042006 Mhprovider New Complete
1N2E2N0R 1N2ES2NNAR hhnrmicer Mew Comnlete b
Eed
000-00-2412 MHPATIENT,ONE F AGE 87 05/06/2009 1Z/0Z/Z008
PRINTED ENTERED
--— CAGE ——-
2 CALLE DAV
Total 2
ore of £ orf/greater is considered clinically significant.
Report view
Not walid unless signed: Bewiewed by ... ... ... ... ... ...
Printed by: MHPROVIDER,ONE
Ordered by: MHPROVIDER, TWELVE
sxragpres
000-00-2417 MHPATIENT,OME F ALGE 87 0O5/06/2008 12/02/2008
PRINTED ENTERED
. w
Beport | Graph & Tahle
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Main Menu
The Main Menu offers user functions in the context of the Single-Instrument form, such as tools and
help.

Selected Patient Identification Label

The Selected Patient Identification label displays information about who is the currently-selected
patient within MHAS3. All functions performed in the Single-Question form will apply to this patient.

Instrument’s Name

The Title Bar is a visual artifact that is used throughout MHAS3 to display information about the
context that applies to the current activity. In this case, the Title Bar displays the current instrument’s
name.

List of Previously-Administered Tests

This is the list of all tests that have been administered to the selected patient. The list is also used for
selecting which administration to process.

Report View

The Report View displays an administration report in textual form, based on the patient’s data stored
in VistA for the selected administration.

The Navigation Tabs

These tabs are used to switch between report and graph/table view.

New button

The New button is used to start a new administration for the selected patient.

Edit Button

In the case that the selected administration is “editable”, based on how long ago it was administered,
the Edit button becomes enabled and can be used to trigger editing of the selected administration.

October 2010 MHAS3 User Manual 251
Patch YS*5.01*96



Use of the Software

Graph & Table

Graph View

Example: The Graph View displays a graphical representation of test data values over time.

. Mental Health Assistant in use by MHPROVIDER ,ONE =19
File Edit WYiew Tools Help

. . One Mhpatient
Instrument Results Review: CAGE SEN: 002412

Total

ol : : : :
11/22/2004 03/25/2005 08/09/2005 12/23/2005 06/09/2006 10/26/20086 \ 12/01/2008
Scores Graph view
L. o ooy o i

11/22/2004  |11/22/2004  (11/22/2004 |11,122,-"ZDD4 |11,-"22,-"2004 |D1,-"20,-"2DDS |D1,128,-"2

CAGE total
Total 0 1 1 1 0 2 2 1 1

.

| Bepors Graph & Table

Table View

The Table View represents the same data as the Graph View, except that it is in table format. The
Table View also functions as a means for selecting which administrations and characteristics to
represent on the graph.
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Example: The Splash screen is shown upon start up.

Loading CAGE...
P
y od
he)
et Hispane
hic,
. pTSD
R (P"JD”'OV.. sD eteral
than PTSY 2.V

Liatric, 0 es

o

stric

uml. non- 1 d“"

ave blank if not e
m w (u'ldud'm Fr ........
m“ ......... ion to this P
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Invoking the Single-Instrument Administrator from the CPRS Tools Menu

The only way to invoke the Single-Instrument Administrator is from the CPRS Tools menu. In
addition to the Mental Health Assistant, individual instrument types may be added to the CPRS tools
menu, from which the Single-Instrument Administrator is started for any particular instrument type.
To configure single instruments on the CPRS Tools menu, The Clinical Applications Coordinator
needs to add a set of parameters to the user’s VistA CPRS GUI Tools menu. See Appendix F for
instructions.

NOTE: If the instrument’s name entry is missing from the Tools menu, users should contact their
Clinical Applications Coordinator for assistance.

In the following example, to start CAGE, start CPRS first. Then, once CPRS has settled, click on the
Tools menu item, followed by a click on the CAGE menu item.

If CAGE starts normally, the “splash” form is displayed briefly, followed by the Single-Instrument
Manager form, as shown below.

NOTE: If CAGE asks the user to logon to VistA again, users should contact their local IRM to
inquire about the availability of Single Sign-on.

Example: The CAGE instrument type is started in the Single-Instrument Administrator.

& VistA CPRS in use by: Mhprovider,One (COR-FO-ALBANY)
File Edit WView REEEN Help

MHPATIENT.0  Mental Health Assistant  jected Primary
000-00-2412 F er Mat Selected

Active Problems Lab.Test In !! :ahnn. " erze Feactions
......... Mo Problems Fy  Options... essment

Active Medications Chrical Remir
Mo Active Medications Found Prieurmovas
Breaszt Exam
October 2010 MHA3 User Manual 254

Patch YS*5.01*96




Use of the Software

Example: The Single-Instrument Administrator form.

%- Mental Health Assistant in use by MHPROVIDER,ONE (=] E3]
File Edit Wiew Action Tools Help
One Mhpatient
CAGE SN w2412
Administrations
e Date Given |Date Sawved | Ordered By Status S
11/16/2006 11/16/2006 Mhprovider, New Complete =
1043172006 10/31/2006 Mhprovider,New Complete
10/30/2006 10/30/2006 Mhprovider New Complete
10/30/2006 10/30/2006 Mhprovider, New Complete
1N2E200R 1NA2ELIN0R khorowider Mew Comnlete M
F
000-00-2417 MHPATIENT,ONE F AGE 87 05/06/2009 12/02/2008 F
PRINTED ENTERED
--- CAGE ——-

& CALE LDAW

Total 3
A total score of £ or greater is considered clinically significant.

Not walid unless signed: PBewiewed by ... ... ...t ittt i e e nea s
Printed by: MHPROVIDER,L ONE
Ordered by: MHPROVIDEER, TWELWE

*EkgoprEE

000-00-Z412z MHPATIENT,ONE F AGE 87 05 0572002 1lESOZsEZ00E
FREINTED ENTERED
o b
Beport | Graph & Tahkle
October 2010 MHA3 User Manual 255

Patch YS*5.01*96



Use of the Software

Starting a New Administration

Example: To start a new administration, click on File > New... or click on the New button.

& Mental Health Assistant in use by MHPROYIDER ,ONE

M Edit view Action Tools Helg
EY, Click here... One Mhpatient
Select Patient... SEMN: 0002412
3ave As.. > Administrations
Print... 3
o Date Given |Date Sawved |Ordered By Status 2
Bt T116/2006 11/16/2006 Mhprovider, New Complete =
10431/2006 10/31/2006 Mhprovider, New Complete
100302006 10/30/2006 Mhprovider, Mew Complete
10/30/2006 10/30/2006 Mhprovider, New Carmplete
108 RS ONER 102 R NNR bdhorneader M e Comnlete v
A
000-00-2412 MHPATIENT, ONE F AGE 87 05/06/2009 1270272008 T
FLRINTED ENTERED
-—— CAGE —--
5 CALE DRAW
Total 3
L total score of Z or greater is considered clinically significant.
Mot walid unless signed: Bewviewed By ... .o ii oot on i e m e e ameae
Frinted by: MHPROVIDER,ONE )
Ordered by: MHPEOVIDER, TWELVE
*rragpEEt
000-00-2412 MHPATIENT,ONE F AGE 87 05/06/2009 12/0Z/2008
FLRINTED ENTERED
N b
Beport | Graph & Tahle
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Example: The Instrument Administrator form for a single-type of instrument. This form combines
the instrument Administrator and the Instrument Results Review functions on a single form.

w. Mental Health Assistant in use by MHPROVIDER,OME =13
File Edit Wiew Action Tools Help
One Mhpatient
CAGE ve. OF here SEN: woexe-2 412
Administrations
Date Given |Date Sawved |Ordered By Status -
11/16/2006 11/16/2006 Mhprovider, New Complete E
1043172006 10/31/2006 Mhprovider New Complete
10/30/2006 10/30/2006 Mhprovider Mew Complete
10/30/2006 10/30/2006 Mhprovider, New Cormplete
1N2E200R 1NA2ESLNNR kdhormider Mew Comnlete M
.Y
000-00-2417 MHPATIENT,ONE F AGE 87 05/06/2009 12/02/2008 b
PRINTED ENTELRED
--- CAGE ——-
5 CALE DAV
Total 3
A total score of £ or greater is considered clinically significant.
Not walid unless signed: Bewiewed by .. ...ttt i et teea e naa s
Printed by: MHFROVIDER,ONE .
Ordered by: MHPROVIDER, TWELWE
*rragprEt
000-00-2412 MHPATIENT,ONE F AGE 87 05/06/2009 1Z/0Z/Z008
PRINTED ENTELRED
[ e
Beport | Graph & Tahle
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Selecting Another Patient

Example: To select another patient, click on the File > Select Patient... menu item. The CPRS
patient-selection dialog box is displayed and the user is able to select a different patient, after which
the MHA patient synchronizes with the CPRS patient.

@ Mental Health Assistant in use by MHPROYIDER,OME
FEN Edit Yiew Action Toaols  Help

One Mhpatient
SEN: o242

Administrations

Date Given |Date Saved | Ordered By Status S

11/116/2006 11/16/2006 Mhprovider,New Complete =

10/31/2006 10431/2006 Mhprovider New Complete

10/30/2006 10/30/2006 Mhprovider.New Complete

10/30/2006 10/30/2006 Mhprovider, New Complete

12 R2N0R 12RPNA hhorredicder e Cnmualete bt
4

000-00-241% MHPATIENT,ONE F AGE 87 05/06/2009 12/02/2008
PRINTED ENTERED
--- CAGE ---

S CALE BRAN

Total &l
A total score of £ or greater is considered clinically significant.

Not walid unless signed: Bewiewed by .. ...ttt i et teea e naa s
Printed by: MHPROVIDER,ONE
Ordered by: MHFROVIDEER, TWELVE

EEFQopEEE

000-00-Z412 MHPATIENT,ONE F AGE 87 0OL5/06/7Z00% 1Z/0Z7Z00%8
PRINTED ENTERED
o A
Beport | Graph & Table
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Saving a Graph, Report, or a Table to a File

To save a graph, report or table, click on File > Save As... menu item and then click on Graph,
Report or Table. To save a graph or a table, the “Graph and Table” tab must be selected first.

Example: A Mental Health Assistant message dialog appears that asks the user to enter a filename
and storage location for the table, report or graph file to be saved. A graph is saved as a bitmap, a
table is saved as an Excel file and a report is saved as a text file.

& Mental Health Assistant in use by MHPROYIDER ,ONE

GIEN Edit  Wiew action Tools Help
Mewa, .. . .
Click One Mhpatient
Select Patient... / - BEN: oorwe2412
Report ‘lstrations
Graph Given |Date Sawved |Ordered By Status >
TT1/18/2006 11/16/2006 Mhprovider,MNew Complete =
1043172006 10/31/2006 thprovider,MNew Complete
10/30/2006 10/30/2006 thprovider New Complete
10/30/2006 10/30/2006 thprovider New Complete
102 RIPNNA 102 A2 NNR kdhnrosdcder Mew Comulete b
LY
000-00-2412 MHPATIENT, ONE F AGE 87 05/06/200% 12/02/2008 y
TRINTED ENTELED
——- CAGE —--
5 C 4L E DAW
Total &l
A total score of £ or greater iz considered clinically significant.
Mot walid unless signed: Reviewed by ... .. ... ... ... ........
Frinted by: MHPROVIDER, ONE B
Ordersd by: MHPROVIDER, TWELVE
srragprEE
000-00-2412 MHPATIENT, ONE F AGE 87 05/06/200% 12/02/2008
TRINTED ENTELED
e b
Beport | Graph & Tahle
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Example: Save As form.

Save i |B by Documents

IChAnnual Leave CMHASZ [ My irkual Machines
ICiCreatar [Ty eBooks &) TestBlug)
IChedipse @My Music lﬂTest Scores.bmp
I)Elementk. Classes EM}.H Pictures )
|5)Email Archive |=3My Received Files Type a new filename, or
I GAF @MY videos keep the default
e

File name: .zt Scores.bmpl
Save az twper | Bitmap files [*.brp] j Cancel
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Printing a Graph, Report, or Table

Example: To print a graph, report or table, click on File > Print menu item and then click on Graph,
Report or Table. A copy of the table, report or graph is sent directly to the default printer.

%. MentalHealth Assistant in use by MHPROVIDER,ONE [=1E3]
EN Edit  Wiew Action Tools Help
Mew... One Mhpatient
Select Patient. .. SEMoomcz412
Save As... acdmindtrations
iven |Date Sawved |Ordered By Status A
Exit
- Graph 2006 11M16/2006  Mhprovider New Complete =
10431/2006 10431/2006 thprovider New Complete
10/30/2006 10/30/2006 thprovider New Complete
10430/2006 10430/2006 Mhprovider,New Complete
102 R200R 102 R T0R tdhornwider Mew Comnlete L
£y
000-00-2412 MHPATIENT,ONE F AGE 87 05/06/2009 1Z/0Z/Z008 T
PRINTED ENTERED
--- CAGE ---
3 CALE DAV
Total o}
A total score of 2 or greater is considered clinically significant.
Not walid unless signed: Bewiewed by ... ..o ...l ao.
Printed by: MHPROVIDER,CONE _J
Ordered by: MHFROVIDER, TWELVE
srragprrE
000-00-2417 MHPATIENT, ONE F AGE 87 05/06/2009 1Z/0Z/Z008
PRINTED ENTERED
o bt
Bepont | Graph & Tahle
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Use of the Software

Copying a Graph, Report, or Table to the Windows Clipboard

Example: To copy a report, graph or table to the Windows clipboard, click on Edit > Copy menu
item and then click on Graph, Report or Table. A copy of the table, report or graph is sent to the
Clipboard. The contents of the Clipboard can then be pasted onto an MS Word or Excel document.

% Mental Health Assistant in use by MHPROYIDER ,ONE

File NGl Yiew Action Tools Help
One Mhpatient
SEN: o242
ew Date Given rdered By Status 5
11/16/2006 hproviderMNew Complete =
10431/2006 10/31/2006 thprowvider New Complete
104302008 10/30/2008 hhprovider New Cormplete
10/30/2006 10/30/2006 Mhprovider,New Camplete
1NM2RL2TNR 10/2RA2N0R hdhormniacder e Comnlete v
.Y
000-00-2412 MHPATIENT,ONE F AGE 27 05/06/2008 12/02/2008 3
DLINTED ENTERED
-—- CAGE ---
2 CALE PAW
Total 3
A total score of 2 or greater is considered clinically significant.
Not walid unless sigmed: Peviewed by ... .. ... .. ... ....
Printed by: MHPROVIDER,ONE B
Ordered by: MHPROVIDEE, TWELVE
rrragprre
000-00-2412 MHPATIENT, ONE F ABE 87 05/06/2008 12/02/2008
PRINTED ENTERED
I b
Bepont | Graph & Table
Example: The Mental Health Assistant message dialog box is display after copying to the
clipboard.
Mental Health Assistant |
i ] The table has been copied ko the Windows clipboard.
If vou like, wou may paste it into an open MS Excel spreadsheet,
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Use of the Software

Switching View from Reports to Graph &Table and Back

Example: To switch between views, click on View > Reports and View > Graph & Table to
switch between views on the form. The navigation tabs at the bottom-left of the form serve the same

purpose.

& Mental Health Assistant in use by MHPROVIDER . ONE
File Edit BUEEN Action Tools Help

Click here... One thpatient
Show values on graph
Administrations
e Date Given |Date Saved |Ordered By |Status 5
11/16/2006 11/16/2006 Mhprovider,New Complete =
10/31/2006 10/31/2006 thprovider New Complete
10/30/2008 103042006 hhprovider Mew Cormplete
10/30/2006 10/30/2006 MhproviderNew Caomplete
10/2R2N0R 1N2R200R tdhornwidder Mew Cnmibleta b
Eey
000-00-24127 MHPATIENT,ONE F AGE 87 05/06/2008 1270272008 T
PRINTED ENTERED
--- CAGE —-—-
% CA4LE RAW
Total ]
AL total score of £ or greater is considered clinically sigmificant.
Mot walid unless signed: Reviewed by ... .. ... ... ... ... ..-....
Printed by: MHPROVIDER,ONE 3
Ordered by: MHPROVIDER, TWELVE
e
... or here
000-00-2412 MHPATIERS, ONE GE 87 05/06/2009 12/02/2008
PRINTED ENTERED
[ b
Beport | Graph & Tahle |
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Use of the Software

Switching to MHA3 Main Menu

Example: While the Single-Instrument Administrator initially bypasses MHA3 Main form, it offers
a way to return to the Main form. Click on the Action > MHA Main Menu item.

w- Mental Health Assistant in use by MHPROYIDER ,ONE

File Edit Wiew M Tools  Help
: One Mhpatient
CAGE Click SEN: 000002412
Administrations
Mew Date Given |Date Sawved |Ordered By Status .
11/16/2006 11/16/2006 Mhprovider, New Complete E
10/31/2006 10431/2006 Mhprovider New Complete
10/30/2006 10/30/2006 Mhprovider Mew Complete
10/30/2006 10/30/2006 Mhprovider, New Complete
1N2E200R 1NA2ESLNNR kdhormider Mew Comnlete M
-
000-00-2412 MHPATIENT,ONE F AGE 87 0570672009 1270272008 b
PLINTED ENTELED
-—- CaGE —---
5 CALE DAV
Total 3
A total score of £ or greater is considered clinically significant.
Not walid unless signed: Bewiewed by .. ...ttt i et teea e naa s
Printed by: MHPROVIDERL,ONE ]
Ordered by: MHPROVIDER, TWELVE
FEEagpEEE
000-00-2412 MHPATIENT,ONE F AGE 87 0570672009 1270272008
DPLINTED ENTELED
- hs
Beport | Graph & Tahle
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Use of the Software

Editing an Existing Editable Administration

To edit an administration:

1.
2.
3.
4.

Example: Editing an administration.

If the selected administration is editable the Edit button will be enabled.
Find and select an editable administration.

Click on the Edit button.

Administrations older than twenty-four hours are not editable.

%. Mental Health Assistant in use by MHPROVIDER ONE =3
Eile Edit Wiew Action Tools Help
cace oot
Administrations
ey Date Given |Date Saved | Ordered By Status 25
05/06/2009 |05706/2009 (MHPROYIDER.ONE Incomplete: Editable —
04/16/2009  05/16/2003  Mhprovicer One Complete
04/06/2009 05/06/2009 Mhprovider,One Complete
1240252008 120252008 Mhprovider, Twelve Complete
1201/2N0A 12M1/2N0A hhorowider Twealve Cnmulete bt

Incomplets instrumenty do not hawe reports.

Biepont | Graph & Tahle
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Use of the Software

Exiting the Single Instrument Administrator Form

Example: To exit the Single Instrument Administrator form, click on File > Exit menu item. The
Single Instrument Administrator form closes and the user is returned to the MHA3 Main form.

%. MentalHealth Assistant in use by MHPROVIDER,ONE [=1E3]
EN Edit  Wiew Action Tools Help

Mew... One Mhpatient
Select Patient. .. SEN ez 12
5‘3}"'3 As... r Administrations
Pt ’ Date Given |Date Saved |Ordered By Status A
05/06/2009 |05/06/2009 |(MHPROVIDER.OMNE Incomplete: Editable
04/16/2009 05/06/2009 thprovider.One Complete
04/06,/2004 0R/06/20049 thprovider.One Complete
12f02/2008 12f02/z2008 Mhprovider, Twelve Complete
120142008 12MN12008 thorovider Twealve Comnlete b,

Incomplete inst.ru.mth.s do not have reports.
Click

Beport | Graph & Table
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Use of the Software

Selecting a Person (other than yourself) for Instruments Ordered By

To identify the Ordered By person:

Click on the Drop-Down List Box labeled Instruments Ordered By.

From the Ordered By list, select the name of the desired staff member.

The selection list folds up and the selected name is displayed in the box.

The Ordered by person will receive an email notification in VistA regarding this
administration.

PoppE

Example: The selected name also appears as the Ordered By person in all reports related to this
administration. By default the current user’s name is selected.

@ Mental Health Assistant in use by MHPROYIDER ,ONE

One Mhpatient
CAGE . Sl o241
Display:

o+ All Questions at Once.

Interviewer:

|MHPRGWDERDNE j " One Question ata Time.

Date of Administration:

| 5/ B/2003 M
Yisit Location:
|1 Test (north] ~|
’ Staff Entry Fatient Entry
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Use of the Software

Selecting a Person for Interviewer

To select an interviewer:

1. Click on the Drop-Down List Box labeled Interviewer.
2. Select your name from the list.

3. The Drop-Down List Box folds up and the selected name is displayed in the text box.

Example: By default, the current user’s name is selected. The selected name also appears as the

Interviewer or Printer person in all reports related to this administration.

& Mental Health Assistant in use by MHPROVIDER ,ONE

CAGE

Crdered By:
WHPROWIDER, Qi

Interviewer:
|MHPF{GVIDERDNE .

Date of Administration:

One Mhpatient
SEM: w2412

Display:

o+ All Questions at Once.

" One Question ata Time.

o e -
Yisit Location:
|1 Test (north] ~|
’ Staff Entry Fatient Entry
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Use of the Software

Selecting Date of Administration

To select a date of administration:

1. Click on the Date-Picker labeled Date of Administration.
2. Select a random date from the calendar.
3. The Date-Picker folds up and the selected date is displayed in the box.

Example: By default, today’s day is selected. The selected date also appears as the date in all reports
related to this administration.

o Mental Health Assistant in use by MHPROVIDER ONE M=E3
Cne hhpatient
CAGE Sal w2412
Crdered By Display:
MHPROVIDER, ONE -
v All Questions at Once.
Interviewet:
|MHPROWDERDNE j " One Cuestion ata Time.

Date of Administration: 1. Click to open calendar
5/ 62009 el

[ 4| May, 2009 [ |

Sun kMon Tue Wed Thu Fri Sat
1 2
3 A a» 7 5 9 ’ Staff Entry Eatient Entry
A U I N R O
17 18 14 21 22 23
&4 25 26 28 29 30
a1

¢ Today: 5/6/2009 2. Click on a date
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Use of the Software

Selecting Visit Location

To select a Visit Location:

1. Click on the Drop-Down List Box labeled Visit Location.
2. Select the desired location from the list.
3. The Drop-Down List Box folds up and the selected location is displayed in the box.

Example: The selected location also appears as the location in all reports related to this
administration.

o Mental Health Assistant in use by MHPROVIDER ONE M=
COne bdhpatient
CAGE SaM oo-e-2412
Ordered By Display:
MHPROVIDER, ONE -
v All Questions at Once.
Interviewet:
|MHPHOWDEHDNE j " One Cluestion ata Time.

Date of Administtation:

| 5/ 5/2003 -
j/_ 1. Click to open list

7 Aty J ’ Staff Entry ] [ Eatient Entry ]

== Armbulatory Surgery
Auto-Febook Clinic
Chp Evaluation
Cardiology
Cardiology Prn After 4:30 j
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Use of the Software

Selecting Display Mode for Data Entry

Example: To select a Display mode, click on One Question at a Time display mode or click on All

Questions at Once display mode. The Display mode Option Button is checked based on selection

made.

& Mental Health Assistant in use by MHPROYIDER ,ONE

Select Display mode
Irdered By _\ Display:

IMHPROVIDER. ONE -

' Al Questions at Once.
Interviewer:

IMHPROVIDER. ONE -

" Dne Question at a Time.
Date of Administration:

| 5/ 5/2008

Le

Le |

’ Staff Entry

S[=1/3

One Mhpatient
DS w2412

Fatient Entry
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Use of the Software

Selecting Patient Entry Data Entry Mode

To select Patient Entry mode:

1. Click on a Display mode

2. Click on Patient Entry button

3. Click on Yes to first warning message

4. Click on OK to second warning message

Example: The Single-Question form or the All-Questions form is displayed, depending on which
button was clicked.

o Mental Health Assistant in use by MHPROVIDER ONE =13

One Mhpatient
SEM w2412

1. Select Display mode

Display:

All Questions at Once.

Intersiewer:

|MHPRDWDERDNE j " One Cuestion ata Time.

Date of Administration:
| B/ 5/2003 2. Click on Patient Entry
Yisit Location:
1 Test (north) j

’ Staff Entry Eatient Entry
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Use of the Software

Example: Any time that Patient Entry mode is invoked, two warning messages are displayed.
These messages are an indication that SecureDesktop is about to be activated. SecureDesktop

warning #1.

SecureDesktop Warning r5_<|

WARNING

From thiz point on, the veteran will be answenng guestions on the
inztruments selected. To maintain security, all ather functions on thiz
computer will be unavailable.

Al unzaved wark in other programs should be zaved and the
programs clozed before continuing.

YWhen yau have finished, this computer will automatically return o
the log-on window.

AFTER COMPLETING THE TEST([S]. USER IS AUTOMATICALLY
LOGGED OFF FROM THE SYSTEM

Lo pou wigh bo continue?
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Use of the Software

Example: SecureDesktop warning #2.

SecureDesktop Warning

WARNING

USE OMLY ALPHA-MUMERIC KEYS ON THE KEYEOARD.

[1zing any ather kevs will cause the test ta abart.
All keystrokes are monitared for security violations.
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Use of the Software

Example: “Single-question” data-entry form.

g CAGE: MHPATIENT ,ONE
File “iew Tools Help

Flease read each item carefully and select the answer that bestdescribes you.

1. Hawe vou ever felt vou should cut down on your drinking?
1 Yes

2 Mo

CAGE

l Mext Question ] [ Erior Question ] lBeviewAnswers] [ Cancel

Use speedtab & Use the number key of the item to speed data entry.

[ l
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Use of the Software

Example: “All-questions” data-entry form.

w. CAGE: MHPATIENT ,ONE

File ‘iew Tools Help

One Mhpatient
CAGE SEMN: o212

Pt

Flease read each item carefully and selectthe answer that bestdescribes vou.
1. Hawe you ever felt you should cut down on wour drinking?
1. Yes

2 No

2 Hawve people annoyved wou by criticizing wour drinking?
1 Yes

2 Mo

3. Hawe you ever felt bad or guilty about ywour drinking?
" 1.%es

2 Mo

4, Hawve you ever had a drink first thing in the morming to steady vour nerves orto getrid of a hangower (an eve opener)?  —
71 Yes

2 Mo

CAGE

Hint: Use the nurber key of the item to speed data entry.

[ ]

October 2010 MHAS3 User Manual 276
Patch YS*5.01*96



Use of the Software

Selecting Staff Entry Data Entry Mode

To select Staff Entry mode:

1. Click on a display mode.
2. Click on Staff Entry button.

Example: The Single- Question form or the All-Questions form is displayed, depending on which
button was clicked.

@ Mental Health Assistant in use by MHPROVIDER ,ONE

. One Mhpatient
1. Select Display mode SEM: wooee-241 2
\Display:

Ordered By

"BROWID
o All Questions at Once.
Interviewer:

MHPROYIDER ONE -

" One Question ata Time.

Diate of Administration:

| 5/ 62009 | 2. Click on Staff Entry mode

Yisit Location:
1 Test (narth) -

’ Staff Entry Fatient Entry
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Use of the Software

Example: “Single-Question” data-entry form.

@ CAGE: MHPATIENT ,ONE
File “iew Tools Help

Flease read each itern carefully and selectthe answer that bestdescribes wou.

1. Hawe vou ever felt wou should cut down on yaur drinking?
1. Yes

" 2 No

CAGE

l Mext Question ] [ Frior Question ] lBeviewAnswers] [ Cancel

Use speedtab & Use the number key of the item to speed data entry.
[ |
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Use of the Software

Example: All-questions data-entry form.

w. CAGE: MHPATIENT ,ONE

File ‘iew Tools Help

One Mhpatient
CAGE SEMN: o212

Pt

Flease read each item carefully and selectthe answer that bestdescribes vou.
1. Hawe you ever felt you should cut down on wour drinking?
1. Yes

2 No

2 Hawve people annoyved wou by criticizing wour drinking?
1 Yes

2 Mo

3. Hawe you ever felt bad or guilty about ywour drinking?
" 1.%es

2 Mo

4, Hawve you ever had a drink first thing in the morming to steady vour nerves orto getrid of a hangower (an eve opener)?  —
71 Yes

2 Mo

CAGE

Hint: Use the nurber key of the item to speed data entry.

[ ]
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Use of the Software

Appending Comments to an Existing Record

To append a comment to an existing record:

1.
2.
3.
4.
S.
6.

Example: Mental Health Assistant Main Menu form.

Click on Tools > Append comments... menu item

The Comments Editor Form is displayed

Type a new comment in the Comments Editor

Click on File > Save Comment in the Comments Editor menu
Click on File > Exit, to close Comments Editor

Comment appears appended to the administration’s report text

w- Mental Health Assistant in use by MHPROYIDER ,ONE

File Edit Wiew Action B
&ppend Caorv S One Mhpatient
CAGE METRIC Inskrument Reviews S . SN )CO(—):[)J(-2412
: Click
Cptions...
NE Date Given | Date Saved |Ordered By |Status 25
050642009 05/06/2009 MHPROVIDER.ONE Incomplete: Editable n
05/06/2008  (Mhprovider,One Camplete
04/06/2009 05/06/2009 Mhprovider.One Complete
12022008 1240242008 Mhprovider Twelve Complete
12012008 12012008 kMhnrowider Twealee Comnlete b
s
Qoo-00-z41Z MHPATIENT,OME F AGE 27 0E/0&/z00% 0471672009 F
PRINTED ENTERED
--- CAGE --—-
& C AL E ERAT
Total Z
A total score of 2 or greater is considered clinically significant.
Not walid unless signed: Bewiewed by .. ...ttt i et teea e naa s
Printed by: MHPROVIDER, ONE
Ordered by: MHPROVIDER,L ONE
FrraapEEE
Qoo-00-z41Z MHPATIENT,OME F AGE 27 0E/0&/z00% 0471672009
PREINTELD ENTEREL
--- CAGE --—- Z
Beport | Graph & Table
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Use of the Software

Example: Comments Editor Form.

% Append Comments E]E]
File Help
CAGE 04/16/2009 S8 mon2?

Presvious Comments

Mone

MNew Comments

\ Type comments here
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Use of the Software

Example: Save Comment and Exit.

w- Append Comments |:||§|fgl
File Help
CAGE 04/16/2009 sS4 wran?

Presvious Comments

Mone

MNew Camments
These are my new comments for CAGE administration]

Example: Comments added to CAGE note.
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Use of the Software

w- Mental Health Assistant in use by MHPROYIDER,ONE
File Edit Wiew Action Tools Help

One Mhpatient
CAGE SSM: oom-2412

Administrations

e Date Given |Date Saved |Ordered By Status A
05/06/2009 05/06/2009 MHPROYIDER.OME Incomplete: Editable N

04/06/2009 Mhp Complete
1200252008 120252008 Mhprovider Twelve Complete
12401/2008 12M1/2nng Mhnrowider Twelee Cnrmtlete b
Not walid unless signed: BRewiewed by ... ... .. ... ...... ﬁ
Printed by: MHPROVIDER,L ONE
Ordered by: MHPROVIDER,ONE
ErEragprEE
000-00-241%Z MHPATIENT,ONE F AGE 87 0570672005 0471672003
PRINTEL ENTEERELD
--- CAGE ---
—--— ITEM RESPONSES --—-
17T EN 3T 4 N
S I T B = e e e o e o e e S T e S O T S s
***  Comment Entered By: MHPROVIDER,ONE Comment Date: O05/056/Z003 11:47:55 AM
These are my new comments for CAGE adwministration.
v
Beport | Graph & Tahle
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Glossary

The following terms are associated with the Mental Health Assistant 3 software application release:

TERMS DESCRIPTIONS

API: Application Programmer Interface

ASI: Addiction Severity Index

CLIENT: A computer that accesses shared network
resources provided by another computer (called
a) server.

CLOSE: Closes the window. If there are any changes that
have not been saved, you will get a confirmation
message asking you if you want to continue
without saving; save before exiting; or cancel the
close action and return to the window.

CPRS: Computer Patient Record System

DBIA: Database Integration Agreement

DESKTOP: The backgrpund on your, on which windows,
icon, and dialog boxes appear.

EDIT BOX This is a box where the user can type in free text

using the keyboard.

ELEMENT NAME:

Globally unique descriptive name for the field.

An ‘enhancement’ to an already existing Class I

ENHANCEMENT: software package is the introduction of new or
improved functionality.
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Glossary

TERMS

DESCRIPTIONS

FTP:

File Transfer Protocol

GAF:

Global Assessment of Functioning

GROUP:

In User Manager, an account containing other
accounts that are called members. The
permissions and rights granted to a group are
also provided to its members, which makes
groups a convenient way to grant common
capabilities to collections of user accounts. For
Windows NT, groups are managed with User
Manager. For Windows NT Server, groups are
managed with User Manager of Domains.

GUI:

Graphical User Interface.

HL7:

Health Level 7

IMR:

Information Resources Management

LENGTH (LEN):

The maximum number of characters that one
occurrence of the data field may occupy.

LIST BOX:

Box that shows a list of items. If more items exist
than can be seen in the box, a scroll bar appears
on the side of the box. Selecting an entry from a
list box requires either double clicking the entry
or single clicking the entry and pressing the
spacebar.

MHP:

Mental Health Package
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Glossary

TERMS

DESCRIPTIONS

OK COMMAND BUTTON:

Adds the new entry after the data has been
entered.

OPTION BUTTON:

A small round button that appears in a dialog
box. Within a group of related option buttons,
you can select only one button at time.

PACKAGE:

An icon that represents an embedded or linked
object. When you choose the package, the
application that was used to create the object
either plays the object (such as sound file) or
opens and displays the object.

PASSWORD:

A unique string of characters that must be
entered before a logon or an access is authorized.
A password is a security measure used to restrict
logons to user accounts and access to computer
systems and resources. For Windows NT, a
password for a user account can be up to 14
characters long and is case-sensitive.

PATH:

Specifies the location of a file within the
directory tree. For example, to specify the path of
a file named README.WRI located in the
WINDOWS directory on drive C, you would
type c:\windows\readme.wri.

PID:

Patient Identification
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Glossary

TERMS

DESCRIPTIONS

PREVIOUS:

Previous enable the user to return to a previously
answered question so the answer can be changed.

PSYCHOLOGIST:

Performs patient care duties in accordance with
Clinical Privileges as assigned or granted by the
appropriate governing committee in the area of
Psychology and Mental Health. This may include
individuals, family and group counseling and
psychotherapy, assertiveness, and other behavior
training, etc.

RADIO BUTTON:

Radio buttons appear in sets. Each button
represents a single choice and normally only one
button may be selected at any one time. For
example, MALE or FEMALE may be offered as
choices through two radio buttons. Click in the
button to select it.

RIGHT MOUSE BUTTON or
SHIFT F10:

You may click the right mouse button or press
Shift F10 for a popup box of menu items.

RPC BROKER:

Remote Producers Call Broker
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Glossary

TERMS

DESCRIPTIONS

RPC:

Remote Producers Call, a message-passing
facility that allows a distributed application to
call services available on various computers in a
network. Used during remote administration of
computers.

Save to File (Save AS):

This is a standard feature of Microsoft
applications where the user can type the name of
the file to be saved. The user can also define the
drive and directory where the file is to be saved.
In some cases the file name presented in the edit
box is sufficient and the user merely needs to
click on the “Ok” button to save the file.

SHARE:

To make resources, such as directories, printers,
and ClipBook pages, available to network users.

Status Bar:

A line of information related to the application
running in the window. Usually located at the
bottom of a window. Not all windows have a
status bar.

Task List:

A window that shows all running applications
and enables you to switch between them. You
can open Task List by choosing Switch To from
the Control menu or by pressing CTRL=ESC.
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Glossary

TERMS

DESCRIPTIONS

Tab Key:

Use the TAB key or the mouse to move between
fields. Do not use the RETURN key. The
RETURN key is usually reserved for the default
command button or action (except in menu
fields).

TCP/IP:

Transmission Communication Protocol/Internet
Protocol

TEXT BOX:

Type the desired characters into the edit box. The
selected entry will not be effective until you tab
off or exit from the text box.

TOOLBAR:

A series of shortcut buttons providing quick
access to commands. Usually located directly
below the menu bar. Not all windows have a
toolbar.

TRANSPORT LAYER:

The fourth layer of the OSI model. It ensures that
messages are delivered error-free, in sequence,
and with no losses or duplications. This layer
repackages messages for their efficient
transmission over the network. At the receiving
end, the Transport layer unpacks the message,
reassembles the original messages, and sends an
acknowledgement of receipt.

UID:

Unique Identifier
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Glossary

TERMS DESCRIPTIONS
VA: Veterans Administration
VHA: Veterans Health Administration
VAMC: Department of Veterans Affairs Medical Center
VERA: Veterans Equitable Resource
VISN: Veterans Integrated Service Network
VistA: Veterans Health Information Systems and

Technology Architecture

WORKSTATION:

In general, a powerful computer having
considerable calculating and graphics capability.
For Windows NT, computers running the
windows NT operating systems are called
workstations, as distinguished from computers
running Windows NT Server, which are called

SEervers.

Glossary of Graphical User Interface (GUI) components used in Mental Health

Assistant 3 (MHAS3)

Component/Terms

Descriptions

Multiple-Selection List Box

1. Pick o rumbers

1. Ore
v 2 Two
3. Thies

v ENT I

A Multiple-Selection List Box permits
selection of one or more choices from a list
of choices. Simply click on the little boxes
next to the selection’s text and a check-mark
symbol appears in the box, indicating your
selection.

Drop-Down Combo Box

A Drop-Down Combo Box contains a
“hidden” list that is not visible until the user
clicks on the button with the down-arrow
icon. Then, the list appears and an item can
be selected from the list. Click on the item
that you wish to select. Drop-Down Combo
Boxes also accept typed text in the
component’s Text Box. Some Drop-Down
Combo Boxes are used to display data
directly from VistA files, such as a list of
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Glossary

Wizt Location
TAL DISTRESS COUMNSELING B3
MARITAL DISTRESS COLMSE IS
MEDICAL TRIAGE
MORT
NEUROLOGY
MWOM-COUMT
WNOM-COUMT CREDIT

MUR 1 TEST
MUR 1WEST e

staff members.

Drop-Down List Box

2. Pick one number

A Drop-Down List Box contains a “hidden”
list that is not visible until the user clicks on
the button with the down-arrow icon. Then,
the list appears and an item can be selected

|1 Tine = from the list. Click on the item that you wish
— to select. Unlike Drop—_Down Combo Boxes,
4 Fou no text can be entered into the Text Box part
of the component.
Text Box Text Boxes allow for typing a relatively

B Whal is pour fiest name?

small amount of text—generally, the length
of a single line of text, or less. Normally,
Text Boxes accept any text characters typed

[ohn . _
into them. However, in some cases, Text
Boxes are restricted to accept only a pre-
defined group of characters. For instance,
only accepting integer or currency values.
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Date-Picker

2. Erter any dale:

4 72005 -

sun Mon Tue Wed Thu Fn 5at
1 2
3 4 5 £ @ B 9

WD 12 13 14 15 16
17 18 19 20 A 2 23
4 X B T B AN

T Today: 471172005

L

A Date-Picker component offers two ways of
entering date information. The first is to type
in the date in the Text Box part of the
component while observing the displayed
format. Another way to pick a date is to click
on the button with the down-arrow icon,
which triggers the display of the visual
calendar. By default the calendar displays the
current month. Other dates can be navigated
to by clicking on the name of the month, the
year, and the side-arrows. To pick a date,
click on the day number on the calendar.

Single-Selection List Box

7. Fick one number

A Single-Selection List Box displays all
available choices at once, from which only
one of the mutually-exclusive selections may
be made.

Masked Text Box

9. Enter a phone numbe;

[B01) 9665442

A Masked Text Box is a special kind of Text
Box in that it adds pre-configured formatting
to the data entered into the component. In
this example, the “( ) — formatting elements
were correctly placed and automatically
added to the phone number as the user typed
in only the numbers.

Multiple-Line Text Box

10 White five nes of 1ext [gibbesish is accepled)

Thiz 1= a test to see how much test | can place here kdplfg
pokd fgpokd ook, dplickg pook pdokf pook. gpok doofgk
podkpgokl gpokd gpokdpfogk pdgodiigoby sdufriewhn ivwe
igos quoidjf goagy cijodifgye cydohgj oig) odigdo hgjooy ikjdkig)
dolig) dohigj dighdkif gigal oid poifig cogi gidif gogj odiif goqg

A Multiple-Line Text Box functions in the
same manner as a single-line Text Box, but
provides enough space for entering large
amounts of text.
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Spin Box

Mew GAF rating: |1 e

the up and down arrowheads respectively
increase or decrease the value of the
displayed integer. Additionally, an integer

the integer value.

Spin Boxes provide for the quick entry and
verification of integer data. The buttons with

value can be typed into the Text Box holding

Option Buttons

12 Pick ane number

at once, from which one of the mutually-

Option Buttons display all available choices

exclusive selections may be made. This is the
most commonly-used component in Mental

L
i T:: --------- Health Assistant. To make a selection, click
e on one of the white circles, which will then
£ & Fou display a black dot in its center.
Slider A Slider is a visual way of displaying a range

14, Slide the maikes to any rumber you ke

from which to select a single value. The

1 2 3 [ 5 3 7 8 9

@ | what the range limits mean.

Low medim

accompanying labels offer information about

Progress Indicator

30%

during time-consuming events.

Indicates the amount of progress transpired

Command Button

Edit

A button that executes a specific function
when pressed.

Menu Button

A button with more than one choice

Full
Lite
Follow-Up
Tabs A navigation method similar to tabs on a

writing notebook.

, - -
| Manative Repart |1tem Report | Item Trends | Domain Scores
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This is a list of shortcut keys use by the VistA Mental Health Assistant Graphical User Interface
software application:

NOTE: When going from one menu option to a sub-menu, do not release the Alt key.

Shortcut Keys

Main Form Window

Alt-F File
Select Patient
Upload Results
Exit
Tools
METRIC Instrument Reviews
Options
Help
Online Support
About Window

Alt-T

Alt-H

>0 OZ XCow

ESC Exit

Alt-1  Instrument Administrator

Alt-R  Instrument Results Review

Alt-A Addiction Severity Index Manager

Alt-G Global Assessment of Functioning Manager

Offline Results Synchronizer Window
Alt-F File
E Exit
Alt-H Help
@) Online Support
A About Window
Alt-S  Search for
Alt-G Go
Alt-D Delete Off-Line record
Alt-U Upload
Alt-X Exit
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User Preferences Window

Alt-F Font
P CPRS Font
W Windows Font
N New Font
Alt-H Highlight Color
Alt-M Misc.
Alt-C Cancel
Alt-D Done
About Window
Alt-O OK
ESC Exit
Instrument Administrator Window
Alt-F File
S Select Patient
X Exit
Alt-T Tools
M METRIC Instrument Reviews
B Battery Wizard
O Options
Alt-H Help

Alt-B
Alt-1
Alt-D
Alt-L
Alt-A
Alt-W
Alt-C
Alt-O
Alt-Q
Alt-P
Alt-S

| Instrument Description
@) Online Support
A About Window
Instruments Ordered By
Interviewer

Date of Administration

Visit Location
Available Instruments and Batteries
Show

Instruments Chosen

One Question at a Time
All Questions at Once

Patient Entry

Staff Entry

Appendix A
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Battery Wizard Window
Alt-F File
New
Rename
Delete
Exit
Tools
Options
Alt-H Help
| Instrument Description
) Online Support
A About Window
Alt-A Available Instruments and Batteries
Alt-B  Name of Battery
Alt-1 Instruments in Battery

Alt-T

@] Xgox=z

Alt-S Save
ESC Exit
One Question at a Time Window

Alt-F File
C Cancel

Alt-V View
E Previous Instrument
| Next Instrument
R Review Answers
P Prior Question
Q Next Answer

Alt-T Tools
M METRIC Instrument Reviews
) Options

Alt-H Help
O Online Support
A About Window

Alt-P  Prior Question
Alt-Q Next Question
Alt-R Review Answers

All Questions at Once Window

Appendix A

Alt-F File
X Exit
Alt-V View
(Depends on the instruments in the battery)
Alt-T Tools
M METRIC Instrument Reviews
O Options
Alt-H Help
0] Online Support
A About Window
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Review Answers Window

Alt-F
X
Alt-H
)
A

File

Exit

Help

Online Support
About Window

Alt-C Change Answer

Alt-X  Exit

Instrument Results Review Window

Alt-F

S
A

Alt-E

Alt-V

Alt-T

Alt-H

>0 OZ>» OX

Alt-R Reports

File
Select Patient
Save As
R Report
T Table
G Graph
Print
R Report
T Table
G Graph
Exit
Edit
Copy
R Report
T Table
G Graph
View
Reports
Graph and Table
Tools

Append Comments
METRIC Instrument Reviews

Options

Help

Online Support
About Window

Alt-G Graph and Table

ESC Exit

Appendix A
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Append Test Comments Window

Alt-F
S
Alt-F
X
Alt-H
O
A
ESC Exit
ASI Window
Alt-F
N
S
A
P
X
Alt-W
F
L
U
Alt-E
C
A
Alt-V
N
I
R
D
Alt-A
w
Alt-T
O
Alt-H
O
A
ESC Exit

ASI Data Entry Window

File
Save
File
Exit
Help
Online Support
About Window
File
New ASI
F Full
L Lite
U Follow-Up
Select Patient
Save As
R Report/Table
G Graph
Print
R Report/Table
G Graph
Exit
New
Full
Lite
Follow-Up
Edit
Copy
R Report/Table
G Graph
ASI
View
Narrative Report
Item Report
Item Trends
Domain Scores
Action

Write progress note
Tools

Options

Help

Online Support
About Window

Appendix A
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Alt-D
Alt-E
Alt-G
Alt-I
Alt-L
Alt-M
Alt-P
Alt-R
Alt-S
Alt-A
Alt-F

Alt-T

D
Alt-F4
ESC

Drug/Alcohol Use Section
Employment/Support Section
General Information Section
Spiritual Comments Section
Legal Status Section
Medical Status Section
Psychiatric Status Section
Leisure Comments Section
Family/Social Relationships Section
Family History Section
File
Exit
Tools

Options
H Highlight Color
T Speed Tab
S Show hints

Default Window Size/Position
Exit
Exit

F1 Help for the highlighted item

Alt-H

ASI Options Window

Help
C Contents
@) Online Support
A About Window

Appendix A

Alt-C Cancel
Alt-D Done
ESC Exit
ASI Signature Window
Alt-C Cancel
Alt-O OK
ESC Exit
ASI Termination Window
Alt-C Cancel
Alt-O OK
ESC Exit
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Addiction Severity Index Manager Window
Alt-F File

Select Patient

Save New Rating
Save As

G Graph

T Table

P Print
G Graph
T Table

> »w

Alt-E Edit
C Copy
G Graph
T Table
Alt-A Action
Save New Rating
Mark Rating “Entered in Error”
Alt-T Tools
@) Options
Help
@) Online Support
A About Window
C Copyright Info
Alt-R Mark Rating “Entered in Error” or Change Delete Rating
Alt-D Delete Rating
Alt-N  New GAF Rating
Alt-D Evaluation Date
Alt-S  Save New Rating

I w;m

Alt-H

Edit GAF Window
Alt-D Delete Rating
Alt-H Change Rating

Alt-C  Cancel
Alt-O OK
ESC Exit
Pop-Up Menus (Only on Addiction Severity Index Manager Window)
Reports/Tables
Alt-P Print
Alt-C Copy
Alt-S Save As
Graphs
Alt-P Print
Alt-C Copy
Alt-S Save As
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This section contains descriptions of the many windows commands and features used in MHA GUI
software application:

Windows Conventions

Cancel
Cancels the latest entry (up until the OK or SAVE button is clicked).

Check Box
Toggles between a YES/NO and ON/OFF setting. Usually a square box containing a check mark or
x. Clicking the box or pressing the spacebar toggles the check box setting.

Close

Closes the window. If there are any changes that have not been saved, you will get a confirmation
message asking you if you want to continue without saving; save before exiting; or cancel the close
action and return to the window.

Command Button

The Command button initiates an action. It is a rectangular box with a label that specifies what the
button does. Command buttons that end with three dots indicate that a subsidiary screen may be
evoked by selecting the command.

Date Field

Identified by “ / / ” or a date “mm/dd/yy”. Will usually have an associated popup calendar.
Double clicking with the mouse inside the date edit box, or tabbing to the edit box and then pressing
the F2 key, displays the calendar. Clicking on the desired date, or using the arrow keys to move to a
date and then pressing the spacebar, selects the date. Each component of the date (month/day/year)
must consist of two characters (i.e., 02/02/96). The selected entry will not be effective until you tab
off or exit from the date field.

Drop Down List

A list box containing an arrow button on the right side which displays one entry at a time. Choose
from a vertical list of choices. Select the entry you want by clicking the list entry. You cannot type in
this box, only select an item from the list. Once an entry is selected, it cannot be deleted - only
changed. If <None> is the last entry, selecting it will clear the list entry. If <More> is the last entry,
selecting it will display additional entries. The selected entry will not be effective until you tab off or
exit from the drop down list.
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Edit
Used to edit position information.

Edit Box
This is a box where the user can type in free text from the keyboard.

F2 Key
Where there is an additional action, which may be taken on a field, pressing the F2 key will initiate
that action.

Form Buttons
Buttons, which appear on tab pages, apply only to that tab and not the entire form. If there are action
buttons on both the tab page and the form, the tab button should normally be clicked first.

Help
Provides help for the area you are currently working in.

List Box

List Box that shows a list of items. If more items exist than can be seen in the box, a scroll bar
appears on the side of the box. Selecting an entry from a list box requires either double clicking the
entry or single clicking the entry and pressing the spacebar.

Lookup Box

Choose from a vertical list of choices. By typing in a few characters and pressing the ENTER or
TAB key, a list of matching entries drops down. Select the entry you want by clicking the list entry.
Entering a question mark and then pressing ENTER or TAB, or clicking the down arrow on an empty
edit field, gives a complete listing of available entries. If <More> is the last entry, selecting it will
display additional entries.

OK
Adds the new entry after the data has been entered.

Radio Button

Radio buttons appear in sets. Each button represents a single choice and only one button may be
selected at any one time. For example, MALE or FEMALE may be offered as choices through two
radio buttons. Click in the button to select it.

Right Mouse Button or Shift F10
You may click the right mouse button or press Shift F10 for a popup box of menu items.
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Save

Saves all changes made since the last save action. If you attempt to save and all required fields have
not yet been completed, you will receive notification that the required fields must be completed
before saving.

Save to File (Save AS)

This is a standard feature of Microsoft applications where the user can type the name of the file to be
saved. The user can also define the drive and directory where the file is to be saved. In some cases
the file name presented in the edit box is sufficient and the user merely needs to click on the “Ok”
button to save the file.

Tab Key
Use the TAB key or the mouse to move between fields. Do not use the RETURN key. The RETURN
key is usually reserved for the default command button or action (except in menu fields).

Text Box
Type the desired characters into the edit box. The selected entry will not be effective until you tab off
or exit from the text box.

View Box
This is a box that displays text but does not allow editing (read only).
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Appendix C

How to co-sign a progress note generated by MHA3

The following conditions are needed to generate a co-signer in TIU notes.

1. A progress note needs to be generated. (Some instruments do not generate progress notes.)
2. The person who administers the instrument must be someone who needs a co-signer, like a
student.

When an instrument is completed in MHA3, and the two conditions are met, this dialog will
appear:

Save Progress Note to Vista

The data For this administration has been saved in Wiska,
Do wou wish bo;

& co-signer is required. Select From:

Save standard progress noke Click

Edit then save progress noke

Do not save progress note

Select the person to co-sign the progress note from the drop-down list presented in the combo
box. Once selected, press the button to either save the standard progress note, or edit the progress
note before saving it.
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Appendix D

How to remove patient data that was entered in error

There are two methods to remove the data from an instrument’s administration. The first uses the
MHS Manager Functions in VistA and the second is available in MHA3’s “Instrument Review
Results” window. In either case, this function can be performed only by individuals who have
access to the MHS Manager Functions in VistA, usually a Clinical Application Coordinator
(CACQC).

IMPORTANT: Data removed by either method will only remove the results of the

administration of the instrument. Any progress notes, or consult notes, etc., will not be removed.

Remove data entered in error: Vista menu instructions.

Here are the steps to follow in the “roll-and-scroll” version (the user responses are shown in red):

¥»** MENTAL HEALTH ***
MHS MANAGER FUNCTIONS

Inpatient Features management functions...
Mental Health System site parameters...
MHAZ2 Psych test utilities...

Move crisis notes and messages
Seclusion/Restraint Management Utilities...
Decision Tree Shell

MHA3 Utilities...

NOoO ok~ WNPRE

Select MHS Manager Option: 7 MHA3 Utilities

*** Mental Health ***
MHA3 Utilities

Print Test Form
Detailed Definition
Delete Patient Data
Stop/Re-Start Progress Notes for an Instrument
Exempt Test
Test Usage
XML Output
MHA3 HL7 Utilities...

O~NO O WNPRF

Select MHA3 Utilities Option: 3 Delete Patient Data

Delete Patient Data
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Select PATIENT NAME: MHPATIENT,ONE *SENSITIVE* *SENSITIVE*
NO EMPLOYEE

W ARNING***

**RESTRICTED RECORD***
EE IR I I S S I S S IR I A A S S S
* This record is protected by the Privacy Act of 1974 and the Health *
* Insurance Portability and Accountability Act of 1996. If you elect *
* to proceed, you will be required to prove you have a need to know. *
* Accessing this patient is tracked, and your station Securlty Officer *
* will contact you for your justification.

EE I R R I I O A A I A A A

Do you want to continue processing this patient record? No// Y (Yes)

Appendix D

Message(s) are on file for MHPATIENT,ONE
Last message was entered on DEC 15, 1992

Enter RETURN to continue or "' to exit:

Delete MHA3 data? No// YES

PHQ-2 on JAN 07, 2009@09:56:27 by MHPROVIDER,ONE
Delete? No// YES

Are you sure? No// YES ***Deleted

AUDC on NOV 26, 2008@14:28 by MHPROVIDER,ONE
Delete? No// »
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Remove data entered in error: MHAS3 instructions.

Open MHA3 and select the Instrument Review Results option.

@ Mental Health Assistant in use by MHPROVIDER ,ONE
File Tools Help

One Mhpatient

Mental Health Assistant s

Instrument Administrator
Click

Instr‘ment Results Review

Addiction Severity Index Manager

Global Assessment of Functioning Manager

Select the administration of the instrument you wish to remove. The instrument’s name and the
date of the administration will be highlighted, and its report will appear in the right window. In
this example, notice that there are five administrations of the CAGE on 11/16/2006.
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w- Mental Health Assistant in use by MHPROVIDER ,ONE
File Edit Yiew Tools Help

One Mhpatient

Instrument Results Review: CAGE SEN 000241 2
Instruments: Not walid unless signed: Reviewed by .......... ... oo,
Date |Name |g Printed by: MHPROVIDER, ONE

ord d by: MHEPROVIDEER, ONE
01/09/2008  BRADEMSCALE —| || oo °¥

1222008 BOMC *rrggprEt
12/02/2008 CAGE

000-00-2412 MHPATIENT, ONE F AGE 86 01/15/2009 11/16/2006
12/01/2008  CAGE PRINTED ENTERED
12/01/2008  AUDIT
11/24/2008 AUDIT
11/24/2008 AUDC

12/08/2006  IEQ 1w Z N 3N 4 % - .
11/20/2006 | CAGE / Administration to be deleted

-—— CAGE ---
--- ITEM RESPONSES —--

1116/2006 | CAGE
11/16/2006 | CAGE

A

1116/2006 | CAGE

11/1E i

11/16/2006 | CAGE

10/31/2006 | CAGE

1043172006 AUDIT

104312006 AUDC

1043042006 | AUDIT

10/30/2006 | CAGE

10/30/2006 | AUDIT

10/30/2006 | CAGE

10/27/2006 AUDIT &

Beports | Graph & Tahle |

There are three ways to initiate the deletion process:
1) Select the Delete administration from the Tools option in the Main Menu.
2) Press the DEL key.
3) Right click, then select “Delete” from the pop-up menu.

These three methods are illustrated below.
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& Mental Health Assistant in use by MHPROVIDER ,ONE

File Edit Wview BIEEEN Help

Append Camments., .,

Instrumen EEEEETEET

Instruments:

METRIC Insktrument Reviews...

lid unless signed: Re

12112/2008  BOMC
12/02/2008  CAGE
12/01/2008  CAGE
12/01/2008  AUDIT
11/24/2008  AUDIT
11/24/2008  AUDC
12/08/2006  |IEQ
11/20/2006  CAGE
11/16/2006  CAGE
11/16/2006  CAGE
11/16/2006  CAGE
11162006
11/16/2006  CAGE
10/31/2006  CAGE
10/31/2006  AUDIT
10/31/2006  AUDC
10/30/2006  AUDIT
10/30/2006  CAGE
10/30/2006  AUDIT
10/30/2006  CAGE
10/27/2006  AUDIT

Opkions. ..
Date |Name |f
01,09/2009 ERADEM SCALE  —

MFrinted hby: MHPROVIDEER, ONE
Ordered by: MHPFROVIDER, CNE

***EDP***

0O00-00-2412Z MHPATIENT, OMNE

Appendix D
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@ Mental Health Assistant in use by MHPROVIDER ,ONE
File Edit Wiew Tools Help

Instrument Results Review: CAGE

[nstruments: Mot walid 1
Diate Matre #| ||Printed by:
GrecloEesl o
01/09/2008 BREADEMSCALE =~ | |- --r=% =¥
12A12/2008  BOMC $rtogpthr

12/02/2008  CAGE
12/01/2008  CAGE
12012008 AUDIT
11/24/2008  AUDIT
11/24/2008  AUDC
12¢08/2006  IEQ

11/20/2006  CAGE
11/16/2006  CAGE
11/16/2006  CAGE
11/16/2006  CAGE
11/16/2006 |CAGE | |
11/16/2006  CAGE [
10/31/2006  CAGE
10312006 AUDIT
10/31/2006  AUDC

ooo0-00-Z41:

Once you press the DEL key, this warning dialog will appear.

Jate |Name |A Printed by: MHEROVIDER, ONE
Ordered by: MHPROVIDER, ONE

1n/08/2008  BRADEM SCALE | —

2

2 (=
1) This operation can not be reversed laker. 1/15/200¢

2 ! FINTED

2 23 Only the data are removed From Wista; any progress noke, consults, etc, based on these data are not deleted or changed by this
ackion,

1 Are you sure you want to permanently delete the results of the CAGE administered on 11/16/20067

1

o [ Yes ] l Mo ]

17207 20b LAGE

1116/2006 CAGE

1A RMONE mAMFE
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If you are sure that the deletion is proper, click on the Yes button. If the data are removed
successfully, this prompt will appear. In addition, the list of instruments will have been
refreshed.

Eraden #cale tor Predaicting Pressure Uloer Risk
Date Giwven: 1/759/2009

“linician: Mhprovider, One

Location: 1 Test (north)

Mhpatient, One

Veteran:

The data were deleted.

J\T

AL hring ful
Remember that progress notes, consulks, etc, are not deleted or changed by this process,
Al
AL to mois
[EC P P .
Aotiwvity ——- ability to <change and control body posi
CAGE Walks frequently.
CAGE Mobility -- ability to change and control body posi
Ho limitation.
CAGE Hutrition —-- usual food intakepatterns
[ = Aormal 1l awt+
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Notice that only four administrations of the CAGE are listed for 11/16/2006.

w- Mental Health Assistant in use by MHPROVIDER ,ONE

Appendix D

File Edit Wiew Tools Help
. . One Mhpatient
Instrument Results Review: BRADEN SCALE ST o021 2
Instruments: EBraden Scale for Predicting Pressure Ulcer Risk
Date MName #| ||Date Given: 1/9/2009
C¢linician: Mhprovider, One
Location: 1 Test (north)
121252008 BOMC Veteran: Mhpatient, One
12/02/2008 CAGE FEN: xxx-xx-241Z2
DOB: Feb 1,15922 (86)
12/01/2008 CAGE Gender: Female
12/01/2008  AUDIT densory perception -- ability to respond meaningfully to pressure-related
discomfort
11/24/2008 AUDIT No impairment.
11/24/2008  AUDC Moisture -- degree to which skin is exposed to molsture
Rarely moist.
12/08/2006 | 1EQ Aotivity —- ability to change and control body position
11/20/2006 CAGE Walks freguently.
11416/2006 CAGE Mobility -- ability to change and control body position
No limitation.
11/16/2008 CAGE Nutrition -- usual food intakepatterns
1116/2006 | CAGE Excellent.
11/16/2006 CAGE Friction and shear
No apparent problem.
10/31/2006 | CAGE
1043172006 AUDIT *** Braden Zcale Score ***
devere risk 2 or lower.
1043142006 AUDC High risk:10-1Z2.
1043042006 ALDIT Moderate risk: 13-14.
Mild risk: 15-18.
10/30/2006 | CAGE Gcore: 23
1043072006 AUDIT Copyright Barbara Braden & Nancy Eergstrom, 1988
10/30/2006 | CAGE
10/27/2006 AUDIT
10/27/2006  AUDC &
Beports | Graph & Tahle
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Appendix E

Some sites have reported difficulty installing SecureDesktop as the Windows registry is blocked
by McAfee HIPS. Uninstalling HIPs allowed the installation to occur normally.

SecureDesktop & Screen Pass : How to correct Windows-Registry problems.
According to the Birch Grove Software site:

“Screen Pass is a screen locking system for Windows® that extends the capability
of the standard workstation lock and gives network administrators complete control
over idle workstations.

With Screen Pass, network administrators can enforce screensaver password use,
screensaver timeout, and screen saver selection. Advanced features include
automatic logout, automatic shutdown, customizable administrator override, and
auditing of all logon/logoff and lock/unlock events.

Intended primarily for workstations connected to Novell Netware or Microsoft
networks, Screen Pass can be distributed and managed remotely with or without
group policy. The central management feature makes Screen Pass ideal for small,
medium, and large networks - anywhere that security of idle workstations is a
concern.”

Screen Pass installs its own version of a gina.dll and it may take precedence over the one used by
Secure Desktop. If SecureDesktop does operate properly these changes may be necessary in the
Windows Registry:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows
NT\CurrentVersion\Winlogon\GinaDLL=dwlgina2.dll

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows
NT\CurrentVersion\Winlogon\GinaDLL_ScreenPass=msgina2.dll

See Remedy Ticket # HD0000000278953.
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SecureDesktop : How to correct dwlGina2.dll problems.

A dwlGina2.dll error problem may occur when a non-administrator uninstalls MHA3 without an
administrator first de-activating SecureDesktop.

Here is how to fix it:

1. Turn off defective PC, if on.

2. Start the PC and Windows in SAFE mode.

3. Logon as Administrator.

4. Find the media containing the YS_MHA_SD_UNINSTALLGINA.exe file. These files are
typically found at C:\Program Files\Vista\Y S\MHAS3. Run

YS _MHA_SD_UNINSTALLGINA.exe. Click Yes, to uninstall it.

5. Reboot in normal mode.

If this doesn’t work, then modify step five by first finding and running
YS_MHA _SD _INSTALLGINA.exe. Click Yes, to install it. Then follow the remainder of step
five.
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Appendix E

Appendix F

How to add the name of an instrument to the CPRS Tools menu

This is done in Vista; an example for the AUDC is provided below:

Select GUI Parameters Option: tm GUI<KENTER> Tool Menu Items

CPRS GUI Tools Menu may be set for the following:<ENTER>

1 User USR [choose from NEW PERSON]

2 Location LOC [choose from HOSPITAL LOCATION]

3 Division DIV [REGION 5]

4 System SYS [OEX.ISC-SLC.VA.GOV]

Enter selection: 1<ENTER> User NEW PERSON

Select NEW PERSON NAME: MHPROVIDER, ONE<ENTER> CPF

————————————— Setting CPRS GUI Tools Menu for User: MHPROVIDER,ONE-----——----
Sequence: ? <ENTER>

Enter the sequence in which this menu item should appear.

Select Sequence: 2

Are you adding 2 as a new Sequence? Yes//<ENTER> YES

Sequence: 2// <Enter>

Name=Command: AUDC =C:\Progra~1\Vista\YS\MHA3\YS MHA.exe s=%SRV p=%PORT
c=%DFN u=%DUZ m=%MREF AUDC
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